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Legal information

The Schneider Electric brand and any trademarks of Schneider Electric SE and its subsidiaries
referred to in this guide are the property of Schneider Electric SE or its subsidiaries. All other
brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and furnished for
informational use only. No part of this guide may be reproduced or transmitted in any form or by
any means (electronic, mechanical, photocopying, recording, or otherwise), for any purpose,
without the prior written permission of Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide or its
content, except for a non-exclusive and personal license to consult it on an "as is" basis.
Schneider Electric products and equipment should be installed, operated, serviced, and
maintained only by qualified personnel.

As standards, specifications, and designs change from time to time, information contained in this
guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by Schneider
Electric and its subsidiaries for any errors or omissions in the informational content of this material
or consequences arising out of or resulting from the use of the information contained herein.
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Safety information

Important information

Read these instructions carefully and look at the equipment to become familiar with the
device before trying to install, operate, service, or maintain it. The following special
messages may appear throughout this manual or on the equipment to warn of potential
hazards or to call attention to information that clarifies or simplifies a procedure.

i The addition of either symbol to a "Danger” or "Warning" safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not followed.

A This is the safety alert symbol. It is used to alert you to potential personal injury hazards. Obey

Please note

all safety messages that follow this symbol to avoid possible injury or death.

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out
of the use of this material. A qualified person is one who has skills and knowledge related to the
construction, installation, and operation of electrical equipment and has received safety training to
recognize and avoid the hazards involved.
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Notices

FCC

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that the
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

* Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

* Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that any changes or modifications not expressly approved by Schneider
Electric could void the user’s authority to operate the equipment.

This digital apparatus complies with CAN ICES-3 (B) /NMB-3(B).
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Metering equipment symbols

The following IEC 60417 and ISO 7000 symbols may be used on the metering equipment:

Symbol Reference

IEC 60417-5017

IEC 60417-5018

IEC 60417-5019

IEC 60417-5172

ISO 7000-0434B

&
A\

|

ISO 7000-1641

Title and description

Earth; ground

To identify an earth (ground) terminal in cases where
neither the symbol 5018 nor 5019 is explicitly required.

Functional earthing; functional grounding (US) *

To identify a functional earthing (grounding) terminal, for
example, of a specially designed earthing (grounding)
system to avoid causing malfunction of the equipment.

Protective class I; Protective earth/ground

To identify any terminal which is intended for connection
to an external conductor for protection against electric
shock in case of a fault, or the terminal of a protective
earth (ground) electrode.

Protective class Il equipment **

To identify equipment meeting the safety requirements
specified for Class Il equipment (double or reinforced
insulation).

Caution, refer to accompanying documents

To indicate that caution is necessary when operating the
device or control close to where the symbol is placed. To
indicate that the current situation needs operator
awareness or operator action in order to avoid
undesirable consequences.

Operator's manual; operating instructions

To identify the location where the operator's manual is
stored or to identify information that relates to the
operating instructions. To indicate operating instructions
should be considered when operating the device or
operating controls close to where the symbol is placed.

* There may be national differences concerning the use of this symbol.

** Protective class equipment requirements are outlined in IEC 61140.
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About this manual

This manual discusses features of the PowerLogic™ ION9000 series power meter and provides
configuration instructions.

Throughout the manual, the term “meter” refers to all models of the PowerLogic™ ION9000 series
meter. All differences between the models, such as a feature specific to one model, are indicated
with the appropriate model number or description.

This manual assumes you have an understanding of power metering and are familiar with the
equipment and power system in which your meter is installed.

This manual does not provide configuration information for advanced features where an expert
user would perform advanced configuration. It also does not include instructions on how to
incorporate meter data or perform meter configuration using energy management systems or
software, other than ION Setup. ION Setup is a free configuration tool available for download from
WWW.S€e.com.

Contact your local Schneider Electric representative to learn what additional training opportunities
are available regarding the PowerLogic™ ION9000 series meter.

Make sure you are using the most up-to-date version of your meter’s firmware in order to access
the latest features.

The most up-to-date documentation about your meter is available for download from
www.se.com.

Related documents

Document Number

PowerLogic™ ION9000 online https://www.se.com/ca/en/product-range/64241-
documents new%21-powerlogic-ion9000/#documents
PowerLogic™ ION9000 series
. . . NVE78642
installation guide
PowerLogic™ ION9000 series -

. . . GDE96023
LVCS installation guide
PowerLogic™ ION9000 series -

: : . NNz67817
LVDC installation guide
PowerLogic™ ION9000 series -

. . . NNZ67818

LVDC/LVCS installation guide
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Document Number

PowerLogic™ ION9000 series -

Measurement Canada installation NNZ55235
guide

ION Reference 7EN02-0290

PowerLogic™ ION9000 series

i PLSED310106EN
technical datasheet

PowerLogic™ Fiber Ethernet option

METSEPMFIBER
module

PowerLogic™ 4-wire RS-485 option

METSEPMRS4854W
module
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Safety precautions

Installation, wiring, testing and service must be performed in accordance with all local and
national electrical codes.

& A DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

* Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

* Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

* Follow guidelines in the Wiring section of the related Installation Guide.

* Always use a properly rated voltage sensing device to confirm that all power is off.
* Do not use the data from the meter to confirm power is off.

* Do not exceed the maximum ratings of this device.

* Do not short secondary terminals of Voltage Transformer (VT).

* Do not open secondary terminals of Current Transformer (CT).

* Ground secondary circuit of CTs.

* Use only Low Power Current Transformers (LPCTs) that are approved for use with this
device.

* Do not connect CT secondary signals to meter low voltage LPCT terminals.

* Do notinstall CTs or LPCTs in equipment where they exceed 75% of the wiring space of any
cross-sectional area in the equipment.

* Donotinstall CTs or LPCTs in areas where ventilation openings may be blocked or in areas
of breaker arc venting.

* Do notinstall CTs or LPCTs using Class 2 wiring methods or connect to Class 2 equipment.
See NFPA 70.

* Secure CT or LPCT secondary conductors to ensure they do not contact live circuits.
* Assume communications and I/O wiring are hazardous live until determined otherwise.
* Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

NOTE: See IEC 60950-1 for more information on communications and I/O wiring connected to
multiple devices.
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A WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

A WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

* Change default passwords/passcodes to help prevent unauthorized access to device
settings and information.

* Disable unused ports/services and default accounts, where possible, to minimize pathways
for malicious attacks.

* Place networked devices behind multiple layers of cyber defenses (such as firewalls, network
segmentation, and network intrusion detection and protection).

* Use cybersecurity best practices (for example: least privilege, separation of duties) to help
prevent unauthorized exposure, loss, modification of data and logs, interruption of services,
or unintended operation.

Failure to follow these instructions can result in death or serious injury or equipment
damage.
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Meter overview

ION9000 series overview

The ION900O series advanced energy and power quality meter helps meet the needs of your
energy management, power management, and cost management applications within your
EcoStruxure™ Power architecture.

ION9000 series revenue-accurate meters comply with international metering standards. The
meters feature flexible ION programmability that enhances functionality through customization by

loading specialized frameworks. You can add optional modules and incorporate mounting
accessories into the physical installation to meet a variety of installation and application needs.

Measurement accuracy

Third-party international standards-certified:

Power quality

Class 0,1S for energy

Power Quality Instrument — Class A (PQI-A) for all normative IEC 61000-4-30 power quality
metrics

IEC 62053-22, -23, -24 and ANSI C12.20

Third-party international standards-certified:

IEC 62586-1, IEC 62586-2, and IEC 61000-4-30
EN 50160, including flicker monitoring
IEEE 519

Root cause analysis and sequence-of-events support

Cybersecurity

Disturbance Direction Detection

High-speed RMS data capture with pre and post event records
Extended waveform capture

Time quality flag for GPS or PTP time sources

Time synchronization to 1 ms accuracy

High-speed voltage transient capture with 10 MHz sampling rate (ION900O0T only)

Meter security with multiple users and access levels
Total control for each communications port and protocol, including protocol lockout
Secure webpages (HTTPS)

Support for meter event logging to a remote server (syslog)

7EN02-0390-08
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Account management

If your meter’s user access information is lost, you must return the meter to the factory, where
your meter is reset to its factory defaults and all logged data is lost.

NOTICE

DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.

Your meter in an energy management system

As a key piece in your energy management system, the PowerLogic™ ION9000 series meter
provides highly accurate measurements and calculations for a wide variety of power system
values, performs analysis on collected data, alerts you of potential issues and integrates with a
variety of display and analysis software.

It performs analysis on collected data, alerts you of potential issues and integrates with a variety
of edge control software such as EcoStruxure™ Power Operation and EcoStruxure™ Power
Monitoring Expert, and cloud-based energy management software such as EcoStruxure™
Energy One Hub.

For further analysis, you can also connect your meter with EcoStruxure™ Power Advisor to
enhance the performance and maintenance of power networks.

Communications

Supported protocols

Your meter’s fundamental protocol and architecture is ION.

You can integrate the meter into various industry-standard networks. Data that the meter
measures can be made available to other devices using:

* Modbus

* DNP3.0

* DLMS

* SNMP

* MV-90 billing software
You can configure the meter to import data from other devices on these networks. Your meter
supports the IEC 61850 protocol and COMTRADE waveform data format.

Your meter also supports IPv6, Devices Profile for Web Services (DPWS), and Rapid Spanning
Tree Protocol (RSTP) Ethernet protocols.
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Meter configuration

ION Setup device configuration tool

ION Setup is a free configuration tool for your meter that lets you remotely configure your meter’s

features over Ethernet or serial communications.
* Use the setup screens to guide you through the process of configuring your meter.
* Use the real-time data screens to verify your meter’s configuration.
* Use the data screens to view your meter’s recorded data.
* Use the charting function to view your meter’s recorded waveforms.

* Use ION Setup in Advanced mode to work directly with modules.

Download ION Setup from www.se.com.

Switching ION Setup to Advanced mode

1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

Data display

Built-in web server and webpages

Localization

Display

Your meter’s onboard internal web server and built-in webpages provide quick and easy access

to real-time energy, basic power quality information and meter configuration without having to use

specialized software.

The meter can be customized to use different regional settings.
Localization settings determine:

* The language used for the display and webpages

* Time, date, and digit formats

* Displayed phase labels (123/ABC)

* Institute of Electrical and Electronics Engineers (IEEE) or International Electrotechnical
Commission (IEC) conventions for power, power factor, and energy

Configure your meter’s localization settings using ION Setup or the display.

Use the meter’s display to view real-time and historical power quality data, access monitoring
tools, receive and acknowledge alarms, and perform basic device configuration.

The touch-screen color display has multiple mounting options to suit your environment and an
eight-language interface with external LED indicators for power, alarms, and energy pulsing
applications.
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Notification

Active and historical alarms

The meter’s display shows an alarm icon and the alarm LED flashes if your meter detects an
active alarm condition.

Depending on the priority of the alarm, the display also flashes. You can view and acknowledge
active alarms, historic alarms, and events using the display and webpages.

An active alarm becomes a historic alarm when the alarm condition no longer exists.

Email notifications

Configure your meter to automatically email information such as notification of a high-priority
event or a regularly scheduled send of logged data.

Specify the type of event that triggers an email alert, such as a power quality disturbance or
interval for logged data. Email messages from your meter are received like any other email
message.

ION9000 meter models and accessories

Commercial references for the ION9000 series meter and accessories.

Commercial reference Description

METSEION92030
ION9000 series meter
METSEION92830
METSEION92040 ION9000 series meter with RD192 remote display
METSEION92043 ION9000 series — Measurement Canada Approved meter
METSEION92044 ION9000 series — Measurement Canada Sealed meter
METSEION92130 ION9000 series — LVDC meter
METSEION92140 ION9000 series — LVDC meter with RD192 remote display
METSEION93030 ION9000 series —LVCS meter
METSEION93040 ION9000 series — LVCS meter with RD192 remote display
METSEION93130 ION9000 series — LVDC/LVCS meter
METSEION93140 ION9000 series — LVDC/LVCS meter with RD192 remote display
METSEION95030 ION90OOT series meter
METSEION95040 ION900OQT series meter with RD192 remote display
RD192 192 x 192 mm remote display with ION9000 series back-
METSERD192 to-back mounting adapter and 1/4 DIN (92 x 92 mm) panel cutout
mounting adapter
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Commercial reference Description

PM89RD96 96 x 96 mm remote display with 1/4 DIN (92 x 92 mm)
METSEPM89RD96 i
panel cutout mounting adapter
METSEPM89M2600 Digital I/O option module (2 outputs, 6 inputs)
METSEPM89M0024 Analog I/0 option module (2 outputs, 4 inputs)
METSEPMRS4854W 4-wire RS-485 option module
METSEPMFIBER Fiber Ethernet option module
METSE9B2BMA ION9000 series back-to-back mounting adapter
METSESHWK ION900O series replacement hardware connectors and terminal
covers
ION9000 series — LVCS replacement hardware connectors and
METSEQHWKLVCS :
terminal covers
METSE9QUSBK RD192 replacement USB cover
METSERD192HWK RD192 replacement hardware kit
METSECAB10 Remote display cable, 10 m

For more information on meter types and accessories, refer to your meter’s catalog pages,
available from www.se.com.

Terminal covers

The terminal covers enclose the terminals, the conductor fixing screws, and a length of the
external conductors and their insulation. The terminal covers are secured by tamper-resistant
meter seals.

The voltage and current terminal covers help prevent tampering with the meter's voltage and
current measurement inputs.

These covers are included for meter models where sealable voltage and current covers are
required to comply with revenue or regulatory standards.

The meter terminal covers must be installed by a qualified installer.

Refer to your meter's installation guide or the instructions that came with your terminal covers for
instructions on installing the terminal covers.
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Cybersecurity

Your device has security capabilities that:

* Allow it to be part of a NERC CIP compliant facility. For information on NERC Reliability
Standards, go to the North American Electric Reliability Corporation website.

* Align with cybersecurity standards in the IEC 62443 international standard for business IT
systems and Industrial Automation and Control Systems (IACS) products. For information
about the IEC 62443 international standard, go to the International Electrotechnical
Commission website.

This chapter contains information about your product’s cybersecurity. Network administrators,
system integrators, and personnel that commission, operate, maintain, or decommission a device
should review "Recommended actions" on page 26 to help secure your device in a protected
environment.

A& WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

* Change default passwords/passcodes to help prevent unauthorized access to device
settings and information.

* Disable unused ports/services and default accounts, where possible, to minimize pathways
for malicious attacks.

* Place networked devices behind multiple layers of cyber defenses (such as firewalls, network
segmentation, and network intrusion detection and protection).

* Use cybersecurity best practices (for example: least privilege, separation of duties) to help
prevent unauthorized exposure, loss, modification of data and logs, interruption of services,
or unintended operation.

Failure to follow these instructions can result in death or serious injury or equipment
damage.

Recommended actions

Your device is designed to be used in a protected environment that uses a defense in depth
strategy, in compliance with IEC 62443, the global standard for industrial automation control
system security.

To help secure your device, you must take specific actions at every stage of the project life-cycle.

NOTE: The list of recommended actions below is not a complete list of possible cybersecurity
measures. It is meant to be a starting point to improve the security of your device in a protected
environment. Consult with cybersecurity experts to plan, configure, operate, maintain, and
decommission your device based on your needs.
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The following table lists the actions we recommend you take to help secure your device in a
protected environment, organized by life-cycle stage:

Recommended action Defense-in-depth role

Plan
Review cybersecurity Resources to increase your cybersecurity knowledge and
awareness awareness.

Review the system
defense in depth

assumptions

Review the device security Understand how the device's security capabilities can be used in a
capabilities protected environment.

Understand the security measures expected to be provided by the
external environment in which the device is to be used.

Review the "Security risks
and mitigation strategies"
on page 34

Known security risks and the mitigation strategies to help minimize
the risks.

Review the Security risks ~ Known security risks and the mitigation strategies to help minimize
and mitigation strategies the risks.

Configure

Change the default Help reduce unauthorized access. Default account settings are
password * often the source of unauthorized access by malicious users.
Disable meter Limiting configuration options and providing read-only access
configuration methods * reduces the attack surface of the meter.

Disable webpages to deny a web browser to access the meter
data. If your meter can be accessed by a web browser outside
your protected network, a malicious user could intercept

Disable webpages and s e e,

time sync sources *

Disable the ability to modify the meter’s time source to help protect
against disguised communication from an unknown source as
being trusted and possibly invalidating timestamps.

Lock accounts after a predefined number of unsuccessful login
attempts. Lockouts help reduce brute-force password attacks from
succeeding.

Define lockouts and event
timeouts *

Limit user access to the minimum, least privilege level of access

needed to perform their job functions.
Limit user access*

Revoke user privileges when no longer needed due to role
change, transfer, or termination.

Edit meter access event Edit the default meter access event priorities that are logged to the
* event log to meet your reporting requirements.

loggin
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Recommended action Defense-in-depth role

Create strong passwords for each user that requires access to the
meter. Default account settings and weak passwords are often the
Create and change user source of unauthorized access by malicious users.

* .
asswords Follow user account management tasks as described by your
organization or contact your network administrator. For example,
maximum password age or history policies.

Advanced security is the default meter security mode. If your
Set up Advanced security * meter uses standard security mode, we recommend you change it
to advanced.

Disable unnecessary and unused communication protocol ports,

such as SFTP and network ports, to reduce the meter attack
Disable unused protocols  gyrface.

and change default port

Change port number default values to reduce the predictability of
numbers

port use.
See "Protocols, ports, and connections" on page 75.

Revenue-lock the meter

and use anti-tamper
sealing points

Validate security settings Verify the meter security configuration.

Physical lock switch with tamper-evident seal to prevent remote
modification of revenue parameters, settings, and data.

Assign a dedicated reader  Assigning a dedicated reader can help prevent event log entries
for event log notifications being overwritten before they are reviewed.

A syslog server can receive logs from multiple devices and store
Configure syslog to store  the log information as needed. Syslog helps maintain meter log
event logs information for extended periods of time.

See "Syslog" on page 247.

Operate
Monitor event logs for suspicious activity and to help identify the

Monitor the event log cause of cybersecurity breaches that could lead to a cybersecurity
incident.

Report a cybersecurity Report suspicious activity, a cybersecurity incident, or a

incident or vulnerability vulnerability to Schneider Electric.

Maintain

) Keeping your device firmware up to date helps protect you from
Apply firmware updates

security vulnerabilities.

Follow your company's policies and standards by periodically
checking your device locks and seals to verify that the device has
not been tampered with.

Check the revenue lock
and anti-tamper seals
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Plan

Recommended action Defense-in-depth role

Limit user access to the minimum, least privilege level of access

needed to perform their job functions.
Review user accounts on a

) Revoke user privileges when no longer needed due to role
regular basis

change, transfer, or termination.
See "Limiting user access" on page 42 for details.

Keep your network security Helps reduce your attack surface, decreasing the likelihood of a
up to date. vulnerability.

Perform security audits Help verify the security status of your system.
Decommission

Record decommissioning  Document disposal actions according to your company’s policies

activities and standards to keep a record of activities.
Wipe the device Help prevent the potential disclosure of data.

Follow decommission and sanitization tasks as described by your
organization or contact your network administrator.

Decommission-related Decommission network and security rules. For example, a firewall
rules and sanitize records  rule that could be used to get past the firewall.

Perform records tracking sanitization tasks to remove records in
related systems. For example, monitoring SNMP servers.

Dispose, reuse, or recycle
the device

Follow local disposal regulations.

* For detailed information on the default meter security settings, see "Default meter security
settings" on page 50.

Before you install your device, use the following planning information to help you prepare for the
installation and commissioning of your meter in your facility.

* "Cybersecurity awareness" on page 29
* "System defense-in-depth assumptions” on page 30
* "Device security capabilities" on page 31

* "Security risks and mitigation strategies" on page 34

Cybersecurity awareness

Knowledge is the first step to help prevent cyber intrusions. Review the following to increase your
cybersecurity awareness:
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* Cybersecurity Best Practices guide

* EcoStruxure™ Power Guide for Designing and Implementing a Cyber Secure Digital Power
System

Subscribe to Schneider Electric security notifications

Register for Schneider Electric security notifications on the Schneider Electric Cybersecurity

Support Portal website.

System defense-in-depth assumptions

Defense-in-depth is an information security strategy integrating people, technology, and
operations capabilities to establish variable barriers across multiple layers and dimensions in your
information technology and control system.

Defense-in-depth helps minimize data protection gaps, reduces single-points-of-failure, and
creates a strong cybersecurity posture. The more layers of security in your system, the harder it is
to breach defenses, take digital assets or cause disruption.

Using a defense-in-depth strategy by securing the device in a protected environment will help
reduce your attack surface, decreasing the likelihood of a vulnerability.

Before you install your device, review the following system defense-in-depth assumptions. If you
have not already adopted these assumptions, we strongly recommend you add them to help
improve your cybersecurity posture.

Site security assumptions

* Perimeter security — Installed devices, and devices that are not in service, are in an access-
controlled or monitored location.

* Emergency power — The control system provides the capability to switch to and from an
emergency power supply without affecting the existing security state or a documented
degraded mode.

Network security assumptions
* Controls against malware — Detection, prevention, and recovery controls to help protect
against malware are implemented and combined with appropriate user awareness.
* Physical network segmentation — The control system provides the capability to:
— Physically segment control system networks from non-control system networks.

— Physically segment critical control system networks from non-critical control system
networks.

* Logical isolation of critical networks — The control system provides the capability to
logically and physically isolate critical control system networks from non-critical control
system networks. For example, using VLANS.
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* Independence from non-control system networks — The control system provides network
services to control system networks, critical or non-critical, without a connection to non-
control system networks.

* Zone boundary protection — The control system provides the capability to:
— Manage connections through managed interfaces consisting of appropriate boundary

protection devices, such as proxies, gateways, routers, firewalls, and encrypted tunnels.

— Use an effective architecture. For example, firewalls protecting application gateways
residing in a DMZ.

— Control system boundary protections at any designated alternate processing sites should
provide the same levels of protection as that of the primary site. For example, data
centers.

* No public internet connectivity — Access from the control system to the internet is not
recommended. If a remote site connection is needed encrypt protocol transmissions.

* Resource availability and redundancy — Ability to break the connections between different
network segments or use duplicate devices in response to an incident.

* Manage communication loads — The control system provides the capability to manage
communication loads to mitigate the effects of information flooding types of DoS (Denial of
Service) events.

* Control system backup — Available and up-to-date backups for recovery from a control
system failure.

* Encrypt protocol transmissions over all external connections — Use an encrypted
tunnel, TLS wrapper, or a similar solution.

Administrative assumptions

* Cybersecurity governance — Available and up-to-date guidance on the secure use of
information and technology assets in your company.

* Firmware upgrades — Meter upgrades are implemented consistently to the current version of

firmware.

For detailed information on the device security capabilities, see "Device security capabilities" on
page 31.

Device security capabilities

Your device includes security capabilities that, when combined with other defense-in-depth
measures, can help reduce vulnerabilities.

Before you install your device, carefully review the following device security capabilities to
understand how you can configure and use the device securely in a protected environment.
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Security area

Physical

Information
confidentiality

Access

Device security capabilities

Revenue-lock switch
Anti-tamper sealing points

LED lock status indicator on the
device

Revenue lock icon on the display.

SSH, SFTP, HTTPS support, Secure
ION, and Secure EtherGate

User authentication identifies and

authenticates software processes and

devices managing accounts.

Least privilege in multiple dimensions:

read, peak demand reset, time sync,
test mode, meter configuration, and
security and communications
configuration.

User account lockout limits the
number of unsuccessful login
attempts.

Use control restricts allowed actions
to the authorized use of the control
system.

Supervisors can override user
authorizations by deleting user
accounts.

Password strength feedback using
ION Setup.

Role in defense-in-
depth

These capabilities help
prevent unauthorized
access to revenue-
related parameters and
settings or leave clear
evidence that the device
has been physically
tampered with.

These secure protocols
employ cryptographic
algorithms, key sizes,
and mechanisms to help
prevent unauthorized
users from reading
information in transit.

These capabilities help
enforce authorizations
assigned to users,
segregation of duties,
and least privilege.
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Role in defense-in-
depth

Security area Device security capabilities

* Internal time synchronization.

* Time source integrity protection and
meter configuration event logging.

* Timestamps, including date and time,
match the meter clock.

* The device embeds user information  These capabilities

when a change is made. support the analysis of
security and user
account events and help
protect the device from

° SSH server hosts an internal SFTP
Device configuration site and stores files in the meter’s
flash memory, such as webpages,

COMTRADE records, and firmware Uiz itz Elizre i)
files and record configuration

changes.
* Settings can be saved as a Security

Configuration File (.scf) using ION
Setup.

* Offload information to syslog or a
protected storage or retention
location.

* Least functionality.

* Default port numbers can be changed
to lower the predictability of port use.

* Unused protocols can be disabled to

These capabilities help
reduce the attack surface of the

prohibit and restrict the

. . device.
Device hardening use of unnecessary
* Inactivity timeout requires sign in after functions, ports,
a ’[ime—period of inaCtiVity for protoco'sy and services.
webpages, display, and Secure ION
protocol.

* Limit the number of consecutive failed
login attempts.
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Role in defense-in-
depth

Security area Device security capabilities

* Machine and human-readable
reporting options for current device
security settings.

* Audit event logs to identify:

— Meter configuration changes.
These capabilities help

— Energy management system
2l 2 y provide a method to

events. _
. generate security-
Operation * Audit record storage capacity related reports and
communication to notify a user when manage event log
the threshold is approaching. storage.

* Audit storage capacity of 5,000 event
logs by default and alternate methods
for log management.

* Time source integrity protection and
event logged when changed.

- . , , This security capability
* Digitally signed firmware is used to

help protect the authenticity of the helps protect the
Maintenance: Upgrade ) PP ) y authenticity of the
firmware running on the meter and ) .
and backup firmware running on the

only allows firmware generated and

. meter and facilitates
signed by the manufacturer.

protected file transfer.

* Purge shared memory resources o
through device wiping and other These capabilities help

decommissioning tasks. prevent the potential
Decommissioning disclosure of data when
* Physical (recommended) or adEfen

sustainable device disposal decommissioned
possibilities.

For detailed information on the system defense-in-depth assumptions, see "System defense-in-
depth assumptions" on page 30.

For detailed information on how to help secure your device in a defense-in-depth protected
environment, see "Recommended actions" on page 26.

Security risks and mitigation strategies

Review the following issues and security risks and the mitigation strategies to help minimize the
risks:
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Cybersecurity

Configure

User accounts

Default account settings
are often the source of
unauthorized access by
malicious users.

Secure protocols

ION, Modbus, DNP, DLMS,
IEC 61850 and some IT
protocols are unsecure.

The device does not have
the capability to transmit
data encrypted using these
protocols.

Self-signed certificates

Factory shipped meters
include a self-signed SSL
certificate.

An SSL certificate is
required to use webpages
over HTTPS and Secure
ION (ION over TLS).

Security risk

If you do not change the
default password,
unauthorized access can
occur.

If a malicious user gained
access to your network,
they could intercept
communications.

Self-signed certificates
can't be validated. An
attacker with access to the
network could pose as the
device to obtain credentials
sent over the TLS tunnel.

Mitigation strategies

Change the default password of 0
(zero) to help reduce unauthorized
access. See "Changing the default
password" on page 37.

For transmitting data over an internal
network, physically or logically
segment the network.

For transmitting data over an
external network, encrypt protocol
transmissions over all external
connections using an encrypted
tunnel, TLS wrapper, or Secure ION.

See "System defense-in-depth
assumptions" on page 30.

Disable unused protocols

Use a Certificate Authority (CA)
signed SSL certificate and external
network controls.

This section contains detailed information on the following tasks:

* "Meter security configuration" on page 36 in a protected environment

* "Disabling and enabling protocols and changing port numbers" on page 46

* "Verifying the meter security settings" on page 47

* "Applying security settings to multiple meters" on page 48

This section also includes the following reference information:

* "Default meter security settings" on page 50

* "Advanced security mode" on page 51
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Meter security configuration

Meter security configuration using ION Setup consists of the following tasks:

1.

2
3.
4

Open a Security Configuration File

. Configure the meter security settings

Push the updated security settings to the meter

. Store the updated SCF file

Opening a meter security configuration file

Meter security settings are stored in an encrypted Security Configuration File (SCF).

Use ION Setup to open a SCF file.

Prerequisites:

Meter connection using ION Setup.
Login credentials.

Security configuration access privileges.

To open the meter security configuration file:

1.

In ION Setup, select the meter, and then open Setup Assistant.

2. Click Security > Security Mode > Edit.
3.
4

Enter the meter password, and then click OK.

. Select the SCF file that you want to edit, and then click Open.

NOTE: We recommend that you use Advanced security mode.

For more information on SCF files, see "Storing Security Configuration Files" on page 45.

The meter security configuration settings open in the ION Setup Security wizard.

Next, configure the meter security settings.

Configuring the meter security settings

After you open a SCF file, ION Setup displays the security settings in a Security wizard.

Use the ION Setup Security wizard to complete the following security configuration tasks:

"Changing the default password" on page 37

"Disabling and enabling meter configuration options" on page 37
"Disabling and enabling webpages and time sync sources" on page 38
"Defining lockout and event timeout" on page 39

"Editing meter access event logging" on page 40

"Limiting user access" on page 42

"Creating and changing user passwords" on page 43
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Changing the default password

Change the default password of 0 (zero) to help reduce unauthorized access. Default account
settings are often the source of unauthorized access by malicious users.

Prerequisites:

* Open a Security Configuration File in the ION Setup Security wizard.

To change the default password:

1. Inthe ION Setup Security wizard, click Next to navigate to Define individual
users/passwords.

2. Highlight USER1, and then click Password.

3. Enter and confirm the new password.

TIP: Use strong passwords to increase the password complexity. A password can be any
combination or letters and numbers, up to sixteen characters.

NOTICE

LOSS OF ACCESS

Ensure that the password you set is compatible with the device front panel and any
software used to communicate with the device.

Failure to follow these instructions can result in loss of access to the device.

While ION Setup supports up to sixteen character passwords, some ION software clients
may not yet support passwords longer than six alphanumeric characters.

4. Click OK.
5. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

Disabling and enabling meter configuration options

Limiting configuration options, such as Modbus, webpages, and the display, and providing read-
only access reduces the attack surface of the meter.

Prerequisites:

* Open a Security Configuration File in the ION Setup Security wizard

To disable and enable meter configuration methods:
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1. Inthe ION Setup Security wizard, click Next to navigate to Security Options.
2. In Security Options:

Select or clear Enable Web to enable or disable the ability to view meter settings online
using webpages.

Select or clear Allow setup by webpages to enable or disable the ability to change meter
settings using webpages.

Select or clear Allow Front Panel programming to enable or disable the ability to change
meter settings using the display.

Select from the Modbus Access drop-down list:
— None — Disables built-in Modbus map access.

— Read/Write — Enables configuration of basic metering parameters using only Modbus
communications protocol.

— Read Only — Enables ability to read metering parameters using only Modbus
communications protocol. This option is enabled by default.

3. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

Disabling and enabling webpages and time sync sources

Disable webpages to deny a web browser to access the meter data. If your meter can be
accessed by a web browser outside your protected network, a malicious user could intercept
communications. See "Disabling and enabling protocols and changing port numbers" on page 46
for details on enabling HTTPS.

Disable the ability to modify the meter’s time source to help protect against disguised
communication from an unknown source as being trusted and possibly invalidating timestamps.
See “Configuring time information using ION Setup” for detailed steps on setting up the time
source.

Prerequisites:

* Open a Security Configuration File in the ION Setup Security wizard

To disable and enable webpages and time sync sources:
1. Inthe ION Setup Security wizard, click Next to navigate to Security Options.
2. In Security Options:

— Select or clear Enable Web to enable or disable webpages for viewing meter data
online using a web browser.

— Select or clear Allow Broadcasting Time Synchronization to enable or disable the
ability to modify the meter’s time synchronization source.
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3. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

Defining lockout and event timeout

A lockout prevents logging into a valid user account after a predefined number of unsuccessful
login attempts. Lockouts help reduce brute-force password attacks from succeeding.

Event timeout defines the time interval during which identical incorrect credentials are treated as a

single login attempt for event recording.

NOTE: Failed user login attempts over Ethernet—and any associated lockouts—will apply to both
ION and Secure ION. Failed user login attempts over other communication channels—such as a
serial port—are tracked separately.

You can define the following account lockout and event timeout options:
* Lockout after unsuccessful login attempts.
* Lockout duration.

* Eventtimeout for ION or Secure ION only, and only when not using ION sessions.

Prerequisites:

* Open a Security Configuration File in the ION Setup Security wizard

To define user lockouts and timeouts:

1. Inthe ION Setup Security wizard, click Next to navigate to Select protocol lockout
options:
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Select protocol lockout options

Step 3 Protocol Lockouts

X

protocol settings.

Define for each twpe of protocal the number of invalid login attempts that will be
allowed per uzer and timeout if applicable.
Defing the lockout duration and access event prionties; these apply ko all

Pratacol Lockout Ewvent Tirmeout Edit...
2 attempts 20 minutes
YWieh 3 attempts I,
FTP 3 attemptz I A,
T elnet g attempts B A,
Factary & attemnpts B
Front Panel 8 attempts P 28,
Lockout duration: 1440 | minutes Events. ..
< Back Next = Cancel Help

2. Select each protocol and click Edit to change lockout and timeout values for:

— User lockout after unsuccessful login attempts.

— Timeout for ION protocol only.

3. Enter a value for the Lockout duration in minutes.

4. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

Editing meter access event logging

The event log monitors meter access events such as user logins and user account lockouts.

You can edit the default meter access event priorities that are logged to the event log to meet your

reporting requirements.

To monitor meter access events, see "Monitoring the event log" on page 53.

Prerequisites:

* Open a Security Configuration File in the ION Setup Security wizard.

To configure meter access event logging:

1. Inthe ION Setup Security wizard, click Next to navigate to Select protocol lockout

options:
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2. Click Events. The Event Priorities dialog box opens:
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3. For each meter access event priority, set the value according to your reporting
requirements. The following table describes the priority value ranges:

Priority Description Value range

None Not recorded in the event log. 0

The default event log cutoff value is 5. Event
values equal to or less than the cutoff value

-5
are not recorded in the event log norin
Info Only syslog records.
Recorded in the event log and in syslog 6-63
records.
Produces low alarm.
Low Recorded in the event log and in syslog 64-127

records.
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Priority Description Value range

Produces medium alarm.

Medium Recorded in the event log and in syslog 128-191
records.

Produces high alarm.

High Recorded in the event log and in syslog 192-255

records.

4. Click OK.
5. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

You can also change event priorities for cybersecurity events using ION Setup Advanced Mode.

Limiting user access
Limit user access to the minimum level of access needed to perform their job functions.
Revoke user privileges when no longer needed due to role change, transfer, or termination. User

credentials do not expire.

NOTE: The maximum number of users is 50. Users can be added or removed at any time.

Prerequisites:

* Open a Security Configuration File in the ION Setup Security wizard

To define user access:

1. Inthe ION Setup Security wizard, click Next to navigate to Define individual
users/passwords.

NOTICE

DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.
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2. Foreach user, select the user, and then assign their permissions:
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See for "Access " on page 32 information on the device access level permissions.
3. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

Creating and changing user passwords

Create strong passwords for each user that requires access to the meter. Default account settings
and weak passwords are often the source of unauthorized access by malicious users.

To optimize cybersecurity in a protected environment, follow user account management tasks as
described by your organization or contact your network administrator, for example, maximum
password age or history policies.

Prerequisites:

* Open a Security Configuration File in the ION Setup Security wizard.

To change a password:

1. Inthe ION Setup Security wizard, click Next to navigate to Define individual
users/passwords.
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NOTICE

DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.

2. For each user that you want to assign or change a password:
a. Highlight the USER, and then click Password.

b. Enter and confirm the password.
TIP: Use Password strength to increase the password complexity. A password can be
any combination or letters and numbers, up to 16 characters.

c. Click OK.

3. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

You can also change the password using ION Setup Diagnostics tool, Security Options Module
using ION Setup Advanced Mode, and Power Monitoring Expert.

Setting up Advanced security

Meter security has strong user login, user access management, and password complexity.

NOTE: We recommend that you use Advanced security mode.

For detailed information on the Advanced security mode capabilities, see "Advanced security
mode" on page 51.

Prerequisites:
* Meter connection using ION Setup.
* Login credentials.

* Security configuration access privileges.

To set up Advanced security:

1. Open ION Setup > select the meter > Setup Assistant.

2. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.
3. Select the advanced.scf security configuration file.
4

. Click Open. If prompted, click Yes to use Advanced security.
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5. Next, either:

— Continue configuring the meter security settings.

— Click Finish to push your security configuration changes to the meter.

Pushing updated security settings to the meter

After you have completed configuring the meter security settings, push the updated settings to the
meter.

To push the updated security settings to the meter:

1. Inthe ION Setup Security wizard, click Next until you reach the Security wizard pane that
has a Finish button.

2. Click Finish. A Confirmation message box opens.

3. Click Yes to confirm your changes.

ION Setup pushes your security configuration changes to the meter.

Next, store the Security Configuration File.

Storing Security Configuration Files

After ION Setup pushes the security configuration updates to the meter, it prompts you to store
the edited security settings to an encoded Security Configuration File (SCF).

We recommend that you store the SCF file using a new filename when you change the meter
security settings. If you do not use a new SCF filename, your changes will overwrite the settings in
the SCF file that you opened.

NOTE: If you don't store your security changes to a SCF file, your changes are stored on the
meter only; no other record of your security configuration is kept.

ION Setup stores SCF files in the following folder: C: \ProgramData\Schneider
Electric\ION Setup\Security

Store your meter’s Security Configuration File (SCF) in a protected location.

4 WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Store Security Configuration Files (SCF) to a secure site.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern how sensitive system files are securely stored vary from site to
site. Work with the facility IT System Administrator to ensure that such files are properly secured.
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Security log file

The first time you store a SCF file, ION Setup creates a security log file (SECURITY.LOG) in the
\Security folder.

The security log file contains the history of security configuration files saved from ION Setup.

Use SECURITY . LOG to track meter security configuration changes and to select the correct SCF
file for a meter whose security settings you want to edit or use in another meter.

NOTE: The security log file is stored as plain text.

Disabling and enabling protocols and changing port numbers

Disable unnecessary and unused communication protocol ports—such as SFTP, standard ION
protocol, and network ports—to reduce the meter attack surface. Change port number default
values to reduce the predictability of port use. See “Protocols, ports and connections" for port
defaults.

Leave Secure ION enabled for configuration changes and upgrades. If Secure ION is disabled,
use the display, Modbus programming, or webpages to access the meter.

Prerequisites:
* Meter connection using ION Setup.
* Login credentials.

* Security configuration access privileges.

NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To disable and enable protocols and change port numbers:

1. In ION Setup, select the meter, and then open Setup Assistant.
Click Communications > Advanced Ethernet > Protocols.
Select the protocol, and then click Edit.

Change the default port number.
Enable or disable the protocol.

Click OK.

N o o &~ W Db

Click Exit.
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Cybersecurity

Verifying the meter security settings

Generate a Meter Configuration Report to verify the meter security settings and user privileges.

Prerequisites:

* Meter connection using ION Setup.

* Login credentials.

To verify meter security settings:
1.
2.

4. Click Close or Save As to save the report as a .txt file.

In ION Setup, select the meter, and then open Setup Assistant.
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5. (Optional) Edit the meter security settings.

Felp

Click Reports > Meter Configuration > Display. The Meter Configuration Report for your
meter opens.

Scroll down to the Security section to validate the meter security settings. For example:
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Viewing the Device Configuration Checklist

View the Device Configuration Checklist to verify that the default password is not being used.

To view the checklist:
1. Click Tools > Options.

2. Click the Assistant tab and select the Configuration Checklist check box.
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Applying security settings to multiple meters

A Security Configuration File (SCF) can be applied to other meters. If differences in capabilities
between meters exist, ION Setup will indicate a capability is not available.

Prerequisites:
* Meter connection using ION Setup.
* Login credentials.

* Saved Security Configuration File (.scf).

NOTICE

DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.
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To apply security settings to multiple meters:

1.
2.
3.

Open ION Setup > select the meter > Setup Assistant.
Security > Security Mode > Send. The Open Security Configuration file dialog box opens.
Open the meter security configuration file.

TIP: Open the security log file to determine the SCF file you want. See "Opening a meter
security configuration file" on page 36 for more information.

Click Yes to confirm the security update.

The security settings in the SCF file are sent to the meter.
Click Exit.

Updating passwords on multiple meters

Use the ION Setup Diagnostics tool to update passwords on multiple meters at the same time.

Prerequisites:

* Meter connection using ION Setup.

* Login credentials.

* Security configuration access privileges.

NOTICE

DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.

To update passwords on multiple meters:

1.

10.

© © N o a ~ 0N

Open ION Setup > select the System.

Tools > Diagnostics. The Systems diagnostics: System dialog box opens.
Select the Tools tab > Advanced Security Password Updater.

Click Open.

Select the meters that need a password update.

Click Set Info.

Click Start.

Click Allow passwords to be visible.

Select each user, click Password, and then enter a new password.

If the meter is connected to a display, update the password for the Front Panel.

Click Start. A Notice message box opens.
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11.
12.

13.

14.
15.
16.

Click Proceed. A result is displayed for each device.

Click Save As to save a copy of updated meter passwords in a .txt file. The Save As dialog
box opens.

Save the file with a unique file name to a protected location. An ION Setup message box
opens

Click OK.
Click Exit.
Click Close.

Default meter security settings

Review the following default meter security settings to understand how you can securely
commission your meter:

Area Setting Default
HTTPS with HTTP redirect Enabled
SSH Terminal Disabled
Communications SFTP Enabled
protocols Modbus TCP Enabled
ION Enabled
ION over TLS (Secure ION) Enabled
Time and time . o
. Broadcast time synchronization Enabled
keeping
Webpages Webpages Enabled
Configuration using the display Enabled
) . Configuration using webpages Disabled
Configuration
Configuration using Modbus )
i Disabled
programming
Meter access . _ o o
event logging Valid login event priority 0 (No priority)
See "Editing
meter access Invalid login event priority 128 (Medium priority)
event logging" on
page 40 for Lockout event priority 255 (High priority)
details.
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Area Setting Default

Enabled if Advanced security was
used before upgrading meter
firmware to v3.0.0. See "Advanced
security mode" on page 51 for
details.

Advanced security mode
(advanced.scf)

Enabled if Standard security was
used before upgrading meter
firmware to v3.0.0.

We recommend that you use

Security mode Advanced security mode.

. See:
Legacy security support
(standard.scf) * “Legacy security support” for
details on Legacy security
support.

* "Setting up Advanced security"
on page 44 for information on
switching to Advanced security
mode.

For recommendations on how to configure and use your meter in a protected environment, see
"Recommended actions" on page 26.

Advanced security mode

Advanced security mode lets you add up to 50 users, has strong user login, and privilege
management.

NOTE: We recommend that you use Advanced security mode.

This topic lists the advanced mode security capabilities, as well as detailed information on user
access permissions, and the default username and password.

Advanced security mode capabilities

The following table lists the security capabilities of advanced security mode:
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Security capability

Description

User credentials and
password robustness

Use a single account to access the meter with a numeric password
for login.

Use multiple user accounts with alphanumeric passwords for login
and configuration changes.

Password range and limit: Any combination of letters and
numbers, up to 16 characters.

Password strength feedback using ION Setup.

User account lockouts and
timeouts

Define user account lockout criteria after unsuccessful login
attempts and define event timeout period.

User privileges

User accounts with variable permissions to read access, test
mode, or configuration privileges.

Webpages

Disable or enable webpages for viewing meter data online using a
web browser (Web Server).

Configuration

Disable or enable ability to configure the meter using:

* Modbus communications programming or allow read-only
viewing.

* Thedisplay

* Meter webpages (Web Server programming).

Disable and enable time synchronization.

Password required for broadcast time synchronization
configuration changes using the display or communication
protocols.

Cybersecurity event logs
and reports

Set up cybersecurity event logs and alarms using event priorities.

User access (Advanced security mode only)

The following table lists the Advanced security mode user access details:

Access type

Permission

Time Sync Access

Set the meter’s time and time synchronization parameters.

Read Access

View parameters, except security configuration.

Peak Demand Reset
Access

Reset peak demand values.

Comm Config Access

Configure communication settings.

Test Mode Access

Switch the meter to test mode, if available with your meter type.

Full Meter Config Access

Configure meter settings.

Security Config Access

Configure security settings.

User accounts (Advanced security mode only)

The following table lists the Advanced security mode user account details:
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Operate

Username Default password Account description
Default administrator. This account has full meter
User1 0 (zero) , . . .
access, including configuration.
Default viewer. This account has view only
User2 0 (zero)
access.
User3, User4, ... These user accounts are not activated; they do
User50 not have default passwords.

Related topics:
"Changing the default password" on page 37.
"Legacy security support" on page 280

"Setting up Advanced security troubleshooting” on page 305

Review the following recommended actions to operate your device in a protected environment:
* "Monitoring the event log" on page 53
* "Revenue lock LED behavior" on page 294

* "Reporting a security incident or vulnerability " on page 54

Monitoring the event log

Monitor event logs for suspicious activity and to help identify the cause of cybersecurity breaches
that could lead to a cybersecurity incident.

NOTE: The default event log limit is 5,000 records. When the limit is reached, new log entries
overwrite older ones. To be notified when the Event Log record limit is approaching, see
Assigning a designated reader for event log notification. To extend log record retention, offload
information to syslog or a protected storage or retention location, see Configuring Syslog network

settings using ION Setup.

For more information on meter access logging events, see "Editing meter access event logging”
on page 40.

Prerequisites:
* Meter connection using ION Setup.
* Login credentials.
To monitor the event log:
1. In ION Setup, select the meter, and then open Setup Assistant.
2. Click Reports > Event Log > Display.

3. Select the range of records you want to view, the type, and then click OK.

7EN02-0390-08

Public 53



Cybersecurity PowerLogic™ ION9000 series - User manual

4. Click Save As to save the log to your local machine or print the event log.

5. Click Close.

Reporting a security incident or vulnerability

To report suspicious activity or a cybersecurity incident, go to the Schneider Electric Report an
Incident website.

To report a security vulnerability affecting your product or solution, go to the Schneider Electric
Report a Vulnerability website.

Maintain

This section contains information on the tasks you should perform periodically to help maintain
the security of your meter in a protected environment.

Viewing and downloading an event log

Generate an event log report to assist with cybersecurity incident investigations.

Event logs contain meter configuration changes and energy management system events.
Prerequisites:

* Meter connection using ION Setup.
* Login credentials.

* Configured event logs and alarms.

To view and download an event log:
1. Open > select the meter > Setup Assistant.
2. Click Reports > Event Log > Display. The Log reports dialog box opens.
3. Select a record range for the report and click OK:
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The Event Log for your meter opens.

NOTE: Only All available records and Last options are available for Event Logs.

4. Click Save As.
5. Select CSV or TXT > Save.
6. Click Close.
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Upgrades and security configuration

When meter firmware or ION Setup software is upgraded — Security configuration remains the
same until changed, including usernames and passwords. It is recommended security
configuration is reviewed after an upgrade to analyze privileges for new or changed device
features and revoke or apply them according to your company’s policies and standards.

For detailed information on upgrading firmware, see "Firmware upgrades" on page 280.

Decommission

Review the following recommended actions to decommission your device in a protected
environment:

Record activities — Document disposal actions according to your company’s policies and
standards to keep a record of activities.

* "Wiping the device" on page 55
* Decommission-related rules and sanitize records:

— Follow decommission and sanitization tasks as described by your organization or contact
your network administrator.

— Decommission network and security rules. For example, a firewall rule that could be used
to get past the firewall.

— Perform records tracking sanitization tasks to remove records in related systems. For
example, monitoring SNMP servers.

* "Disposal, reuse, recycling" on page 58

Wiping the device
Wipe the device before decommissioning it to help prevent potential disclosure of data.
Prerequisites:
* Meter connection using ION Setup.
* Login credentials.

* Security configuration access privileges.

NOTICE

DATA LOSS

Ensure all important data from the device is saved before performing a reset.

Failure to follow these instructions can result in data loss.
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NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with your device.

Failure to follow these instructions can result in loss of access to the device.

NOTE: Complete the following tasks in the order listed; overwrite the communications module
registers last to maintain meter connectivity.

To wipe the device:

1.

Overwrite the meter template file. This overwrites the meter template with the default factory
template. See “Overwriting the Meter template file” for detailed steps.

Delete files in the documents folder in SFTP file directory using SFTP client software. See
“SFTP” for more information.

Delete the custom SSL certificate. See “Deleting a custom SSL certificate” for more
information.

Delete webpages. See “Deleting custom webpages” for more information.

Delete the IEC 61850 configuration file. This deactivates functions related to the IEC 61850
protocol. See “Deleting an IEC 61850 configuration file” for more information.

Restore default security configuration. See “Restoring default security configuration” for
more information.

Overwrite factory module registers. This deletes values for:

— Device owner.
— Device tag.

— Device location.
— Device name.

See “Overwriting factory module registers” for more information.

Perform a Master Reset. This deletes values for:

— Eventlog, data, and waveform records.

— Power quality event (COMTRADE) files.

— Energy, metering, min./max., revenue and test mode, and peak demand values.
— Disturbance (sag/swell event) counter, EN 50160 parameters and statistics.

Overwrite communications module registers. This deletes values for network infrastructure
details. See “Overwriting communications module registers” for more information.
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Overwriting the meter template file

1.

9.
10.
11.
12.
13.

N o g M w DN

Go to www.se.com and search for the meter template for your device.
Download the ZIP file and extract files.

Open ION Setup.

Click the meter to select it > Setup Assistant.

Click Template > Send to Meter tab.

Click Send.

Navigate to the extracted files and select the DCF file.
NOTE: FWN file type is also an option.

Click Open.

Click Proceed. The Template Paste Options dialog box opens.
Clear all check boxes and click OK.

Click Yes. The overwriting process could take a few minutes.
Click OK.

Click Exit and then OK.

Restoring default security configuration

NOTICE

DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.

4.
5.

. Open ION Setup > select the meter > Setup Assistant.

Click Security > Security Mode > Edit. The Open Security Configuration file dialog box
opens.

Select the standard.scf and click Open. If prompted, click No to use Legacy security
support.

Click Next to navigate to the Define individual users/passwords screen.

Click Finish. The Confirmation message box opens.

Overwriting factory module registers

1.

2
3.
4

Open ION Setup.

. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

Double-click Factory Modules folder > select meter type.

. Select the Setup Registers tab.
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5. Type text or characters to replace values for these setup registers by selecting them and
click Edit:

— FAC1 Device Namespace.

— FAC1 Device Name.

FAC1 Owner.

FAC1 Tag1.

FAC1 Tag2.
6. Click Send.

Overwriting communication module registers

1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced.
3. Double-click Comm Modules folder > Ethernet > Setup Registers.
4

. Type text or characters to replace values for network infrastructure setup registers by
selecting them and clicking Edit. Some registers include:

— Stored IPv4 Address.
— Stored IPv4 Subnet Mask.

— Stored IPv4 Gateway.
NOTE: IP values can be replaced with text.

— Primary DNS.

— Secondary DNS.

— All'servers.

— All port numbers.

— Ethernet Device Name.

— Stored IPv6 Global Gateway.
— Domain Name.

5. Click Send.

Disposal, reuse, recycling

Before removing the device from its intended environment, follow the recommended actions in
"Decommission” on page 55.

Follow device removal tasks described by your organization or contact your network administrator
to determine a responsible method of disposal.

Dispose the device according to the legislation of the country. Some regulatory organizations
include:

* The United States Environmental Protection Agency (EPA) for guidance on the sustainable
management of electronics.
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— The EPA provides an Electronic Product Environmental Assessment Tool (EPEAT) that
helps assess the environmental attributes of electronics.

* The European Waste Electrical & Electronic Equipment Directive (WEEE Directive) is
the community directive on waste electrical and electronic equipment.

* The European Restriction of Hazardous Substances Directive (RoHS) directive on the
restriction of the use of certain hazardous substances in electrical and electronic equipment.

NOTICE

UNAUTHORIZED OR UNINTENDED ACCESS TO CONFIDENTIAL DATA

Store devices that are not in service in an access-controlled or monitored location.

Failure to follow these instructions can result in unauthorized or unintended access to
sensitive or secure customer data.

Device disposal

It is recommended that the entire device is physically destroyed. Destroying the device helps
prevent potential disclosure of data contained in the device that was not removed.

A WARNING

HAZARD OF PHYSICAL INJURY

» Do not destroy devices without the proper safety training.
* Never burn a device, put a device in a microwave, or pour acid on a device.

Failure to follow these instructions can result in death or serious injury.

Device reuse

Store the device in a location that is access controlled or monitored if there is potential for reuse.

Device recycling

Go to www.se.com and search for the Product Environmental Profile for your meter type to get
instructions on managing e-waste.
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Installation and commissioning

This chapter supplements the meter installation guide and provides guidance on commissioning
your meter.

* See your device installation guide for information related to installation.

* See your product catalog pages at Schneider Electric for information about your device, its
options, and accessories.

* Download updated documentation from www.se.com.

For the latest information about your product, or for assistance in advanced features and custom
functionality, contact your local Schneider Electric representative.

Installation

Installation, wiring, testing and service must be performed in accordance with all local and
national electrical codes.
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A DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

* Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

* Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

* Always use a properly rated voltage sensing device to confirm that all power is off.
* Do not use the data from the meter to confirm power is off.

* Do not exceed the maximum ratings of this device.

* Do not short secondary terminals of Voltage Transformer (VT).

* Do not open secondary terminals of Current Transformer (CT).

* Ground secondary circuit of CTs.

* Use only Low Power Current Transformers (LPCTs) that are approved for use with this
device.

* Do not connect CT secondary signals to meter low voltage LPCT terminals.

* Do notinstall CTs or LPCTs in equipment where they exceed 75% of the wiring space of any
cross-sectional area in the equipment.

* Donotinstall CTs or LPCTs in areas where ventilation openings may be blocked or in areas
of breaker arc venting.

* Do notinstall CTs or LPCTs using Class 2 wiring methods or connect to Class 2 equipment.
See NFPA 70.

* Secure CT or LPCT secondary conductors to ensure they do not contact live circuits.
* Assume communications and I/O wiring are hazardous live until determined otherwise.

* Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

Power system wiring

You can connect the meter’s voltage inputs directly to the phase voltage lines of the power system
if the power system'’s line-to-line or line-to-neutral voltages do not exceed the meter’s direct
connect maximum voltage limits.

The maximum voltage allowed for direct connection may be lower than the manufacturer-
specified limits, depending on the local electrical codes and regulations.

If your system voltage is greater than the specified direct connect maximum voltage, you must
use voltage (potential) transformers (VTs/PTs) to step down the voltages. Use high-bandwidth
voltage transformers in high-speed transient capture applications (ION90OQT only).
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Residual current measurement

The meter can calculate or measure the residual current, depending on how the inputs are wired.

3 CT wiring
For a 3-phase 3-wire system, the meter
calculates residual current for Ground.

For a 3-phase 4-wire system, the meter
calculates residual current for Neutral.

4 CT wiring

For a 3-phase 4-wire system, the meter
calculates residual current for Ground.

Functional ground

For a 3-phase 3-wire system, the meter
measures the residual current for Ground at 14.

For a 3-phase 4-wire system, the meter
measures the residual current for Neutral at 14.
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For a 3-phase 4-wire system, the meter
measures the residual current for Ground at I5.
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The meter’s functional ground terminal must be wired for optimal performance.

Use the supplied ferrite when terminating the functional ground terminal to earth ground. Make
sure the ground wire is looped through, around and back through the ferrite as shown.
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LVCS overview

The Low Voltage Current Sensor (LVCS) hardware option is used with external low voltage
current transformers to sense current in each phase of a power feed. Use the LVCS option to:

* Measure and monitor individual phases.

* Help reduce installation costs for new or retrofitted installations.

* Provide non-intrusive load monitoring.
LVCS only works with voltage output Low-Power Current Transformers (LPCTs) and is intended
for use with listed Energy-Monitoring current transformers rated for the application. To use LVCS,

an ION9000 LVCS meter is required. See "ION9000 meter models and accessories" on page 24
for a list of meters that support LVCS.

LPCT configuration

This section assumes your meter and LPCTs are already installed. For more information related
to installation, refer to the ION9000 series — LVCS installation guide at www.se.com.

This section illustrates two common LPCT configuration scenarios and how they are configured
using ION Setup. You can also configure LPCTs using the meter webpages or display.

Configuration scenario 1: LPCT connected directly to conductor

The LPCT is connected directly to the line to be measured.

Wieie

+ s
Comduckar
LPCT
10414
LPCT transformation ratio 10A:1V
Meter transformation ratio (default) 1AV
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Example:

Set the meter CT ratio to 10:1 to match the transformation ratio of the LPCT and report the
conductor primary current.

CT ratio:

= LPCT ratio x Meter ratio
=10:1x1:1
=10:1

Configuring LPCT connected directly to conductors
1-13
1. Open ION Setup > select the meter > Setup Assistant.
2. Click Metering Setup > Basic tab.
3. Setthe LPCT CT primary value:
a. Select PM1 CT Prim > Edit. The LVCS Configuration Setup dialog box opens.
b. Enterthe LPCT primary value.
c. Click OK.
4. Setthe LPCT CT secondary value:
a. Select PM1 CT Sec > Edit. The LVCS Configuration Setup dialog box opens.
b. Enterthe LPCT secondary value.
c. Click OK.
The CT Prim and CT Sec values are stored to the device register.

14,15

Configure these settings in Metering Setup > Advanced tab.

Configuration scenario 2: LPCT connected to secondary side of conventional CT

The LPCT is connected to the secondary side of a conventional transformer.
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Shorling Bheck

CT1 [ Conpantionsl CT)

FHHERT
CT1 (L1) transformation ratio 500A:5A
LPCT transformation ratio 10A:1V
Meter transformation ratio (default) 1AV

Example:

The total transformation ratio is the product of all component transformation ratios. Set the meter
CT ratio to match the total transformation ratio and measure the primary currentat CT1.
CT ratio:

= CT1 ratio x LPCT ratio x Meter ratio
=500:5x10:1x1:1
=5000:5 (or 1000:1)

Configuring LPCT connected to secondary side of conventional CT

11-13

1. Open ION Setup > select the meter > Setup Assistant.

2. Click Metering Setup > Basic tab.

3. Setthe LPCT and conventional CT primary values:
a. Select PM1 CT Prim > Edit. The LVCS Configuration Setup dialog box opens.
b. Enterthe LPCT primary value.
c. Click OK.
d. Select the Conventional CT check box.

e. Enter the conventional CT primary value. The calculated PM1 CT Prim value is
displayed.

f. Click OK.

4. Setthe LPCT and conventional CT secondary values:
a. Select PM1 CT Sec > Edit. The LVCS Configuration Setup dialog box opens.
b. Enterthe LPCT secondary value.
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c. Click OK.
d. Selectthe Conventional CT check box.

e. Enter the conventional CT secondary value. The calculated PM1 CT Sec ratio is
displayed.

f. Click OK.

The calculated CT Prim and CT Sec values are stored to the device register.

14,15

Configure these settings in Metering Setup > Advanced tab.

LPCT compensation

Minor phase and magnitude compensation can be made using the Instrument Transformer
Correction (ITC) module. For more information on the ITC module, see ION Reference, available
on wWww.se.com.

Removing the display from back-to-back mounting adapter

Instructions on how to remove the display, for example, if you want to connect it to another meter.

NOTE: Refer to the display installation sheet QGH42230 for installation instructions.

1. Holding the display, turn the tightening wheel with a flat-head screwdriver until it disengages
from the display.
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3. Disconnect the display cable.
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Removing the meter from back-to-back mounting adapter

You can uninstall the meter from the optional back-to-back mounting adapter.

NOTE: Refer to the meter installation guide for installation instructions.

1. Use aflat-head screwdriver to unlock the meter retainer clips.

-f'l.- £ .

2. Holding the meter firmly, swing it outwards and pull slightly upwards to detach it from the top
retaining hooks.
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Option modules

Option modules are ordered separately from your meter and can be connected to your meter
without specialized equipment.

Option modules are identified based on how they are physically connected to the meter’s external
I/O bus.

The first connected module, attached directly to the meter, is Module A. The second module,
attached to Module A, is Module B. The meter supports up to four external modules:

S ||.|,r|nl-.||"|'5|-":|':

s

Option modules are monitored and controlled by the meter’'s ION modules. External I/O modules
are mapped to the corresponding ION modules:

Option module physical position ION module mapping

Module A to Module D Port Ato Port D

Analog inputs A1 to A(n) Analog Input module A1 to A(n)
Analog outputs Q1 to Q(n) Analog Output module Q1 to Q(n)
Digital inputs S1 to S(n) Digital Input module S1 to S(n)
Digital/relay outputs R1 to R(n) Digital Output module R1 to R(n)
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Maximum number of option modules
Up to four option modules are supported per device.
Limitations:
* Only one 4-wire RS-485 module and one Fiber Ethernet module may be installed.

* Depending on the type and quantity of option modules attached to your meter, you may need
to reduce your meter's maximum operating temperature or limit the number of option
modules. See "Maximum operating temperature with option modules" on page 312 for more
information.

Commissioning

Factory default settings
Use these default values the first time you connect to your meter.

Parameter Default value

Username to log onto meter webpages USERH1

Password to log onto meter webpages or access display 0

IP address’ 169.254.0.10
Subnet mask 255.255.0.0
Gateway 0.0.0.0

COM1 Unit ID: 100
RS-485

COM4 Unit ID: 103
Language English

' The IPv6 link local address can also be used. See Self-discovery over Ethernet for details.

Commissioning using ION Setup

Use ION Setup to commission the meter for integration into your energy management system.

Connect to your meter using ION Setup then use the Setup Assistant to configure the meter.
Setup parameters are arranged in logical groupings and category folders.

Before exiting the Setup Assistant, ION Setup performs a meter configuration test and displays
the results. You can review the results and make changes as needed.

To turn off the meter configuration test:
1. Click Tools > Options.

2. Click the Assistant tab and clear the Configuration Checklist check box.

NOTE: ION Setup also performs a configuration test and displays results when configuring certain
features such as the Sag/Swell or Transient Logging wizard in the Power Quality setup assistant.
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Configuring metering parameters

Use ION Setup to configure the meter’'s metering functionality.

1. Start ION Setup and open the Setup Assistant for your meter.

2. Configure the parameters in Metering Setup > Basic.

Basic tab

Parameter Values

4W-WYE, DELTA, 3W-

Volts M
oftsMode \\~vE SINGLE, DEMO'

PT Prim 1-999,999

PT Sec 1-999,999

CT Primary  1-999,999

cT 1-999,999
Secondary '
Nominal
omina 1-999,999
Voltage
Nominal

1-999,999
Current
Nominal

50, 60
Frequency

Description
Power system type

Potential transformer's primary winding voltage
rating

Potential transformer's secondary winding
voltage rating

Current transformer's primary winding current
rating

Current transformer's secondary winding
current rating

Nominal voltage (V) used for metering functions
such as harmonic calculations and sag/swell
detection

Nominal current (A) used for metering functions
such as harmonic calculations and sag/swell
detection

Nominal frequency (Hz) used for metering
functions such as alarms

3. Configure the parameters in Metering Setup > Advanced, if appropriate.

Advanced tab

Parameter Values

PhaseOrder ABC, ACB

V4 PT Prim 1-999,999

V4 PT Sec 1-999,999

14 Prim 1-999,999

Description

Power system’s rotation order of voltage
phases

V4 potential transformer's primary winding
voltage rating

V4 potential transformer's secondary winding
voltage rating

14 current transformer's primary winding
current rating
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Parameter Values Description

14 current transformer's secondary winding
14 Sec 1-999,999 ,

current rating

. 15 current transformer's primary winding

15 Prim 1-999,999 )

current rating

15 current transformer's secondary winding
15 Sec 1-999,999 ,

current rating

Specifies whether revenue readings are
Scale Rev i )
Param ON, OFF presented as primary or secondary side values

(ON = primary side, OFF = secondary side)

' Demo mode is for demonstration only, and does not use the meter input terminals to display
values.

Using the Phasor Viewer

Phasor diagrams can help verify or troubleshoot issues with voltage and current input wiring.

Use ION Setup’s Phasor Viewer to display a real-time phasor diagram of the voltage and current
input signals.

To use the Phasor Viewer:
1. Start ION Setup and open the Setup Assistant for your meter.
2. Click Metering Setup > Phasor.
3. Select Phasor Viewer and click Show.
4

. To change the polarity of the voltage or current inputs, click Show Setup to display the
Polarity Settings.

Select the box beside the input you want to invert polarity, then click Apply to Meter.

Basic setup using the webpages or display
You can use the meter webpages or display to configure basic metering parameters.
* Using the webpages: Navigate to Setup > Metering.
* Using the display: Navigate to Setup Menu > Meter Setup.
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Communications

Communications overview

Communications is the transfer of data to and from the meter and is controlled by a combination of
hardware and software components in the meter.

For each connected communications port, the meter uses the applicable communications
protocol to establish communications with other devices or software. The protocol manages the
communications session and defines the set of rules, commands, and packet structure of the
transmitted data. You can also control which protocols are enabled or disabled on the meter.

NOTE: To maximize the performance of your power management system, it is recommended that
devices be connected directly to an Ethernet network.

Other means of controlling communications, such as who can access certain types of meter data,
are discussed in the security topics for the meter.

Your meter’s default protocol settings meet the needs of most systems with only basic
configuration. You can customize these settings to meet your specific needs. These are
advanced procedures that require an understanding of your meter’s architecture, supported
protocols, and the communications network and power system that your meter is connected to.

Ethernet communications

Your Ethernet connection source should be installed in a location that helps minimize the overall
Ethernet cable routing length and complexity of your network.

The meter supports a single IP address for both physical Ethernet connections.

Your device’s second Ethernet port acts as an Ethernet switch to help simplify network
connections and reduce installation time and costs, by having shorter Ethernet cable runs
between devices without needing additional Ethernet routers or repeaters. You cannot connect
your meter to two different Ethernet networks. The two Ethernet ports do not split the signal, so
connecting both ports should not impact your communications speed.

The meter uses dual-stack IPv4/IPv6 routing technology to manage network communications and
allow network hosts to communicate with the meter using either IPv4 or IPv6.

Ethernet communications connections

Your meter’s dual port Ethernet connections enable you to use straight-line or network loop (ring)
topology.

If local network loop Ethernet topology is required, you must enable RSTP for your meter’s
Ethernet communications to function.

Use CATS5 (or higher) Ethernet cables with unshielded RJ45 modular connectors to wire your
meter’s Ethernet communications.
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Ethernet loop topology

A Ethernet switch or hub

B  Ethernet connected meters

C LAN/WAN
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Protocols, ports, and connections

The Ethernet protocols supported by your device allow simultaneous connections through the IP
service ports.

By enabling or disabling TCP/IP protocols, you can control whether your meter accepts new
socket connection requests. Changing settings for one port does not impact the other existing
connections. Depending on the protocol, you can also change the port number.

NOTE: Some protocol port numbers are read-only and not configurable.

Protocol, ports, and connections

Protocol Port (default) Number of connections
ION (ION over TCP) 7700 8’
Secure ION (ION over TLS) 7443 8’
Modbus TCP * 502 8'
Modbus RTU over Ethernet * 7701 8’
DNP 20000 8'
DLMS 4059 8’
Modbus TCP (dedicated) > 502 32
EtherGate (Com1) 7801 1
EtherGate (Com4) 7802 1
DHCP 67 (68) 1
SFTP 22 2
Webserver (HTTPS) : 443 10
SNMP 161 N/A
SMTP server (email) outgoing only 25 1
NTP 123 1
IEC 61850 102 5

' _These eight simultaneous connections are shared by ION, Secure ION, Modbus TCP, Modbus
RTU over Ethernet, DLMS and DNP. You can have a maximum of three DNP connections. You
can have a maximum of one DLMS connection.

?_ These protocols must be enabled for Modbus gateway functionality.

® _ These are used for the meter’s webpages.

Self-discovery over Ethernet

Your meter supports Devices Profile for Web Services (DPWS) which allows for self-discovery of
the meter when it is connected to your local area network.
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When you connect your meter to your network, your meter automatically appears in your network
in Windows Explorer under Other Devices. By default, the meter is named <meter type>-<last six
digits of MAC address>. For example, a meter with a MAC address of 006078173393 appears on
the network as <meter type>-173393.

B i

A Computer connected to the network with IPv6 enabled

B LAN/WAN (Local Area Network / Wide Area Network), common subnet, no routers

C Meters with self-discovery over Ethernet connected to the network

Considerations for using self-discovery over Ethernet

* For self-discovery, the meter must be connected directly to the network using only a cable or
switches, and not going through a router.

* You must use a computer running Windows 7 or later with IPv6 enabled to use self-discovery
over Ethernet.

* The computer and the meter must be on the same subnet.

* You do not need to configure your meter’s IP address for self-discovery over Ethernet. An
IPv6 address is automatically generated from your meter's MAC address and self-discovery
takes place over IPv6.

Accessing the meter through self-discovery

Use Windows Explorer to locate and access the meter on your Local Area Network (LAN).

NOTE: Some networks restrict device self-discovery over a wireless connection. If this is the
case, make sure your computer is connected to the network using an Ethernet cable.
To access the meter through self-discovery:

1. Connect the meter’s Ethernet port to the LAN.

2. Start Windows Explorer.

3. Click Network.

The connected network devices display.
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4. Locate your meter with the name <Device Name>-<Last 6 digits of MAC address>.

5. Double-click the icon to open the meter webpages.

Ethernet configuration

To use Ethernet communications, you must configure your device’s IP settings.

You need to enter network information for any Ethernet servers used by the device (for example,
a DNS or email server). Contact your network system administrator for your IP address and other
Ethernet network configuration values.

NOTE: For meters that do not have a display, you must connect your meter directly to your
computer to set a unique IP address for each device or configure the meter to use a DHCP server
to acquire IP addresses.

It is recommended that you test your communications with the meter after changing any
communications-related settings (for example, communicating with the meter using the fully-
qualified domain name if using DNS or with assigned addresses after these are provided by the
DHCP server). In addition, make sure that any software or other devices communicating with the
meter are using the new settings.

Initial Ethernet configuration versus changing existing Ethernet settings

There are two scenarios when configuring your meter’s Ethernet communications settings: initial
configuration and changing the existing addresses when the meter is in use.

* Initial configuration: Configure your device’s Ethernet settings manually using the display or
by connecting your meter directly to your computer and using a web browser to access the
device’s webpages. Alternately, you can connect your meter to the network and configure it to
use a DHCP server to acquire an IP address.

NOTE: It is recommended during initial configuration that you use a connection method other
than the one you are trying to configure. For example, if you are configuring DHCP IPv4
settings, connect to the meter using the IPv6 Link Local address or a serial connection. This
allows you to configure the meter without being disconnected.

* Changing existing IP settings: After the meter’s Ethernet port is configured and connected to
the LAN, you can use ION Setup to configure meter settings, in addition to using the display or
meter webpages.

In either case, modify your meter’s Ethernet settings to those provided by your network system
administrator before connecting the device to your local area network (LAN).
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IP address format and ranges

When you set your meter’s IPv4 or IPv6 addresses, make sure you use the correct format and
valid ranges.

Protocol Format

IPv4 0.0.0.0 to 255.255.255.255
:: to FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

IPv6 The double colon indicates that gaps are filled with zeroes to make
the IPv6 address the correct length (32 hexadecimal numbers)

All meters ship from the factory with the IPv6 global address and IPv6 gateway undefined (set to

:.”). To communicate with the meter using IPv6 outside the local network, you must configure
these settings manually or use DHCP to assign the addresses to the meter. Within the local
network, you can use the meter’s IPv6 Link Local address.

IP addresses and network port numbers

To specify a port for an outgoing IP address, append a colon then the port number to the end of
the IP address. For IPv6 addresses, enclosed the address in square brackets then add the port
number. For example, to specify the default port for SFTP (port 22):

* IPv4:169.254.0.10:22
* IPv6: [FE80::260:78FF:FE04:5943]:22

Configurable Ethernet settings

NOTE: Some additional Ethernet settings are available in the Advanced Ethernet menu in ION
Setup and on the meter webpages.

“W” indicates the setting can be configured (written) while “R” indicates it is read-only.

Ethernet configuration settings

Setting Display ION Setup Webpages
IPv4 address w w w
IPv4 Subnet mask w W w
IPv4 Default gateway w w w
IPv4 Assignment Mode

w W w
(DHCP/Stored)
IPv6 Assignment Mode

w w w
(DHCP/Stored)
Ethernet Device name R W w
Domain name R w w
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Setting Display ION Setup Webpages

IPv6 Link Local Address R
IPv6 global address R
IPv6 gateway R
Ethernet Rx timeout —
Modbus TCP timeout —
Modbus gateway

MAC address

Ethernet primary DNS
Ethernet secondary DNS

IPv6 enabled W W W

= =2 =2 ==

= =1 =2 £ = =23

P VI
= =

Configuring IPv4 / IPv6 communications settings using ION Setup

You can configure your device’s IPv4 and IPv6 address settings, such as stored addresses or
address assignment mode, using ION Setup.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access additional data.

NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

Contact your network system administrator for your IP addresses and other Ethernet network
configuration values.

To configure IPv4 / IPv6 communications settings using ION Setup:

1.

2
3.
4

Start ION Setup.

. Open the Setup Assistant for your device.

Click Communications > Basic Ethernet > IPv4 (or IPv6).

. Select the IP address then click Edit.

7EN02-0390-08

Public 79




Communications

PowerLogic™ ION9000 series - User manual

5. Select your IP address assignment mode.

IPv4

Selection Mode Description

The meter acquires its IP addresses from
. your network’s DHCP server. The Device
Use DHCP to obtain an . i
DHCP Name and Domain Name fields are used to

IPv4 address ) o ;
define the meter’s fully-qualified domain
name (FQDN).

The meter uses the IP addresses that you
Stored manually enter for IPv4 (address, subnet
mask and gateway).

Use the following IPv4
address

For IPv6, select the IPv6 Enabled check box to enable IPv6 communications or clear it to
disable IPv6 communications.

NOTE: The IPv6 Link Local address is factory set and is read-only.

IPv6
Selection Mode Description
The meter acquires its IP addresses from
. your network’s DHCPVG6 server. The Device
Use DHCP to obtain an ) i
DHCPv6 Name and Domain Name fields are used to
IPv6 address ) , o .
define the meter’s fully-qualified domain
name (FQDN).

The meter uses the IP addresses that you
Stored manually enter for IPv6 (global address and
default gateway).

Use the following IPv6
address

You can have different assignment modes for IPv4 and for IPv6.

. Configure the settings for the selected mode then click OK.

The changes are saved to the meter. If ION Setup detects that the connection information is
already in use, you are prompted to confirm the change.

. Click Yes to confirm the change or No to cancel.

An example of an instance where you might want to confirm the change is if you are
programming the meter to replace another meter already in service.
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DHCP settings available using ION Setup

Parameter Value Description

The Ethernet device name is used by DPWS
for self-discovery over Ethernet and as the

Contact your local network hostname to uniquely identify your meter for
Device name administrator for parameter DHCP and DNS

values.
By default, this is set to the meter model plus

the last six-digits of the MAC address.

Contact your local network

. . The Ethernet domain name for the network
Domain name administrator for parameter

that the meter resides on.
values.

Stored IPv4 settings available using ION Setup

Parameter Value Description

Contact your local network
IP address administrator for parameter The IP address of your device.
values.

Contact your local network
Subnet Mask administrator for parameter The subnet IP address of your network.
values.

Contact your local network
Gateway administrator for parameter The gateway IP address of your network.
values.

Stored IPv6 address settings available using ION Setup

Parameter Value Description

Contact your local network
Global Address  administrator for parameter The Internet protocol address of your device.
values.

The address the meter uses to route
communications to a different network or

Contact your local network subnet.

Default Gateway administrator for parameter

vElluEs. If you do not set this or the address is

incorrect, you may see slow communications
or communications errors.

ION Setup reconnection

If you change the settings for the Ethernet connection method you are currently using to connect
to the meter, ION Setup tries to reconnect to the meter using the updated information. You can
view the process in the Device reconnection dialog box that appears.
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* IfION Setup can successfully communicate using the new setting, this setting appears in the
IP Address drop-down list box and the check box is selected. Click OK to copy this
information into the IP address field in Device Properties. ION Setup will now use this
address to communicate with the device.

* If ION Setup cannot successfully communicate using the new setting, the new address
appears in the IP Address but the check box is not selected. Either select the check box and
click OK (for example, you may want to use the new setting if you are replacing a meter in
service) OR select another address option from the drop-down list box. Click Test to check
that ION Setup can communicate with the meter using the new address, select the check box,
then click OK.

Configuring basic Ethernet settings using ION Setup
To configure your device’s basic Ethernet settings using ION Setup:
1. Start ION Setup.
2. Open the Setup Assistant for your device.
3. Click Communications > Basic Ethernet > TCP/IP.
4

. Select a setting and then click Edit.

NOTE: Contact your network system administrator for the appropriate values.

General Ethernet settings available using ION Setup

Parameter Value Description

This name is associated with your meter
when using DPWS.

Ethernet device name configurable
By default, it is the meter type and the last 6
characters of its MAC address.
: : Specifies the number of seconds the meter
Rx timeout configurable

waits for communication acknowledgments.

Specify number of seconds the meter waits
Modbus TCP Timeout configurable before disconnecting an idle Modbus TCP

connection.
Disabled Specify the port on which Modbus Gateway
sends/receives Modbus TCP requests.
COM1 (CM1
Modbus Gateway1 Protocol) For Modbus Gateway to function properly,
the serial port protocol must be set to
COM4 (C4 Modbus Master. For example, change CM1
Protocol) Protocol from factory to Modbus Master.
The media access control (MAC) address is
MAC address Read-only

factory set and is for reference only.

' Modbus Gateway is supported only on one serial port at any given time
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Configuring basic Ethernet settings using the meter webpages
You can use the meter webpages to configure the IPv4, IPv6 and TCP/IP settings for the meter.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.

NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

Contact your network system administrator for your IP addresses and other Ethernet network
configuration values.

To configure basic Ethernet setting using the meter webpages:
1. Connect to your meter’'s webpages.

Until you configure other Ethernet connection settings, you can connect to the meter using
its default IPv4 address or its IPv6 link local address, or by using self-discovery over
Ethernet by double-clicking the meter’s network icon.

2. Navigate to Setup > Ethernet.
3. Enter the appropriate value for the settings.

4. Click Advanced Settings to configure additional Advanced Ethernet settings, such as
timeouts and enabling/disabling certain protocols over Ethernet, if needed.

5. Click Apply.

NOTE: If you are changing the address you used to access the webpages, you will need to
reconnect to the webpages after you click Apply.

Ethernet settings available using the webpages

Parameter Value Description

The media access control (MAC) address is

MAC address Read-only )
factory set and is for reference only.

The Ethernet device name is used by DPWS
for self-discovery over Ethernet and as the

_ _ hostname to uniquely identify your meter for
Ethernet device name configurable DHCP and DNS.

By default, this is set to the meter model plus
the last six-digits of the MAC address.
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Parameter Value

Contact your
local network
administrator for
parameter
values.

Domain name

Contact your
local network
administrator for
parameter
values.

Primary DNS

Contact your
local network
administrator for
parameter
values.

Secondary DNS

Description

The Ethernet domain name for the network
that the meter resides on.

The IP address of your network’s primary DNS
server, if your network uses DNS.

The IP address of your network’s secondary
DNS server, if your network uses DNS.

IPv4 settings available using the webpages

Parameter Value

Stored
DHCP

IPv4 Assignment mode

Contact your
local network
administrator for
parameter
values.

Stored IPv4 address

Contact your
local network
administrator for
parameter
values.

Stored IPv4 Subnet Mask

Contact your
local network
administrator for
parameter
values.

Stored IPv4 Gateway

Description

Stored: The meter uses the IP addresses that
you manually enter for IPv4 (address, subnet
mask and gateway).

DHCP: The meter acquires its IP addresses
from your network’s DHCP server.

The Internet protocol address of your device.

The Ethernet IP subnetwork address of your
network.

The Ethernet IP gateway address of your
network.

The webpage also displays the acquired IPv4 settings if the Assignment mode is set to DHCP.

84

Public

7EN02-0390-08




PowerLogic™ ION9000 series - User manual

Communications

NOTE: To disable communications using IPv4, set the Assignment mode to Stored and the IPv4

Address t0 0.0.0.0.

IPv6 settings available using the webpages

Parameter

IPv6 Assignment Mode

IPv6 Link Local Address

Stored IPv6 Global
Address

Stored IPv6 Gateway

Value

Stored
DHCPv6

Read-only

Contact your
local network
administrator for
parameter
values.

Contact your
local network
administrator for
parameter
values.

Description

Stored: The meter uses the IP addresses that
you manually enter for IPv6 (Global address,
gateway address).

DHCPv6: The meter acquires its IP addresses
from your network’s DHCP server.

ThelPv6 Link Local address is factory set and
is read-only.

The Internet protocol address of your device.

The address the meter uses to route
communications to a different network or
subnet. If you do not set this parameter or the
address is incorrect, it may result in slow
communications or communications errors.

The webpage also displays the acquired IPv6 settings if the Assignment mode is set to DHCP.

NOTE: To disable communications over IPv6, set Enable IPv6 in Advanced Settings to No.

NOTE: You must enclose an IPv6 address in square brackets when typing it in a web browser, for
example: “http://[fe80::260:78ff:fe04:5943]".

Configuring Ethernet communications settings using the display

You can configure basic Ethernet communications settings using the display.

You can use the display to select the IP address assignment mode for IPv4 and IPv6, configure
stored IPv4 addresses, and view other settings. To configure the Ethernet settings that are not
available on the display or are read-only, use the meter’s webpages or ION Setup.

Prerequisites:

* Obtain your meter’s IP address and other network information from your network
administrator or IT department.
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To configure Ethernet communications settings using the display:

1.
2.

Press Setup Menu > Communications Setup.

Scroll through the screens until you reach the setting you want to configure then press the
Edit button.

Select the IPv4 or IPv6 Assignment Mode, if required.

Option Description

The meter uses the IP addresses that you manually enter for
Stored IPv4 (address, subnet mask and gateway) and IPv6 (Global
address, gateway address).

The meter acquires its IP addresses from your network’s
DHCP server.

DHCP/DHCPv6

You can have different assignment modes for IPv4 and for IPv6.

If you set the IPv4 Assignment Mode to Stored, continue with the remaining steps to
configure stored IPv4 addresses. If you are using addresses acquired from a DHCP server,
press the down arrow to view the assigned addresses.

Go to the Stored IPv4 Address Setup screen and press Edit.

Configure your meter’s stored IPv4 Addresses, as required.

Stored IPv4 address settings available using the display

Parameter Values Description
Contact your local Sets the IP address for the meter
IP Address network administrator for - your meter's default IP address is
parameter values. 169.254.0.10
Contact your local Used if subnetting applies to your network
Subnet Mask network administrator for  your meter’s default subnet address is
parameter values. 255.255.0.0
Contact your local Used in networks with multiple segments
Gateway network administrator for - yoyr meter's default gateway address is
parameter values. 0.0.0.0

Your meter’s media access control (MAC)
MAC Address Read-only

address
DHCP
The meter can function as a DHCP (Dynamic Host Configuration Protocol) client, allowing a
DHCP server to assign IP addresses to the meter.
86 Public 7EN02-0390-08



PowerLogic™ ION9000 series - User manual Communications

The meter supports assignment of the following addresses by a DHCP server when the
Assignment Mode is set to DHCP:

* IPv4 IP Address

* IPv4 Subnet mask
* IPv4 Gateway

* IPv6 Global Address

* IPv6 Gateway

Considerations for using DHCP

* Itis recommended that you also set up a DNS server and configure software and other
devices to use the meter’'s name to communicate with it. Alternatively, you can configure the
DHCP server to always provide the same address to the meter.

* When you switch the assignment mode from DHCP to Stored, the meter reverts to using its
default IP addresses as the Stored addresses.

* When you switch the assignment mode from Stored to DHCP, the acquired addresses display
as None until the meter receives addresses from the DHCP server.

* When using IPv6, the meter’s fully-qualified domain name (FQDN) is not sent to the DHCP
server. It is important that you make sure what is configured on the meter matches what is
configured on your network.

* |f the meter is not able to communicate to the DHCP server:

— When using IPv4, the meter will try to connect to the DHCP server for approximately one
minute. If the meter cannot connect to the DHCP server, it will revert to the default IP
address, but the Assignment Mode will remain DHCP.

— When using IPv6, the meter will continue to try to connect to the DHCP server, even if it
does not receive an address.

NOTE: If the DHCP server has not assigned an IP address and you need to reconnect to
the meter, use the meter's IPv6 link local address.

— For IPv4, if the meter’s fully-qualified domain name (FQDN) is not found on the DHCP
server, an event is logged in the event log. For IPv6, if the meter’s fully-qualified domain
name (FQDN) is not found on the DHCP server, no event is logged; this is important to
keep in mind when troubleshooting communications issues in a system using DHCP.

Meter domain name

A DNS (domain name system) server maps domain names to IP addresses. If you configure the
meter to use a DNS server, the meter can communicate with other network resources using their
domain names, rather than their IP addresses, and vice versa. For example, if your network has
an SMTP server with the domain name of smtp.company.com, you can enter smtp.company.com
as the SMTP Server address in the meter's communications settings.
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The meter’s Fully-Qualified Domain Name (FQDN)

To allow other network resources to communicate to the meter using its domain name, you must
configure the meter’s Ethernet Device Name setting to match that used by the DNS server. The
meter’s fully-qualified domain name is its Ethernet name plus its Domain name. For example, if
the meter’s Ethernet name is ElectricityHQ and its Domain name is companyXYZ.com, the FQDN
will be ElectricityHQ.companyXYZ.com.

NOTE: This domain name is used for both IPv4 and IPv6 communications. It is used to identify the
meter in a system using DNS and to identify the meter when using DPWS for self-discovery over
Ethernet.

Network protocol control

The network protocol control feature allows you to enable, disable or change the port number of
the network protocols supported on your meter.

Disabling unused ports is considered a cybersecurity best practice to help minimize unauthorized
access to your meter.

NOTE: The protocol port number may not be configurable on all protocols.

Managing network protocol control using ION Setup

Use ION Setup to enable, disable or change the port number of the network protocols supported
on your meter.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.

NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To manage network protocol control using ION Setup:
1. Open the Setup Assistant for your meter.
2. Click Communications > Advanced Ethernet > Protocols.
3. Select a protocol from the list and click Edit.
4. Selectthe Enabled check box to enable the port. Clear the check box to disable the port.

NOTE: The IEC61850 port is enabled when a valid CID file is uploaded to the meter. The
port is disabled by removing the CID file.

88

Public 7EN02-0390-08



PowerLogic™ ION9000 series - User manual Communications

NOTE: For EtherGate functionality, the EtherGate protocol must be enabled and the
applicable serial port set to EtherGate. For Secure EtherGate functionality, select Secure
EtherGate instead of EtherGate.

5. Select a port number from the Port Number drop-down list box or by clicking in the Port
Number field and entering a port number.
6. Click OK.
If multiple ports are set to the same number, ION Setup responds with a message indicating
that the port is already in use by another protocol.
Managing network protocol control using the meter webpages

Use the meter webpages to enable, disable or change the port number of the network protocols
supported on your meter.

The Setup tab contains configurable elements for enabling, disabling, and changing the port
numbers for your network protocols.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.

NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To manage network protocol control using the meter webpages:
1. Open a web browser and enter your meter’s IP address in the address bar.
The webpage login is displayed.
Enter your login credentials.
Navigate to Setup > Ethernet.
Click Advanced Settings at the bottom of the screen.
Select YES or NO to enable or disable each configurable protocol.

Enter the port number for each configurable protocol.

N oo o M e D

Click Apply to send these settings to your meter.

Managing network protocols using the display

The Ethernet Port Enable Setup allows you to enable or disable your network protocols through
the display.
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When configuring communications parameters, ensure you maintain at least one communication

path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.

NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

NOTE: You cannot change the Ethernet port number assignments through the display.

To manage network protocol control using the display:

1.

2
3.
4

o

Press the Home button on the display.
Navigate to Setup Menu > Ethernet Port Enable Setup.
Press Edit. Enter your meter’s password, if prompted.

Press the up or down icons to navigate available Ethernet protocols. A gray bar appears
behind the active selection.

Press Enable/Disable.
Press Select to accept the change.

Press Select to confirm.

Serial communications

The meter supports serial communications through its onboard RS-485 ports. Your meter
supports the 4-wire RS-485 option module through use of the existing Com1 port.

RS-485

In an RS-485 network, there is one client device, typically an Ethernet to RS-485 gateway. It

provides the means for RS-485 communications with multiple server devices, such as meters. For
applications that require only one dedicated computer to communicate with the server devices, a

USB to RS-485 converter can be used to connect to the server device.

Up to 32 devices can be connected on a single RS-485 bus.

RS-485 wiring

Connect the devices on the RS-485 bus in a point-to-point configuration, with the (+) and (-)
terminals from one device connected to the corresponding (+) and (-) terminals on the next
device.
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NOTE: If using the 4-wire RS-485 option module follow the wiring instructions in your installation
guide. Your wiring may depend on serial or gateway configuration.

RS-485 cable

Use a shielded 2 twisted pair or 1.5 twisted pair RS-485 cable to wire the devices. Use one twisted
pair to connect the (+) and (-) terminals and use the other insulated wire to connect the C
terminals.

The total distance for devices connected on an RS-485 bus should not exceed 1200 m (4000 ft).

RS-485 terminals

Common. This provides the voltage reference (zero volts) for the data plus and data minus
signals

Shield. Connect the bare wire to this terminal to help suppress signal noise that may be
S present. Ground the shield wiring at one end only (either at the client or the last server
device, but not both).

- Data minus. This transmits/receives the inverting data signals.

+ Data plus. This transmits/receives the non-inverting data signals.

NOTE: If some devices in your RS-485 network do not have the C terminal, use the bare wire in
the RS-485 cable to connect the C terminal from the meter to the shield terminal on the devices
that do not have the C terminal.

RS-485 configuration

Before connecting your device to the RS-485 bus, use ION Setup, meter webpages or the display
to configure your meter’s default RS-485 settings.

Your meter has two RS-485 connections.

Each RS-485 connection must have a unique unit identifier (Unit ID) and have the following
settings match the rest of the devices on the RS-485 bus:

* Protocol
* Baudrate
* Parity and stop bits
You can configure the following settings to help optimize communications performance:
* RTS delay
* RS-485 bias

You can use a communications converter (USB to RS-485 or RS-232 to RS-485) or an Ethernet
gateway device to connect to your meter.

RS-485 bias

You can use the RS-485 bias setting to fine-tune communications.
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Set the RS-485 bias to ON when the meter is acting as a client over RS-485 communications and
set the RS-485 bias to OFF when the meter is acting as a server. You can configure RS-485
biasing through ION Setup, the meter webpages or the display.

Serial protocols and ports

Your meter supports serial communications protocols on the RS-485 ports.

* ION ;
* Secure EtherGate

* Modbus RTU )
* GPS: Truetime/Datum

* Modbus Master )
* GPS: Arbiter

* DNP 3.0 )
* GPS: Arbiter-Vorne

* DLMS

. * None®
* EtherGate

1 —These are serial port protocol settings that allow protocols to work with other connected RS-
485 devices.

2 — These protocol settings are used for connecting to a GPS receiver communicating in serial
ASCII format.

3 — This protocol setting stops communications using this port.

Configuring serial communications settings using ION Setup

Use ION Setup to configure the meter’s serial communications settings.

Prerequisites:

Make sure you have a unique unit ID for your meter and know the serial network settings
(protocol, baud rate, parity and stop bits).

To configure the meter’s serial communications settings using ION Setup:
1. Start ION Setup.
. Open the Setup Assistant for your device.

2

3. Click Communications > Serial Settings.

4. Select Com1 or Com4 tab, depending on which hardware serial port you are configuring.
5

. Select a setting, and then click Edit to configure the setting to match your communications
system.
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Serial communications settings available using ION Setup

Parameter Values

ION, Modbus RTU, Modbus
Master, DNP v3.00, DLMS,
EtherGate, GPS:

Protocol
rofocol Truetime/Datum, GPS:
Arbiter, GPS: Arbiter-Vorne,
Factory, None
2400, 4800, 9600, 19200,
Baud Rate

38400, 57600, 115200

Rx Timeout' 0.1-15

Unit ID 1-9999

8N1, 8N2, 8E1, 8E2, 801,

Serial Port
' 802

RS485 Bias OFF, ON

Description

Sets the communications protocol for your
meter's RS-485 port

The NONE setting stops communications
using this port.

Sets the data rate, in bits per second

Sets the transmit delay (timeout for receiving
an entire message from a device) in seconds.

Sets the meter’s unique ID on the RS-485
network
Note: Modbus serial device range 1 to 247

Sets the parity and stop bits for the port

Turns on biasing on the client device over the
RS-485 port

! Only applies to a subset of protocols.

Configuring serial communications settings using the webpages

You can use the meter's webpages to configure your serial communications settings.

Before configuring serial parameters, make sure you have a unique unit ID for your meter and
know the serial network settings (protocol, baud rate, parity and stop bits).

To configure the meter’s serial communications settings using the meter webpages:

1. Connect to your meter's webpages using the meter’s IPv4 address or its IPv6 link local
address, or use self-discovery then double-clicking the meter’s network icon.

2. Navigate to Setup > Serial Port.

3. Enter the appropriate value for the settings.

4. Click Advanced Settings to configure additional settings, if needed (for example, RS485

biasing or Rx Timeout).
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Basic serial communications settings available using the webpages

Parameter Values Description

ION, Modbus RTU,
Modbus Master, DNP
v3.00, DLMS, EtherGate,

Protocol GPS: Truetime/Datum,
GPS: Arbiter, GPS:
Arbiter-Vorne, Factory,
None

Sets the communications protocol for your
meter's RS-485 port

The NONE setting stops communications
using this port.

2400, 4800, 9600, 19200, .
Baud Rate Sets the data rate, in bits per second
38400, 57600, 115200
Sets the meter’s unique ID on the RS-485
UnitID 1-9999 network

NOTE: Modbus serial device range 1 to 247

Advanced serial communications settings available using the webpages

Parameter Values Description
The delay in seconds before the
RTS Delay 0-1 .
transmission of the packet.
Sets the transmit delay (timeout for
Rx Timeout' 0.1-15 receiving an entire message from a device)
in seconds.
Serial Port 8N1, 8N2, 8E1, 8E2, Sets th ity and stop bits for th rt
erial Po ets the parity and stop bits for the po
801, 802 party P P
Turns on biasing on the client device over
RS485Bias  OFF, ON ; N et device o
the RS-485 port

! Only applies to a subset of protocols.

Configuring serial communications using the display
You can configure your meter’s basic serial communications settings using the display.

Before configuring serial parameters, make sure you have a unique unit ID for your meter and
know the serial network settings (protocol, baud rate, parity and stop bits).

To configure the meter’s serial communications settings using the display:
1. Press the Home button.

2. Press Setup Menu > Communications Setup.
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3. Press the up and down icons to scroll and select COM1 Setup or COM4 Setup.

4. Configure your meter’s serial settings as required.

Serial communications settings

Parameter Values Description

ION, Modbus RTU,
Modbus Master, DNP
v3.00, DLMS, EtherGate,

Protocol GPS: Truetime/Datum,
GPS: Arbiter, GPS:
Arbiter-Vorne, Factory,
None

Sets the communications protocol for your
meter's RS-485 port

The None setting stops communications
using this port.

2400, 4800, 9600, 19200, o
Baud Rate Sets the data rate, in bits per second
38400, 57600, 115200

Rx Timeout 0.1-15 Sets the transmit delay in seconds

Sets the meter’s unique ID on the RS-485
Unit ID 1-9999 network
NOTE: Modbus serial device range 1 to 247
. 8N1, 8N2, 8E1, 8E2, . .
Serial Port Sets the parity and stop bits for the port
801,802
Turns on biasing on the client device over

RS485 Bias OFF, ON
the RS-485 port

Disabling serial communications ports

You can disable serial communications ports using ION Setup, meter webpages, or the display.

Disabling serial communications using ION Setup

NOTE: Disabling unused ports is considered a cybersecurity best practice to help minimize
unauthorized access to your meter.

To disable serial communications using ION Setup:
1. Open the Setup Assistant for your meter.

. Click Communications > Serial Settings.

2

3. Clickthe Com1 or Com4 tab.
4. Select Protocol and click Edit.
5

. Select None from the drop-down list box and click OK.
Disabling serial communications using the webpages

NOTE: Disabling unused ports is considered a cybersecurity best practice to help minimize
unauthorized access to your meter.
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ION

Secure ION

To disable serial communications using ION Setup:

1. Open a web browser and enter your meter’s IP address in the address bar. The webpage
login prompt is displayed.

2. Enter your login credentials.
3. Navigate to Setup > Serial Port and expand the Basic Settings section.

4. Choose COM1/ RS485#1 - Protocol or COM4/ RS485#2 - Protocol from the drop-down
list box and select None to disable the port.

5. Click Apply. When prompted, click Yes to save the changes.
Disabling serial communications using the display

NOTE: Disabling unused ports is considered a cybersecurity best practice to help minimize
unauthorized access to your meter.
To disable serial communications using ION Setup:
1. Press the Home button.
Press Setup Menu > Communications Setup.
Press Select.
Scroll then select COM1 Setup or COM4 Setup.
Press the navigation icon to scroll and select Protocol.
Press the Edit button. Enter user credentials if prompted.

Press the down icon and then select None to disable the port.

© N o o0 M 0 N

Press the Select button when you are finished. If prompted, press Select button again to
accept the changes.

ION is the architecture of your meter.

The basic building blocks of ION architecture are the ION modules, each of which is specialized to
perform a specific task and contains data and instructions on how to manage that data. ION
modules are linked together to create the meter’s functions and features. ION modules that are
linked together to perform a specialized task are called a framework, such as the Power Quality
framework. These different functional frameworks are then grouped together to define the entire
meter and are collectively referred to as the device template.

Your meter ships with a default device template which provides extensive capabilities. You can
also configure the meter’s template to modify existing meter functions or to create new functions.

Related resources:

For more information on ION architecture and a detailed description of the different ION modules,
see ION Reference, available from www.se.com.

Secure ION, or ION over TLS, enhances the security of the ION protocol by using a Transport
Layer Security (TLS) encrypted tunnel between the device and the software client.
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NOTE: The additional TLS layer applies to a TCP/IP based connection (Ethernet) only. It does not
apply to serial communications.

To use Secure ION your IT infrastructure must be configured to allow the traffic on the Secure ION
port to pass. The default port for Secure ION is 7443.

Connecting to a device using Secure ION
Use ION software to connect to a device using Secure ION.

If you are using ION Setup in Network mode or Power Monitoring Expert, configure the device to
use the Secure ION programmed IP port.

Prerequisites:
Your IT infrastructure must be configured to allow the traffic on the Secure ION port to pass.

To connect to a device using Secure ION:

1. In Device Properties, set the IP Port to the Secure ION port:

Device Properties X |

General Display  Toolz  Details  Time Zone

Harne: |SectrelON 5K
Tvpe: 10M 3000 Semes Power Meter bd
IP Address: 10,168 63 245
IP Pt
(G roup:
Cancel Help
2. Click OK.

NOTE: If you connect to a device in ION Setup using Single ION Device mode, ION Setup will try
to connect to the Secure ION port automatically. If the defined port isn’'t available on your network,
the device will connect using ION over TCP. You can use ION software to configure devices to
override the default connection process, see "Setting the ION protocol connection and port
number" on page 99 for details.

Secure ION security certificates

Devices that support Secure ION include a self-signed SSL certificate. When you connect to a
device using Secure ION, a certificate must be associated with the TLS connection.

You can upload a Certificate Authority (CA) signed certificate. For details, see "Uploading a
custom SSL certificate" on page 118.
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NOTE: To reduce cybersecurity risk, use a Certificate Authority (CA) signed SSL certificate and
external network controls. To learn more about this risk, see "Security risks and mitigation
strategies" on page 34.

In ION Setup, you can view the certificate information—including its SHA1 thumbprint—by
clicking View Certificate Info.

Potential Security Risk x

Certificate Emor Sunmany

Datected an invalid secunty certificate in use.
The cestificate iz not tusted because it iz self-signed

Emee code: HemoteCesldicateM ameddizmaleh, RemateCestiicateChamk mors

View Cerihcate Info

The secunty certficate iz not busted by your computer's opsrating spstem, This may be
causzed by a misconiiguation or an altackel intercepting vour connecton. Only press
Fiocead if pou aie sure the connection i secuie.

Procesd Help

For example:

E Potential Security Risk x

Device Certificate info

Subyect Mame |ONA000-E4ab72 ~
Subgect Organization  Schneider Elechic

Subject Courilry Ly

|zsues Drganization Schneider Elechic

|zzuer Coumntry Cé

Eleciive TABFZ022 11:41:57 AM

Expires TAAF2024 114157 AM

(SHAY Thumboirt  S0B8E0N 120 CCAS2A4CCETDEROCE04EC2TFREIDET ¥ |

| ViewEror Summary |

The zecunty certficate iz not uzted by your computer's operating system, Thiz may be
caused by a misconhiguation or an altackel intercepting vour connection. Only press
Proceed if pou are sure the connection is secune. [::?

Procesd Cancel Help

ION Setup stores the certificate when using Network mode. In Single Device mode, you must
accept the certificate every time you connect to a device using Secure ION.
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Setting the ION protocol connection and port number

When connecting to a device in ION Setup using Single ION Device mode, ION Setup will try to
connect to the Secure ION port automatically. If your IT infrastructure isn't configured to allow
traffic on the Secure ION port to pass, the device will connect using ION over TCP.

You can override the default ION connection on a device that supports Secure ION by manually
appending the IP address connection options to the IPv4 address. Doing so explicitly defines the
connection process.

The following table describes the override values you can use and the resulting connection
process:

Example override value  Connection process

Explicitly connects to port 7443. If the registry dictates that ION

10.168.68.245/7443 L .
over TLS = 7443, this will be a TLS connection.

Explicitly uses the registry to connect to what is specified as the
ION over TLS port. By default: 7443.

10.168.68.245/TLS

Explicitly uses a TLS connection to the specified port. In this

10.168.68.245/TLS:7443
example, 7443.

For example:

Connection Type — o4
) Sesial

Connect wsing: Senal Poet 003 [COM3] Satings

") Modem
Phore Mumber. S etfing

(@) Etheimet
IP Address: [10168.68.245/TL5:7441 v| [ Satinge

L3

Fitriwdae: Elicuwna

Esit Help

() OffLine

ION sessions

An ION session uses a session token ID to authenticate ION requests to a device. The first

ION request sends the user credentials to the device. Upon successful validation, the device
creates a unique, non-transferable ION session token ID. Subsequent ION requests are validated
using the ION session token ID, not the user credentials.

An ION session token ID has a fixed inactivity session timeout of 5 minutes.

There is no configuration required to enable ION sessions.
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Modbus

Key terms

NOTE: Both the ION over TCP and ION over TLS (Secure ION) include ION session
authentication.

Modbus is a client-server communications protocol where the client initiates transactions and the
server or servers respond with the requested information or action.

Your device can function as a Modbus client or Modbus server, depending on how it is configured.
Your device comes with Modbus server functionality configured and ready to use. You can add
custom Modbus information to the default Modbus server data provided by your device.

Term Definition

A communications method that lets you communicate through an
Modbus gateway Ethernet gateway device to a Modbus serial network connected to
that device.

A device that issues commands and receives responses from
Modbus server devices. Serial Modbus networks can only have
one Modbus client per network.

Modbus client (historically
known as Modbus master)

Serial Modbus protocol format; Modbus RTU transmits data using
binary. Server and client devices must use the same format.

Modbus RTU

Identifies the data to read/write. Modbus register maps are
available for Modbus client devices and detail the information
available from the client device. More than one register may be
used to store a single value.

Modbus register/address

A device that responds to Modbus commands and performs
actions or provides information back to the Modbus client. Most
Modbus networks contain multiple server devices.

Modbus server (historically
known as Modbus slave)

Modbus TCP The Ethernet Modbus protocol format.

Modbus unit ID The identifier for a client Modbus device.

You can download your device’s Modbus map from www.se.com and get additional information
about the Modbus protocol from www.modbus.org.

Ethernet Modbus device prerequisites

For your meter to operate as an Ethernet Modbus device, you must complete some prerequisite
configuration.

NOTE: You do not need to perform any Modbus-specific configuration for your meter to function
as a Modbus client device over Ethernet.
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Ethernet All devices must have a working Ethernet connection.

IP address All devices must have a unique IP address.

Port All devices must be communicating over Ethernet port 502 for
Modbus TCP.

NOTE: Devices supporting multiple simultaneous Modbus TCP connections can have
communications delays. Adjust your network timeout settings to accommodate this.

Serial Modbus device prerequisites

For your meter to operate as a serial Modbus device, you must complete some prerequisite
configuration.

Prerequisite Description

The device’s serial connection must be wired correctly.

Wiring The Modbus server devices must have communications wiring to
the Modbus client.

Servers — For your meter to be a serial Modbus server, the meter’s
protocol must be set to Modbus RTU. Client and server devices
Protocol must use the same format.

Client — For your meter to be a serial Modbus client, the meter’s
protocol must be set to Modbus Master.

The baud rate must be the same for all devices on the serial
Modbus network.

Baud rate

The communication stop bits and parity (for example, 8N1) must

Stop bits and parit
P party be the same for all devices on the serial Modbus network.

Each device on the serial Modbus network must have a unique
UnitID unit ID (also called the device address).
Note: Modbus serial device range 1 to 247

Your meter as a Modbus client

Your meter as a Modbus client with Ethernet Modbus server devices

Your meter can function as a Modbus client with Ethernet Modbus server devices.
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T E R T E N B B

A  Ethernet

B  Your meter

C Modbus servers

To use the Modbus client-server architecture, add the Modbus server devices using ION Setup.

Your meter as a Modbus client with serial Modbus server devices

Your meter can function as a Modbus client with serial Modbus server devices.

Ethernet

Your meter

RS-485 Modbus RTU

o 0| >

Modbus servers

To use the Modbus client-server architecture, add the Modbus server devices using ION Setup.
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Modbus client best practices

For your meter to operate as a Modbus client, you must complete some prerequisite
configuration.

NOTE: These settings are required in addition to the serial or Ethernet Modbus prerequisites.

Prerequisite Description

All Modbus client devices must be communicating and

Modbus client devices i i
appropriately configured.

* Modbus client-server serial devices — The client’s serial port
protocol must be set to Modbus Master.

* Modbus client-server Ethernet devices — The client must be

Protocol communicating to the server devices over Ethernet port 502.

NOTE: Having more than one Modbus client on a serial Modbus
network may cause communication conflicts.

The Modbus client device must have the server device information
entered.

Modbus server devices

Configuring your meter as a Modbus client using ION Setup
You can configure your meter to Modbus client-server devices over serial or Ethernet.

Make sure your client and server devices have the prerequisite communications wiring and
configuration before configuring your meter as a Modbus client.

If the meter is a Modbus client over TCP/IP, the Modbus TCP/IP and Modbus RTU protocols must

be enabled.

NOTE: Devices supporting multiple simultaneous Modbus TCP connections can have
communications delays. Adjust your network timeout settings to accommodate this.

The meter as a Modbus client over TCP/IP attempts to communicate with a server device for up to
100 seconds (as per the RFC 1122 standard) before moving on to the next server device.
To configure your meter as a Modbus client over serial or Ethernet:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Communications > 3rd Party Protocols > Modbus Master.

4. Click Add to add a Modbus server device.

The Modbus Device dialog appears.

5. Enter the Modbus server information:

— Enter the Modbus server device’s name and a label suffix (if applicable).

— Select the device type of the server device from the Device Type drop-down list box.
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— Enter the unit ID of the Modbus server device into the Slave ID text box.

— Select the serial or TCP connection from the Connected via drop-down list box. This is
the connection from the Modbus client to the server device.

6. Click Connections. The Modbus Master Connections dialog appears.
7. Select the tab that corresponds to the connection you are configuring.

For example, if you selected TCP Connection 1 from the Connected via drop-down list box,
select the TCP 1 tab.

8. Configure the connection type:

Connection type Configuration

Select the serial communications port that is connected to the
Modbus server devices from the Assigned Port list.

Serial connection

Enter the IP address of the Modbus server device, making

sure that the IP port is set to 502.
TCP connection

Make sure that the Modbus RTU and Modbus TCP/IP
protocols are enabled.

9. Click OK to return to the Modbus Device dialog.
10. Click OK to add the server device. The device now appears on the list.

11. Repeat steps 4 through 10 to add all your Modbus server devices.

Your meter as a Modbus server

Your meter as a Modbus server over Ethernet

Your meter can function as a Modbus server over Ethernet.

----------
-----------

A Modbus client

B Ethernet Modbus TCP

C  Your meter

Your meter does not require any Modbus-specific configuration to act as a Modbus server device
over Ethernet.
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Your meter as a Modbus server on a serial network

Your meter can function as a Modbus server on a serial network.

Modbus client

RS-485 Modbus RTU

Your meter

o/ 0| >

Modbus servers

Your meter’s serial connection must be wired and configured correctly. The same mode of serial
communication must be used for all devices on the network.

Configuring your meter as a Modbus server using ION Setup
To configure your meter as a Modbus server using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Communications > Serial settings. Select the tab for the serial port you want to
configure.

4. Highlight the parameter, and then click Edit to configure the serial port's Modbus
parameters as required:

Parameter Setting

Protocol Modbus RTU or Modbus Master

— OFF if the meter is a Modbus server
RS485 Bias
— ON if the meter is a Modbus client

5. Configure the meter’s other serial port parameters as required.
Next, add the Modbus server devices using ION Setup.

See your device’s Modbus map, available from www.se.com for Modbus register information.

Configuring your meter as a Modbus server using the webpages

To configure your meter as a Modbus server using the meter webpages:
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1. Connect to your meter’'s webpages.
2. Navigate to Setup > Serial Port.

3. Expand Basic Settings or Advanced Settings, and then configure the serial port's Modbus
parameters as required:

Parameter Setting

Protocol Modbus RTU or Modbus Master

— OFF if the meter is a Modbus server
RS485 Bias

— ON if the meter is a Modbus client

4. Configure the meter’s other serial port parameters as required.
Next, add the Modbus server devices using ION Setup.

See your device’s Modbus map, available from www.se.com for Modbus register information.

Configuring your meter as a Modbus server using the display
To configure your meter as a Modbus server using the meter display:

1. Press the Home button.

2. Navigate to Setup Menu > Communications Setup, scroll and select COM1 or COM4
Setup.

3. Configure the Modbus parameters as required:

Parameter Setting
Protocol Modbus RTU or Modbus Master
RS485 Bias OFF if the meter is a Modbus server

4. Configure the meter’s other serial port parameters as required.
Next, add the Modbus server devices using ION Setup.

See your device’s Modbus map, available from www.se.com for Modbus register information.

Supported Modbus features
Your meter supports specific Modbus data classes, data formats, function codes, and commands.

Modbus data classes

Class Description

Coils Digital bits that can be read and written to
Input status Digital bits that can be read

Input registers 16-bit integers that can be read

Holding registers 16-bit integers that can be read and written to
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Modbus data formats

Format

Unsigned 16-bit

Signed 16-bit

Unsigned 32-bit

Signed 32-bit

Unsigned 32B-M10K
Signed 32B-M10K

|EEE float'

Packed Boolean for inputs
Packed Boolean for coils

Unsigned 16-bit read/write

Signed 64 bit

Type # of Modbus registers used
Integer 1
Integer 1
Integer 2
Integer 2
Integer 2
Integer 2
Floating point 2
Integer 1
Integer 1
Integer 1
Integer 4

' A device acting as a Modbus client supports two versions of IEEE float with different word

orders: high/low = Big Endian, low/high = Little Endian.

16-bit data (one word) is transmitted with most-significant byte first and least-significant byte

second.

32-bit data (two words) is transmitted with the most-significant word first and the least-significant

word second.

Modbus function codes

Function

1
2
3
4
5
6

15
16
17
43 (sub code 14)
100

Description

Read coil status

Read input status

Read holding registers
Read input registers

Write to a coll

Write to a holding register
Write to multiple coils

Write to multiple holding registers
Report slave ID (serial only)
Read device identification

Read scattered holding registers

Client / Server

Client and server
Client and server
Client and server
Client

Client

Client and server
Client

Client and server
Client and server
Client and server

Client and server

7EN02-0390-08

Public

107




Communications PowerLogic™ ION9000 series - User manual

Modbus commands

A Modbus client command to unit ID 0 is broadcast (sent to) all Modbus server devices. The only
supported broadcast command is preset multiple registers.

For serial Modbus networks with only one server device, the client can send commands using the
single connection, one-to-one address of unit ID 248, regardless of the server device’s actual unit
ID.

Modbus implementation

Your meter's Modbus implementation includes exception codes, invalid register responses, fixed
and configurable register maps, and security.

Modbus exception codes

Code Name Description
01 lllegal function The requested command is invalid.
This code indicates one of the following:

* Therequested address is invalid for that
function.

02 lllegal address * The requested address is not within the
valid register range for this device.

* Therequested address is protected by
device security.

This code indicates one of the following:

* The requested value is not allowed for that
03 lllegal value register in the device.

* The requested register is part of a multi-
word value.

Modbus invalid read registers responses

Invalid type Read response

Unmapped (unused)* register 0x8000

Reserved* register responses by type

Signed integer 16-bit 0x8000

Unsigned integer 16-bit OxFFFF

Signed integer 32-bits 0x80000000

Unsigned integer 32-bits OxFFFFFFFF

Signed integer 64-bits 0x8000000000000000
0xFFC00000

Float32
(NaN = Not a number)
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*|RIG-B can only be connected to one of the digital inputs located on the meter base, not an
option module. Unmapped (unused) registers are registers that will never be used by the meter,
and therefore have no defined format. Reserved registers have a defined format and are intended
for use by the meter, its options, or its variants.

Modbus invalid write registers response

If the meter receives a write command to a Modbus register address that does not have a register
mapped, the meter will not respond. No data is written or stored, and the meter will not send back
a rejection to the request.

If the meter receives a write command to a read-only Modbus register address, exception code 03
(illegal value) is returned.

Fixed and configurable Modbus map

Your meter has a fixed (static) register map for meter data and a flexible, user-configured register
map.

Modbus security

Your meter’s onboard security options include Modbus-specific settings. These security settings
may need to be configured to write Modbus data to the meter.

Modbus map

Your meter’s default Modbus register information (map) is available on www.se.com.

The Modbus register information includes:
* Registers and mapped values
* Formats and scaling

* Additional details where applicable

NOTE: Your meter’s Modbus registers are specified differently than previous devices using ION
architecture. If you are configuring Modbus client information on your meter, confirm you are
using the appropriate Modbus register addressing. For more information, refer to your meter’s
Modbus map.

Your meter has a fixed (static) register map which contains the most common metering values.
This map is defined by a series of Data Mapping modules, which also determine the values shown
on the meter webpages or the display. The Data Mapping modules are named based on the type
of information they map to Modbus:

Data Mapping module Description

Maps kW, kVA and kVAR demand data such as kW sd
del (sliding demand kilowatts delivered), as well as
current demand such as | a sd (sliding demand phase A
current).

Data Mapping Dmd

7EN02-0390-08

Public 109



Communications

PowerLogic™ ION9000 series - User manual

Data Mapping module Description

Maps kWh, kVAh, and kVARh delivered, and received
Data Mapping Egy data, including conditional, quadrant, and incremental
energies.

Maps present interval EN 50160 power quality

Data Mapping EN
PPINg compliance data.

Maps previous interval EN 50160 power quality

Data Mapping EN Prev
e compliance data.

Data Mapping IEEE519 Maps IEEE 519 harmonics compliance data.

Maps input metering data, alarms, resets, and reset

Data Mapping I/O
counts.

Maps voltage, current, power, power factor, and
frequency data for one second and half-cycle

Data Mapping Meas measurements.

The Cfg Modbus Map Enable setup register may exist in
this module.

Maps power quality data such as Crest Factor, K Factor,
Data Mapping PQ and total harmonic distortion, including IEC 61000-4-30
power quality compliance data.

Maps statistical low, mean, and high data values, such

Data Mapping Stats
as | amean (phase A current average value).

Maps time-of-use (TOU) data, such as seasons, rates,
Data Mapping TOU and per-season demand, such as kW sd rec A (sliding
demand kilowatts received in season A).

You can add extra Modbus information or duplicate information that is already in the fixed map to
different Modbus registers using Modbus Slave modules.

For more information on Data Mapping modules and Modbus Slave modules, see ION Reference,
available on www.se.com.

Configuring custom Modbus data using ION Setup

You can add custom data to your meter's default Modbus map, completely customize your
meter's Modbus map, or revert your meter's Modbus map back to its default configuration using
ION Setup.

Download your meter’'s Modbus map information from www.se.com.
To configure custom data using ION Setup:
1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Click Communications > 3rd party protocols > Modbus Slave.

6.

The name of the meter’s current Modbus map is displayed, along with the quantity of custom
registers and their start and end addresses.

Select the map name and click Edit.
The Modbus Slave Mode Setup screen is displayed.

Select your meter’'s method of Modbus client mapping. If you select Default or Disabled,
click Finish to configure your meter and return to the Setup Assistant, otherwise select
Next to access the Modbus Slave Map Setup screen.

Option Description

Sets your meter to use the default Modbus map. Any custom
Modbus client data is removed.

NOTE: You can download your meter's Modbus map
information from www.se.com.

Default

Add Modbus information in addition to the meter’s default
Modbus map.

Modified

Removes the meter’'s default Modbus map so that all registers
are available, and you can create a completely custom
Modbus map.

NOTE: Use this option if you want to make your meter’s
Modbus map identical to a device that it is replacing, for
example in a retrofit application.

Custom

Removes your meter’'s Modbus data map. Modbus functions
are unaffected, but no meter Modbus data is available.

Disabled

In the Modbus Slave Map Setup screen, you can modify parameters by clicking Edit, or
add parameters by clicking Add.

The Modbus Register screen is displayed.

Configure the Modbus register information and click OK to return to the Modbus Slave Map
Setup screen.

a. Source: Click Select and chose a source from the Parameter Selection screen. Select
Show all available registers to see a complete list of the parameters available on your
meter. Click OK.

b. Address: Enter the Modbus address that will hold the Source data.

NOTE: If you hover your mouse over the Address field, a tooltip indicates the Modbus
function code and start address to send for retrieving the data.

c. Format: Select the Modbus data format from the list.

d. Scaling: Select the scaling value from the list or select Custom and click Scales to
configure custom scaling.
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8. Inthe Modbus Slave Map Setup screen you can click Delete to remove a Modbus register,
Set Name to create a new name for the set of additional data mapped to Modbus, or Save
As to save the additional data you have mapped to Modbus as a separate file.

9. Click Finish to complete your meter's Modbus client configuration and return to the Setup
Assistant.

Ethernet gateway

Ethernet gateway is a communications method that allows you to communicate through a
gateway device to a serial network.

When a meter with gateway capabilities is installed on an Ethernet network, a client device (such
as an energy management system) can communicate through the gateway meter to a serial
network of devices connected to the gateway meter’s serial port(s). The maximum number of
devices on the serial network is determined by the limitations of the gateway meter’s serial port.

™y

|"" RS-485

LAN/WAN

Ethernet gateway meter

Serial RS-485 network of devices

g O|m|>

Terminating resistor

There are two types of Ethernet gateways that you can configure on your meter:

* EtherGate — A single TCP connection communicates through the gateway meter to a serial
network of devices.

* Modbus gateway — Up to a maximum of 32 Modbus client TCP connections communicate
through the gateway meter to a serial network of Modbus devices.

112 Public 7EN02-0390-08



PowerLogic™ ION9000 series - User manual Communications

EtherGate configuration

The meter can function as an Ethernet gateway (EtherGate).

When a meter with gateway capabilities in installed on the Ethernet network, a client device can
communicate through the gateway meter to a serial network of devices wired to the gateway
meter's COM port. You must create an additional communications connection to the gateway
meter to read its information.

NOTE: EtherGate supports only one client device.

Before configuring EtherGate, confirm the following:
* The serial network of devices are wired to the gateway meter’s serial communication port.

* All serial devices are configured to have the same baud rate, serial port settings (for example:
8N1), and protocol (ION).

* Each serial device has a unique unit identifier (unit ID/address).
* Your gateway meter is communicating over Ethernet.

You can then configure the gateway meter’s serial port to use the EtherGate protocol, create the
EtherGate site in ION Setup or an energy management system, and add the serial devices to the
EtherGate site.

Secure EtherGate

Secure EtherGate enhances the security of the EtherGate protocol by using a TLS encrypted
tunnel between the device and the software client.

Secure EtherGate is an option available in the Protocol setup register of the serial communication
modules on the device.

The Secure EtherGate is available at port 7801/7802. If Secure ION is disabled, Secure

EtherGate will continue to accept and parse incoming data to the serial port.

NOTE: The additional TLS layer applies to the TCP/IP based connection (Ethernet side) only. It
does not apply to the serial side of the EtherGate connection.

Configuring EtherGate or Secure EtherGate using ION Setup
To configure EtherGate or Secure EtherGate communications using ION Setup:
1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Click Communications > Serial settings.
4. Selectthe tab (Com1 or Com4) for the serial port you want to configure.
5

Highlight the parameter, and then click Edit. Enter the meter password if prompted
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6. Change the settings, and then click OK to save the changes.

Parameter Setting

Protocol EtherGate or Secure EtherGate

Baud Rate Serial port settings must match the settings for all connected
Serial Port serial devices.

7. Create an Ethernet gateway site to access the serial network of devices through your
gateway meter.

Configuring EtherGate or Secure EtherGate using the webpages

To configure EtherGate or Secure EtherGate communications using the meter webpages:
1. Connect to your meter’'s webpages.
2. Navigate to Setup > Serial Port.

3. Expand Basic Settings or Advanced Settings and modify the settings for the serial port you
are configuring for EtherGate communications (COM1 / RS485#1 or COM4 /| RS485#2).

4. Change the settings, then click Apply. Click Yes to save the changes.

Parameter Setting

Protocol EtherGate or Secure EtherGate

Baud Rate Serial port settings must match the settings for all connected
Serial Port serial devices

You can use ION Setup to create an Ethernet gateway site and access the serial network of
devices connected through the EtherGate meter.

Configuring EtherGate or Secure EtherGate using the display
To configure EtherGate or Secure EtherGate communications using the meter display:
1. Press the Home button.
2. Navigate to Setup Menu > Communications Setup.
3. Press the Select button.
4. Scroll then select COM1 Setup or COM4 Setup.
5

Highlight the parameter and press Edit. Enter the meter password if prompted, change the
setting, then press Select to save the changes.

Parameter Setting

Protocol EtherGate or Secure EtherGate
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Parameter Setting
Baud Rate Serial port settings must match the settings for all connected
Serial Port serial devices

You can use ION Setup to create an Ethernet gateway site and access the serial network of
devices connected through the EtherGate meter.

Modbus Ethernet gateway

A Modbus Ethernet gateway allows multiple Modbus client devices on the LAN/WAN to connect
to downstream serial Modbus server devices.

A Modbus client device, such as an energy management system, can communicate through the
gateway meter to a serial network of devices connected to the gateway meter’s serial port(s). The
meter receives Modbus TCP/IP data on TCP port 502, translates it to Modbus RTU then forwards
it to the addressed server device.

This functionality allows the use of monitoring software to access information from server devices
for data collection, trending, alarm/event management, analysis, and other functions.

Modbus Ethernet gateway implementation
There are some specific aspects to your meter's Modbus Ethernet gateway implementation.

A Modbus request is sent through Ethernet using Modbus/TCP to the gateway meter. If this
request is addressed with the slave ID of one of the downstream serial devices, the meter
forwards the message to that device using Modbus RTU. When the downstream device
responds, the gateway meter forwards the response back to the Modbus client. In addition to
Modbus server addresses 1 to 247, the Modbus gateway supports server address 255, which
sends a Modbus request to the gateway meter only.

For Modbus gateway, you must install the serial Modbus server devices, configure them and
connect them to your Ethernet-connected Modbus gateway meter. Ensure that each serial device
is configured to communicate over Modbus with the same baud rate and has a unique unit ID.
Configure the gateway meter’s serial port to use the Modbus Master protocol and enable the
Modbus gateway feature, create a Modbus gateway site in ION Setup or an energy management
system, and add the serial devices to the Modbus gateway site.

NOTE: Modbus Ethernet gateway supports up to 32 Modbus TCP connections.

Configuring a Modbus gateway using ION Setup
You can configure Modbus gateway on your meter using ION Setup.
Before you begin, make sure you have completed the following tasks:

* Confirm the serial network of devices are wired and configured to have the same baud rate,
serial port settings (for example, 8N1), and protocol (Modbus).

* Confirm each serial device has a unique unit identifier.
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Confirm the serial network of devices are connected to the gateway meter’s serial
communication port.

Confirm your gateway meter is communicating over Ethernet.

Confirm that the Modbus RTU and Modbus TCP/IP Ethernet protocols are enabled on your
gateway meter.

To configure a Modbus gateway using ION Setup:

1.
2.
3.

Start ION Setup.
Open the Setup Assistant for your meter.

Click Communications > Serial settings and select the tab for the communications port
that the serial network is connected to.

Select Protocol and click Edit.

The protocol selection screen appears.

Set the protocol to Modbus Master.

Click Communications > Basic Ethernet > TCP/IP.
Select Modbus Gateway and click Edit.

The Modbus gateway selection screen is displayed.

Select the communications port that the serial network is connected to (and you just set to
use the Modbus Master protocol) and click OK. The Modbus gateway connection is created.

Create an Ethernet gateway site to access the serial network of devices through your
gateway meter.

Creating an Ethernet gateway site using ION Setup

You can create an EtherGate or Modbus gateway site in ION Setup to view serial devices
connected to your meter when it is functioning as an Ethernet gateway.

You must have Ethernet gateway communications configured and your gateway and serial
devices connected and communicating.

1.
2.

Start ION Setup.

Right-click on your workstation icon and select Insert Item.
The New Network Item dialog appears.

Select Site and click OK.

The New Site dialog appears.

Select the General tab and configure the site.

Parameter Values/Options Description

Name - Ethernet gateway site name
Comm Link Ethernet Ethernet communications
Ethernet options Gateway Ethernet gateway communications
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HTTPS

Parameter Values/Options Description

Gateway Info: IP Addr - IP address of the Ethernet gateway meter
— 7801 for EtherGate (Com1)
Gateway Info: Port 7801,7802,502 — 7802 for EtherGate (Com4)

— 502 for Modbus gateway

5. Click OKto create the site.
6. Right-click on your newly created site and select Insert Item.
The New Network Item dialog appears.
7. Ensure the new Ethernet gateway site is selected in the Attach to drop-down list box.
8. Select Device and click OK.
The New Device dialog appears.

9. Enter the details of your serial device. Click OK to add the serial device to your Ethernet
gateway site.

10. Repeat for all the serial devices on the gateway meter.

NOTE: Use a separate standard Ethernet connection in ION Setup to connect to and read
data from your Ethernet gateway meter.

HTTPS (Hypertext Transfer Protocol Secure) is an extension of HTTP and is used by a web
browser to establish communication between a client computer and the meter’'s web server
hosting webpages.

HTTPS uses Transport Layer Security (TLS) encryption to secure the communications channel
and protect exchanged data between the client and the server. When configured to use HTTPS,
the meter uses the self-signed certificate installed on its web server.

You can view the meter's webpages by entering the meter’s IP address on a web browser.

The meter uses port 443 for HTTPS by default.

Changing web protocol settings using ION Setup

Web protocol settings Description

HTTPS With HTTP

. Redirects all HTTP requests to use HTTPS.
Redirect

Allows only secure access and encrypted communications
HTTPS between the client computer and the meter’s internal web server
hosting webpages.

Turns off the meter’s web functionality and blocks all access to the

Disabled ,
meter’'s web server.

To change web protocol settings using ION Setup:
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Open ION Setup and select the Setup Assistant for your meter.
Click Communications > Advanced Ethernet > Protocols tab.
Select the Web protocol and click Edit.

Select a web protocol setting.

Change the default Assigned Port Numbers for HTTPS With HTTP Redirect and HTTPS.
This requires appending the changed port number for HTTPS access to the meter’s
webpages, for example: <meter IP address>:<changed https port number>.

Secure website indicator

A secure website displays a visible indicator such as a lock icon on the web browser.

The web address prefix https:// also indicates that the website is secure.

Web browsers typically prompt or display a message to warn you if a website you are trying to
access is not secure. For https connections, this indicates that the website’s SSL certificate is not
configured properly or is missing.

Default SSL certificate and webpages security

The meter web server protocol is factory-set to HTTPS with HTTP Redirect.

The meter ships from the factory with a self-signed certificate installed and is set to use HTTPS
protocol when accessing the webpages. Because the SSL certificate is self-signed and not signed
by a trusted Certificate Authority (CA), almost all browsers will flag the webpages as unsafe.

If your meter is accessible only inside a secure network, you can add a security exception to
override how the browser identifies the webpages.

If your meter is outside a secure network, you can install an SSL certificate issued by a CA.

Uploading a custom SSL certificate

You can upload a custom SSL certificate through the meter webpages.

Your meter supports .pem certificate file formats.

To upload a custom SSL certificate:

1.
2.
3.
4.

Use a web browser to log in to your meter.
Navigate to Setup > HTTPS.
Click Upload certificate.

Browse to the custom certificate, select it, then click Open.

The certificate is uploaded to the meter and the browser session is restarted.

Generating a new self-signed SSL certificate

A self-signed certificate is valid during the lease period. Generating a new certificate renews the
lease.

To generate a new self-signed SSL certificate using the meter webpages:
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1. Use aweb browser to log in to your meter.
2. Navigate to Setup > HTTPS.
3. Click Generate new self-signed certificate.

The meter prompts that the custom certificate will be deleted and that you will be logged out.

4. Click OKto proceed.

Deleting a custom SSL certificate
1. Use aweb browser to log in to your meter.
2. Navigate to Setup > HTTPS.
3. Click Delete custom certificate.

The meter prompts that you will be logged out and that a self-signed certificate will be used.

4. Click OK to proceed.

Secure File Transfer Protocol (SFTP)
Your meter has an internal SSH (Secure Shell) server that can be accessed using an encrypted
connection with SFTP (Secure File Transfer Protocol) client software. The SSH server hosts an

internal SFTP site and stores files in the meter’s flash memory, such as webpages, COMTRADE

records and firmware files.

Transferring files using SFTP
Prerequisites:
* Your meter’s IP address, username, and password.
* SFTP port number, see "Protocols, ports, and connections" on page 75.

* SFTP client software, such as FileZilla or WinSCP.

To transfer files using SFTP:
1. Start the SFTP client software.
2. Navigate to the desired folder > select files for upload.

3. Close the SFTP client software to disconnect from the meter.

Free up flash memory

Error messages related to available site space for storing files can be resolved by deleting files
using an SFTP client application. Available site space is affected by the number and size of stored
files and by features that use flash memory, such as increasing the number of COMTRADE
waveform records.

SFTP folders and file permissions

SFTP folder structure:
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Folder Description

COMTRADE_1 to View COMTRADE files from these folders. Users have read
COMTRADE_3 permission of files.
documents Add any file type to this folder. Users have full control of files.

Add an IEC 61850 configuration (CID) file to this folder to activate
IEC61850 IEC 61850 functionality. Users have full control of files in the root
and read permission of files in the log folder.

optionModuleUpg and Upload firmware upgrade files for your meter’s display or option
rmdUpg modules to these folders. Users have full control of files.

Add custom webpages to the meter by transferring them into web
web subfolders. This folder is where default meter webpages are
stored. Users have full control of files.

SFTP file name restrictions

The names of files sent to the meter using SFTP:
* Cannotinclude spaces
* Cannotinclude\ / , * 2 < >

* Cannot exceed 50 characters (including the file extension)

Simple Network Management Protocol (SNMP)

Your meter supports Simple Network Management Protocol (SNMP) after you have enabled
SNMP on your meter. You need to upload the meter's Management Information Base (MIB) file
(available from www.se.com) into the Network Management System (NMS) managing your
meter.

SNMP is part of the Transmission Control Protocol/Internet Protocol (TCP/IP) protocol suite.
SNMP is an application layer protocol that enables the exchange of network management
information between devices, allowing you to manage network performance and to identify and
solve problems on networks with devices of various types.

SNMP configuration assumes that you have an advanced understanding of SNMP and the
communications network and power system that your meter is connected to.

Key terms

Term Definition
Agent Software resident on the managed device which interfaces

9 between the device and the NMS.
Managed device Your meter in the SNMP network.

. . A text string that helps authenticate requests between the
Community name/string )
managed device and the NMS.
Managed object Any parameter referenced in the MIB file.
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Term Definition

A management information base which organizes the OIDs in a
hierarchical tree.

MIB

A network management station, manager or client that executes
NMS applications to monitor and control devices. An NMS must have
the standard and custom MIB files and SNMP manager software.

An object identifier that uniquely identifies and labels a managed
object in the MIB.

OID

An NMS that is configured to receive traps and whose IP address

Trap receiver
o is an SNMP trap destination.

Your meter in an SNMP system

Your meter is a managed device with an SNMP agent in an SNMP network.

A Trapreceivers

B  SNMP agent (meter)

C NMS with SNMP manager software and MIB file installed

NOTE: The NMS computer can also function as a trap receiver.

SNMP trapping

SNMP trapping allows your meter’s agent to notify the NMS of events with an unsolicited SNMP
message (a “trap” of the meter’s alarm event).
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You can enter up to four IP addresses for SNMP trap notification for generic and enterprise-
specific traps. For enterprise traps, you must also define the number of events or maximum time
delay before SNMP traps are sent to the NMS.

SNMP trapping is only supported on SNMP v2.

Configuring SNMP using ION Setup

You can enable SNMP and configure SNMP trapping using ION Setup.

Download the ION MIB file from www.se.com.

To configure SNMP using ION Setup:

1.

5.

Start ION Setup.

. Open the Setup Assistant for your meter.

2
3.
4

Click Communications > Advanced Ethernet > SNMP.

. Configure your meter's SNMP parameters by selecting the parameter and clicking Edit.

Click OK in the editing screen to set the parameter value.

Parameter Description

Enable SNMP Enables or disables SNMP on your meter.
Enable Traps Enables or disables SNMP trapping on your meter.

Trap Rcvr1 Addrto Trap  Enter up to four trap receiver IP addresses where trap
Rcvr4 Addr messages will be sent.

Enter the community string used for SNMP get (read-only)

Read only community
requests.

Enter the community string used for SNMP set (read/write)
requests.

Note: You can use the read/write community string for SNMP
get (read-only) requests.

Read write community

System contact Enter the name of your SNMP system administrator.
System name Enter a descriptive name for your meter.
System location Enter your meter’s location.

Review the rest of the SNMP information and modify if necessary.

Configuring SNMP using webpages

You can configure SNMP trapping using your meter’s webpages.

Download the ION MIB file from www.se.com.

1.
2.

Connect to your meter's webpages.

Go to Setup > SNMP Parameters.
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3. Configure your meter's SNMP parameters by selecting the parameter value.

Parameter
Enable SNMP
SNMP Port Number

System contact

System name

System location

Name

Name

Enable High Priority
Alarms

Enable Med Priority
Alarms

Enable Low Priority
Alarms

Report Buffer Size

Report Hold Time

Rcvrd Addr

Read-only Community

Read-write Community

Enable SNMP Traps

Trap Rcvr1 Addr to Trap

Range
Yes/no

161 (default)

Enable/disable

Yes/no

Yes/no

Yes/no

1-30

1-300 seconds

Description
Enables or disables SNMP on your meter.
Enter your meter's SNMP port number.

Enter the name of your SNMP system
administrator.

Enter a descriptive name for your meter.
Enter your meter’s location.

Enter the community string used for SNMP
get (read-only) requests.

Enter the community string used for SNMP
set (read/write) requests. NOTE: You can
use the read/write community string for
SNMP get (read-only) requests.

Enables or disables SNMP trapping on your
meter.

Enables trapping of events that create high
priority alarms.

Enables trapping of events that create
medium priority alarms.

Enables trapping of events that create low
priority alarms.

Enter the maximum number of trap
messages to be stored before the trap
messages are sent. Traps are sent when
the number of trap messages is equal to or
greater than this value.

Enter the maximum duration for trap
messages to be held. Trap messages are
sent when the time after a trap event has
occurred is equal to or greater than this
value.

Enter up to four trap receiver IP addresses,
where trap messages will be sent.

4. Click Apply to configure the meter's SNMP parameters.

SNMP implementation

MIB files

Your meter is compliant with MIB-Il as defined by the standard MIB file RFC 1213.
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SNMP requires that you load your meter’s ION MIB file (available for download from
www.se.com) into the NMS.

You must install RFC 1213, which is required to read basic network information for the meter (for
example, TCP/IP traffic or number of packets received), if it is not included with your SNMP
manager software.

Community strings

A community string is a text string which acts to help authenticate requests from the NMS to your
meter.

There are two community strings on your meter:

* Read Only Community: this community string is used by SNMP get (read-only) requests. The
read only community string’s initial factory-set value is public.

* Read Write Community: this community string is used by SNMP set (read/write) requests.
The read write community string’s initial factory-set value is private.
NOTE: You can also use the read write community string for SNMP get (read-only) requests.

If your meter receives an incorrect community string, it generates an AuthenticationFailure trap.

System strings

A system string is a text string which can be configured to provide information about your meter.

There are three system strings on your meter:
* System contact: Enter the name of the SNMP system administrator.
* System name: Enter a descriptive name for your meter.
* System location: Enter a description of your meter’s location.
SNMP trapping implementation
Generic SNMP traps supported by your meter are:
* Coldstart: The meter (SNMP agent) is starting.
* Linkup: The SNMP agent is enabled.

* AuthenticationFailure: The meter (SNMP agent) has received an incorrect community value.

Enterprise-specific SNMP traps supported by your meter are:
* Low: Trap of events with a low event priority.
* Medium: Trap of events with a medium event priority.

* High: Trap of events with a high event priority.

Event priority range

Low 64-127
Medium 128-191
High 192-255
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NOTE: The number of events or maximum time delay settings only apply to enterprise SNMP
traps.

See ION Reference, available from www.se.com, for detailed information on the SNMP Mapping,
SNMP Options and Alarm Options modules.

Default SNMP mapping

Enabling SNMP provides SNMP access to the meter values linked to the SNMP Mapping module.

You can configure the SNMP Mapping module to link to different meter values. By default, the
following meter values are linked to the SNMP Mapping module:

la kVAR tot Vil ca VIn avg Ib mean :f:: sd mx del-
Ib kVA tot Vil avg Freq Ic mx kW sd del
Ic PF sign tot Vina la mx Ic mean kW sd rec
lavg Vil ab Vinb lamean kW sd mxdel kW sddel-rec
kW tot VIl be Vinc Ib mx kWsdmxrec kVAR sdmxdel
kVARsdmx  kVARsdmxdel- kVARsd kVARSsd kVAR sd del-
rec rec del rec rec KVA sd mx del
kVAsd mxrec kVAsdmxdel-rec kVAsddel kVAsdrec kVAsddel-rec kWh del
kWh rec kWh del-rec kVARh del kVARhrec kVARhdel-rec kVAh del
kVAh rec kVAh del-rec

The following meter information is always provided by default and cannot be configured:
Volts mode Model number
Serial number Device name
Firmware version MIB version

If you change your meter’s default values, you must modify the custom MIB file to reflect the new
values.

Changing your meter’s default SNMP configuration assumes that you have an advanced
understanding of ION architecture, SNMP, and the communications network and power system
that your meter is connected to.

See ION Reference, available from www.se.com, for detailed information on the SNMP Mapping
module.

Configuring SNMP MIB files

You must configure your MIB file if you modify the default SNMP information provided by the
meter for the MIB file labels to reflect the modified values.

Download the ION MIB file from www.se.com.
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NOTE: You should only configure the variable name and description. Changing other fields in
your MIB file may cause the client software to report problems or return errors when trying to
retrieve or view parameters.

The variable name must conform to the following rules:
* The first character must be a letter.
* The first character must be lower case.
* The name must not contain any special characters such as *, ?, &.

* The name must not contain spaces.

To configure your SNMP MIB file:
1. Open your meter’'s MIB file in a text editing program (such as Notepad).

2. Update the variable name and description so they match the meter values connected to the
SNMP Mapping module.

3. Save your meter’'s MIB file. Keep the original file extension of .MIB.

Example:

This example shows an original and an updated OID entry in an MIB file, where the default meter
value of voltage line-to-neutral phase A is modified in the meter's SNMP Mapping module and is
now connected to voltage line-to-neutral phase C.

Original OID entry

Vin_a OBJECT-TYPE

SYNTAX DisplayString (SIZE (0. . 255))
ACCESS read-only

STATUS mandatory

DESCRIPTION “Host Meter Voltage Line A to Neutral Units =V (Volts)” ::= { Schneider Electric
34}

You must update the variable name and description to match the meter values connected to the
SNMP Mapping module:

Value Original Updated

Variable name Vin_a Vin_c

“Host Meter Voltage Line A to Host Meter Voltage Line C to
Description Neutral Units =V (Volts)” ::={ Neutral Units =V (Volts)” ::={
34} Schneider Electric 34}
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IEC 61850

The SNMP client software reads the original and updated file as follows:

Original Updated

variable name: VIn_a variable name: Vin_c

Description: “SNM1 Input 1 - Voltage (line-to-  Description: “SNM1 Input 1 - Voltage (line-to-
neutral) phase A” neutral) phase C”

IEC 61850 is an Ethernet-based communications protocol designed for electrical substations.

Your meter can be integrated into an IEC 61850 system as an Intelligent Electronic Device (IED)
or server that supports concurrent IEC 61850 client connections and an SFTP connection.

Go to the IEC International Electrotechnical Commission website at www.iec.ch for more
information on the IEC 61850 protocol.

Refer to the IEC 61850 and ION technology protocol document at www.se.com for information
about setup and configuration.

Mapping additional data to IEC 61850

Map additional data, such as Inputs and Outputs, to IEC 61850. You do not need to have IEC
61850 enabled on your meter to perform this procedure.

To map additional data to IEC 61850:
1. Open ION Setup > select the meter > Setup Assistant.
2. Communications > 3rd Party Protocols > IEC 61850.

3. Highlight a parameter to add to IEC 61850 data. Select analog for numeric information and
digital for Boolean or binary information.

4. Click Edit. The custom configuration screen is displayed.

5. Select the desired meter value. If the value you want is not shown, select Show all
available registers.

6. Selectan IEC 61850 item:

— Click >> to map the value.
— Click << to unmap values.

7. Click OK.

Enabling IEC 61850 functionality

Your meter is configured with a default set of data available to IEC 61850 that can be integrated
into an IEC 61850 system. To enable this functionality, upload a CID (Configured IED Description)
file to your meter.
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If more than one CID file is stored in the meter, IEC 61850 functionality is deactivated until
additional files are deleted.

Prerequisites:

* CETB850 IEC 61850 configuration tool installed on your computer. Download the software at
www.se.com.

* Meter connection using ION Setup over IPv4 Ethernet.

* Download the firmware package for your meter and select an ICD (IED Capability
Description) file that matches your meter’s profile. Go to www.se.com and search for firmware
and associated files (ZIP) for your meter.

Enabling IEC 61850 functionality consists of 2 steps:
1. Build the CID file using the CET850 IEC 61850 configuration tool.
2. Upload the CID file using ION Setup.

Step 1 — Build the CID file:
1. Openthe CET850 IEC 61850 configuration tool.

2. File > New.
3. Add >IED. The Add IED dialog box opens.
4. Click more options ... in the IED identification area. The Add a Device dialog box opens.
5. Select Other device.
6. Click more options ....
7. Browse to the location of the ICD file, select it and click Open.
8. Click OK.
9. Enter values for the device in the IED dialog box and click OK.
10. File > Build a CID file.
11. Click Yes on the CET850 message box.
12. Save the file as an SCD file. The Save as dialog box opens.
13. Ensure CID files (*cid) is selected and click Save.

14. Close the CET850 IEC 61850 configuration tool.

Step 2 — Upload the CID file:

1. Open ION Setup > select the meter > Setup Assistant.

NOTE: The CID file can also be uploaded using SFTP. Refer to "SFTP folders and file
permissions” on page 119 for more information.
2. Communications folder > 3rd Party Protocols > IEC 61850 > Upload CID.

3. Navigate to the CID file, select it and click Open. CID file validation can take several
minutes.

The CID status on the IEC 61850 tab indicates if the meter is operating as an IEC 61850 IED
or server.
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Watch the video on How to Enable IEC 61850 Functionality on Your Meter.

Configuring digital outputs for IEC 61850 control

Configure default settings for digital outputs to use IEC 61850 for non-critical control of the
meter’s digital outputs.

This procedure is optional. Your meter has comprehensive default settings for IEC 61850 that
meet the needs of most systems without configuration. This is an advanced procedure that
requires in-depth knowledge of your meter, its underlying architecture, and the system in which it
is installed.

A& WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

To configure digital outputs for IEC 61850 control:

1.

o a &~ 0N

10.
11.

12.

Open ION Setup.

Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.
IEC 61850 GGIO Onb Modules folder > double-click module > Setup Registers.
Select the desired SPCS Control Mode register > Edit. A dialog opens.

Select IEC 61850 CtIVAL from the drop-down list box > OK > Inputs.

Select the digital output Status register > Delete.
Note: This digital input register must be deleted to prevent a circular reference that will
cause the affected modules to go offline.

Click Send.

Navigate to the Digital Out Modules folder > double-click on the module selected to control
via IEC 61850.

Select the Setup Registers tab and confirm that the Digital Output module’s setup registers
are configured.

Inputs > Source register > Edit.

Navigate to the IEC 61850 GGIO Onb folder and select the SPCS.stVal output register that
corresponds to the digital output.

Click OK > Send.

See ION Reference, available from www.se.com, for information about IEC 61850 GGIO
and Digital output modules.
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Deleting an IEC 61850 configuration file

1. Open SFTP client software. See "Secure File Transfer Protocol (SFTP)" on page 119 for
information about connecting with SFTP client software.

2. Connect to the meter using the meter’s IP address and SFTP port number. See "Protocols,
ports, and connections" on page 75 for information on port numbers.

3. Open the IEC61850 folder in SFTP file directory and delete the CID file.
4. Close SFTP client software.

Distributed Network Protocol (DNP)

Your meter can be integrated into a DNP network as a DNP slave.

The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used in the electric
utility industry for communications and interoperability among substation computers, Remote
Terminal Units (RTUs), Intelligent Electronic Devices (IEDs, for example: meters), and master
stations.

DNP supported features and default implementation
Your meter is pre-configured for basic DNP slave functionality.

Your meter supports a maximum of three concurrent connections (sessions) using the DNP 3.0
protocol; one for each serial port, up to three using Ethernet, or a combination of both.
Combinations available depend on the meter's communications options. A session consists of all
incoming and outgoing DNP master-slave traffic on one of the meter's communications ports.

For serial DNP communications, you must assign the DNP protocol to the appropriate serial
communication port on your meter; you do not have to configure your meter’s Ethernet ports.

You can modify your meter’s default DNP map using configuration software.

Data can be imported into the meter from a DNP control relay or analog output device. This is an
advanced feature intended for users with an in-depth understanding of the DNP 3.0 and ION
protocols.

See the online ION Setup help for instructions on connecting to your meter and accessing the
Setup Assistant, which can be used to modify your meter’s DNP port settings and default DNP
map.

For more information, see the Multiport DNP 3.0 and ION Technology technical note, available on
WWW.S€e.com.

DLMS/COSEM

The Device Language Message Specification (DLMS) is described by the international standard
IEC 62056. It defines structured modeling and meter data exchange for an interoperable
environment.

DLMS supports applications such as remote meter reading, remote control, and value-added
services for metering different kinds of energy, such as electricity, water, gas, or heat.
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COSEM stands for Companion Specification for Energy Metering. It is an interface model for
communicating with energy metering equipment, providing a view of the functionality available
through the communications interfaces. The model uses an object-oriented approach.

The COSEM model allows for a manufacturer-independent and controlled method to identify,
retrieve, and interpret the information held in any meter.

For more information, see the DLMS/COSEM and ION technology technical note, available on
www.se.com.
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Inputs/Outputs

Inputs/Outputs overview

Your meter has onboard digital Input/Output (I/O) which can be increased by adding optional
digital and analog I/0 modules to expand your meter’s I/O capabilities.

4 WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Your meter base has:
* Eight digital inputs
* Four form A digital outputs
* Two form Crelays
* kWh energy pulsing LEDs (one visible, one infrared)
* kVARh energy pulsing LEDs (one visible, one infrared)

You can view information about your meter’s I/O through the display or webpages and configure
your meter’s 1/0 using ION Setup.

Input/output ION modules
ION modules are used to configure your meter’s digital or analog inputs/outputs (1/0).
You need to configure the following ION modules to use the meter’s digital or analog I/O.

* Digital input: uses the Digital Input module, which tells the meter how to interpret incoming
signals.
* Digital output: uses one of three ION modules depending on the application.
— Digital Output module: Monitors a change of state to control relay operation via a

hardware output device.

— Pulser module: Transfers high-speed pulses to a hardware pulse counting device that is
used to track energy usage.

— Calibration Pulser module: Integrates instantaneous power inputs, then outputs high-
speed pulses to an LED that can be monitored for energy accuracy verification.

* Analog input: uses the Analog Input module, which tells the meter how to interpret an
incoming analog voltage or current signal from transducers.
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* Analog output: uses the Analog Output module to deliver a continuous direct voltage or
current analog signal to transducers.

NOTE: All of these modules can act as intermediaries between the physical hardware port and
the other modules in the meter. They define the characteristics of the incoming and outgoing
signals.

Input/output ION modules, ports, and labels

You can configure the Digital Output, Digital Input, Analog Input, Analog Output, Pulser and
Calibration Pulser ION modules to specify which port handles the outgoing or incoming signals.

To assign a port to one of these modules, modify the Port setup register by picking a port from the
enumerated list.

NOTE: If the port you want to use does not appear in the Port setup register list, that port is in use
by another module. Edit the Port setup register of the module using that port and set it to Not
Used. The portis then available to other modules.

Factory configured settings

Onboard input and output ports

ION module ION module name Hardware port Port setup Description
type (device label) register name
Digital Port D1-D4 D1-D4 Port D1-D4 Form A relay
Output Port R1-R2 R1-R2 Port R1-R2 Form C relay
kW energy pulsing
WATT LED kKWATT WATT LED
Calibration (total)
Pulser kVAR energy pulsing
VAR LED kVAR VAR LED
(total)
. Internally/externally
Digital Input Port S1-S8 S1-S8 Port S1-S8 .
excited
Option module(s) input and output ports
ION module ION module name Hardware port  Port setup Description
type (device label) register name

Port A S1-S6

Port B S1-S6 Option module

Digital Input Port A/B/C/D S1-S6  S1-S6 Co
Port C S1-S6 digital inputs

Port D S1-S6
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ION module ION module name Hardware port  Port setup Description
type (device label) register name
Port AD1-D2
Digital Port B D1-D2 Option module
- Port AB/C/DD1-D2  Relay 1-Relay 2 o
Output Port C D1-D2 digital output
Port D D1-D2
Port A A1-A4

Port B A1-A4 Option module

Analog Input Port A/B/C/D A1-A4  A1-A4 .
Port CA1-A4  analoginput

Port D A1-A4
Port A Q1-Q2
el PortBQ1-Q2  QOption modul
naiog Port A/B/C/D Q1-Q2 Q1-Q2 ptuon module
Output Port C Q1-Q2 analog output
Port D Q1-Q2

NOTE: When configuring your meter, the configuration interface may show all the possible ports,
regardless of what is physically available on your meter.

For more information, see ION Reference, available on www.se.com.

I/0 option modules

1/0 option modules provide increased digital and analog input/output (1/0) capabilities for your
meter.

These I/0O modules can be used to monitor the status of breakers, control analog or digital
transducers, or receive signals that can be interpreted to provide WAGES data for your energy
system. For applications requiring high accuracy, such as energy pulsing to verify accuracy, the
digital output on the meter base is recommended.

NOTE: Your meter’s digital and analog outputs may change state during a firmware upgrade.
Option modules are offline during an option module firmware upgrade; they will not communicate
to the meter and the outputs may change state during the upgrade process.

Your meter’s analog I/O option modules can measure and output either low voltage or current
using standard analog transducers such as 4—20 mA current transducers.

Viewing I/O option module data

View I/O option module data using ION Setup, meter webpages, or the display.
To view option module data using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Select Expansion Modules > Option I/O Modules, and then select the desired I/O option
module tab.

4. Ifthere are no I/O option modules connected, no information other than column headers is
displayed.
To view option module data using meter webpages:
1. Connect to your meter webpages.

2. Go to Monitoring > Inputs/Outputs, and then select Digital Inputs, Digital Outputs,
Analog Inputs or Analog Outputs.

3. Ifthere are no I/0 option modules of the specified type, no entries other than column
headers are displayed.

To view option module data using the display:

Go to Inputs/Outputs, and then select Digital Inputs, Digital Outputs, Analog Inputs or
Analog Outputs.

I/O option module configuration

You can configure your meter’s 1/O option modules using ION Setup.

The Option I/O Modules screen has tabs corresponding to the possible option modules, which are
identified based on how the option modules are connected to the meter. Each tab indicates the
module’s type and status and has an area where the module’s ports are listed for viewing and
configuration. You can also reset your meter’s option modules using ION Setup.

Status examples Description

None No option module detected
Normal The option module is operating normally
Option module added A new option module is detected

Option module removed The option module has been removed
Invalid S19 The option module’s firmware is not supported

Invalid card The option module type is not supported

Analog inputs

Analog input applications

You can use an analog input to monitor an analog signal, for example a flowmeter, to monitor how
much water flows through a pipe.

For analog input operation, your meter takes an analog input signal and provides the resulting
scaled value.

Your meter’s analog I/O option modules can measure either low voltage or current using standard
analog transducers such as 4-20 mA current transducers.
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Analog input voltage and current mode

You can set the analog input’s mode for voltage or current sensing.

In current mode, the analog inputs have a low input resistance while the meter is powered on, and
a high input resistance when the meter is powered off. In voltage mode, the analog inputs have a
high input resistance regardless of whether the meter is powered or not.

NOTE: When unpowered, your meter’s analog inputs act like they are in voltage mode (high input
resistance).

When connected to a current output transducer, this high resistance can create a high voltage.
Standard (i.e., 4—20 mA) current transducers have open circuit protection and can handle a high
input resistance; however, if non-standard transducers are used high voltages may be generated.
Your meter’s analog input has circuitry to limit this voltage, but it may not be sufficient with a very
high-power current source.

NOTICE

EQUIPMENT DAMAGE

* Ensure the analog input is configured for the correct voltage or current mode before
connecting or activating the current transducer.

* Do not exceed the device’s ratings for maximum limits.

Failure to follow these instructions will result in equipment damage.

Analog input behavior

Analog inputs may show a value below zero scale if an open circuit is detected on the input port.

Analog input zero scale and full scale values

In most cases the output range of the sensor feeding the analog input matches the hardware
limits of your meter’s analog input port. In that case, the analog input’s zero scale and full scale
values are the same as the sensor’s represented range. For example:

Analog sensor Meter’s analog input signal  Analog input register values

Full scale = 50 (psi)
0-50 psirepresentedbya  4-20 mA analog input range

Zero scale = 0 (psi)
4-20 mA signal Input value: 12 mA

Scaled value: 25 (psi)

. Full scale = 50 (psi)
0-50 psirepresented bya  0-20 mA analog input range
Zero scale = 0 (psi)
0—20 mA signal Input value: 12 mA
Scaled value: 30 (psi)

' Analog I/0 option module must have firmware version v1.2 or later.
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If the sensor’s output range does not match your meter’'s hardware limits, you must calculate the
full scale and/or zero scale values by analyzing the system.

For more information on the Analog Input module, see ION Reference, available on www.se.com.

Configuring option module analog inputs using ION Setup

You can configure analog inputs using ION Setup.
Analog inputs are available on the optional /O modules.

Calculate your zero scale and full scale values based on the analog source and the input range of
your meter.

Make sure that the analog input port that you want to use is properly configured and connected to
a valid external analog signal source.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.

3. Click Expansion Modules > Option I/O Modules and select the module tab that
corresponds to the option module with the analog input you want to configure.

4. Selectthe analog input channel and click Edit. Enter the meter password if prompted. The
setup screen for that analog input is displayed.

5. Configure the analog input by selecting the parameter and clicking Edit.

Parameter Value/Range Description

The minimum source value that matches
the minimum analog input signal.

Zero scale 0to+10°

The maximum source value that matches

Full scale 0to+10° . : :
the maximum analog input signal.
Port - The physical analog input port connection.
Determines whether the analog input is
Mode Voltage, current

monitoring voltage or current.

Update Rate One Second/High Speed Defines how frequently the input is updated.

Analog outputs

Analog output applications

You can use an analog output to send a signal to an external analog input, for example an analog-
controlled valve, to modify a water pipe’s valve position to change the flow rate.

For analog output operation, your meter takes an input value and scales it to the appropriate
signal value to send out the physical analog output port.

Your meter’s analog I/0 option modules can output either low voltage or current using standard
analog transducers such as 4—20 mA current transducers.
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Analog output behavior

Your meter’s analog output, after it is configured, outputs voltage or current signals. If your
meter’s analog output source becomes unavailable (N/A) the analog output level should go to
zero (0 V/0 mA) under most conditions.

When your meter is powered off or configured to send voltage, the meter registers as a high
impedance.

The electrical signal on the analog output is DC; make sure proper polarity is observed when
wiring external devices to the analog output ports.

Analog output zero scale and full scale values

In most cases, your meter’s analog output range matches the range of the analog sensors that
your meter’s outputs are connected to. In that case, your meter’s analog output zero scale and full
scale values are the maximum and minimum values of the source driving your meter’s analog
output. These values are used to normalize the source value to a value between 0 and 1 which is
applied to the operating range of the analog output port to determine the analog output current or
voltage. For example:

Source value Analog output register values Meter’s analog output signal
Full scale = 120 (kW)

0-120 kW range 4-20 mA range
Zero scale = 0 (kW)

100 kW Output: 17.33 mA

Normalized: 0.83

Full scale = 120 (kW) ;
0-120 kW range 0-20 mA range
Zero scale = 0 (kW)
100 kW Output: 16.67 mA
Normalized: 0.83

' Analog I/0 option module must have firmware version v1.2 or later.

If your meter’s analog output range does not match the range of the connected analog sensor,
you must calculate the full scale and zero scale values by analyzing the system.

For more information on the Analog Output module, see ION Reference, available on
www.se.com.

Configuring option module analog outputs using ION Setup
You can configure option module analog outputs using ION Setup.
Analog outputs are available on the optional I/O modules.

Calculate your zero scale and full scale values based on the measured value and the analog
output range of your meter.

Make sure that the analog output port that you want to use is properly connected to an analog
receiver.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Click Expansion Modules > Option I/O Modules and select the module tab that
corresponds to the option module with the analog output you want to configure.

4. Selectthe analog output channel and click Edit. Enter the meter password if prompted. The
setup screen for that analog output is displayed.

5. Configure the analog output by selecting the parameter and clicking Edit.

Parameter Value/Range Description

Zero scale 0to +10° The minimum source value that matches the minimum
- analog output signal.

The maximum source value that matches the maximum

Full scale 0to+10° _
analog output signal.
Port - The physical analog output port connection.
Mode Voltage, Determines whether the analog output is monitoring
current voltage or current.

Digital inputs

Digital input applications

Digital inputs are typically used for monitoring the status of switches or contacts, such as status
contacts on circuit breakers.

They can also be used for pulse counting or input metering applications, such as WAGES (water,
air, gas, electricity, steam) monitoring, or conditional energy applications, or IRIG-B time
synchronization.

Pulse mode

If you set Input Mode to PULSE, a pulse is generated at the Trigger output when the State output
changes from OFF-to-ON. No pulse is generated when State changes from ON-to-OFF.

Cigital input signal ‘

oM
State output

THjoar ot |I| ‘
Triggar output || A II||I

O

OFF

CFF

{inpat Mode = PLLEE]

KYZ mode

If you set Input Mode to KYZ, a pulse is generated at the Trigger output for each change of state
transition, for example from OFF-to-ON and from ON-to-OFF transitions.
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A/C mode

If you set Input Mode to A/C, the digital input port is configured to detect the presence of a low
voltage AC signal. The next illustration shows how a digital input can be used to monitor the
operation of a low voltage AC fan controller.
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IRIG-B time synchronization

You can use a digital input to synchronize the meter time to an IRIG-B time source.

You can connect an IRIG-B time source to one of meter’s digital inputs for IRIG-B time
synchronization. For IRIG-B time synchronization, you must configure both the meter’s digital
input and the meter’s clock.

NOTE: For improved accuracy use the digital inputs on the meter base.

Configuring onboard digital inputs using ION Setup
You can use ION Setup to configure your meter’s digital inputs.
1. Start ION Setup.
2. Open the Setup Assistant for your meter.

3. Click Onboard I/O > Digital Inputs. The tabs correspond to each digital input. Click on the
tab for the digital input you want to edit.

4. Configure the digital input by selecting the parameter and clicking Edit.

5. After the parameter is configured, click OK to save the setting to the meter.
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Parameter Value/range Description
Specifies how the meter processes the signal:
* Pulse: the meter counts an entire pulse (from
off-on to on-off) as one input.
* KYZ: the meter counts a transition (from off-on
Pulse, KYZ, A/C, or from on-off) as one input.
Input Mode
IRIG-B* * A/C: the meter detects analog signals where the
ON condition is based on the presence of an AC
signal.
* IRIG-B*: the meter detects an IRIG-B time
synchronization signal.
Specifies if the signal from the digital port is inverted
Polarity Inverting/Non-Inverting 2 , 8 L
or not inverted.
Specifies how long (in seconds) the signal must
Debounce 0.000-1.000 remain in a state to be considered a valid state
change.
; Defined by your meter’s , : o
Assigned Port Your meter’s physical digital input port.
hardware
EventLog Mode Log Off/Log On Specifies if events generate log entries.
State OFF/ON Indicates the status of the digital input.

*You must also configure your meter’s clock to use IRIG-B time synchronization.

Configuring option module digital inputs using ION Setup

You can configure option module digital inputs using ION Setup.

1.
2.
3.

Start ION Setup.
Open the Setup Assistant for your meter.

Click Expansion Modules > Option I/O Modules and select the module tab that
corresponds to the option module with the digital input you want to configure.

Select the digital input channel and click Edit.
The setup screen for that digital input is displayed.
Configure the digital input by selecting the parameter and clicking Edit.

Once the parameter has been configured, click OK to save the setting to the meter.
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Parameter Value/Range Description
Specifies how the meter processes the signal:

* Pulse: the meter counts an entire pulse (from off-
on to on-off) as one input.

* KYZ: the meter counts a transition (from off-on or

Pulse, KYZ, A/C, from on-off) as one input.
Input Mode IRIG-B*
; * A/C: the meter detects analog signals where the
ON condition is based on the presence of an AC
signal.
* IRIG-B*: the meter detects an IRIG-B time
synchronization signal.
EvLog Mode Log Off/Log On Specifies if events generate log entries.
Event Priority 0-255 Specifies the priority of an event.
Polarit Inverting/Non- Specifies if the signal from the digital port is inverted
y Inverting or not inverted.
Specifies how long (in seconds) the signal must
Debounce 0.000-1.000 remain in a state to be considered a valid state

change.

Defined by your , ; o
Port Your meter’s physical digital input port.
meter’s hardware

Enable Enabled/Disabled  Specifies whether the module is enabled or disabled.

Alarm Trigger Alarm on ON/Alarm

Mode on OFE Specifies the behavior of the digital input alarm.

* IRIG-B time synchronization is not supported on the option module digital inputs.

WAGES monitoring

WAGES monitoring lets you record and analyze all energy sources and utilities usage.

Your system may use several different types of energy. For example, you may consume steam or
compressed air for industrial processes, electricity for lights and computers, water for cooling and
natural gas for heating. WAGES monitoring collects the usage information from all these different
energy sources to enable a more complete energy analysis.

WAGES information can help you:
* ldentify losses or inefficiencies.
* Modify demand to reduce costs.

* Optimize energy source usage.

WAGES monitoring example

The following example shows WAGES monitoring for a water flow meter.
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You can connect your meter’s digital input to a transducer that sends a pulse for every 15 kiloliters
(4000 US Gal) of water. After configuring an input metering channel and assigning it to the digital
input, the meter can detect and record the incoming pulses. An energy management system can
then use the information from the meter to perform WAGES analysis.

= & -
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A Water flow meter (15 kL/pulse)

Energy meter with digital input 1 assigned to input metering channel 1 and configured with
unit kL (kiloliters)

C Energy management system with WAGES analysis capabilities

Input metering

Your meter’s digital inputs can be used to count pulses from transducers and convert the pulses
to energy measurements.

Your meter’s input metering channels count pulses received from the digital inputs assigned to
that channel. The incoming pulses are used in calculating and measuring consumption data (e.qg.,
BTU, kWh, L, kg). Each channel must have the following values configured to match the pulse
data:

* Pulse Weight: the pulses per unit value.
* Unit Code: the unit of measure associated with the monitored value.

* Demand Code: for time-based values (such as kWh), this provides the associated demand
units (kW) for demand calculations; for other values (such as kg), this can be configured to
provide rate information (kg/h or kg/s).

* Mode: whether a pulse is based on a complete pulse or a transition.

For example, if each complete pulse represents 125 Wh, you can configure for Wh pulsing as
follows:

* Pulse Weight = pulses/Wh = 1/125 = 0.008

* Unit Code = Wh

* Demand Code = kW (this is automatically set)
* Mode = pulse

If you want to configure for kWh pulsing, you must adjust the pulse weight calculation and unit
code as follows:

* Pulse Weight = pulses/kWh = 1/0.125=8
* Unit Code =kWh
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Configuring standard input metering using ION Setup
You can configure input metering with standard units and rates using ION Setup.
When configuring your meter, the configuration interface may show all the possible ports,

regardless of what is physically available on your meter.

NOTE: Your device’s digital input must be connected to the input metering pulse source. Review
the digital inputs assigned to applications to help you understand your existing configuration.

NOTE: To disable an input metering channel and remove any port associations, set Assigned
Input to No connection.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Digital Input Based.
4

. Select the input metering channel you want to configure and click Edit. The Input Metering
Channel Setup screen is displayed.

Select Enabled to enable the input metering feature.
Click Select to define which digital input is the pulse source for the input metering channel.
Configure the remaining parameters as required.

Click OK to save your configuration.

© © N o o

Configure your meter to log the input metering data if required.

Parameter Description

Pulse Weight Enter the value per pulse.
Units Select the measurement units associated with the pulse.

Enter the frequency in minutes that input metering data is calculated in your
energy management system.

Demand Period

Rate Select the rate associated with the defined Units.

Enter a data identifier. This value is added to the input metering channel’s
output register labels to uniquely identify the data within your energy

Source ID management system.

NOTE: You must select a Unit for this field to appear.

Configuring custom input metering using ION Setup
You can configure input metering with custom units and rates using ION Setup.
When configuring your meter, the configuration interface may show all the possible ports,

regardless of what is physically available on your meter.

NOTE: Your device’s digital input must be connected to the input metering pulse source. Review
the digital inputs assigned to applications to help you understand your existing configuration.
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NOTE: To disable an input metering channel and remove any port associations, set Assigned
Input to No connection.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Digital Input Based.
4

. Select the input metering channel you want to configure and click Edit. The Input Metering
Channel Setup screen is displayed.

o

Select Enabled to enable the input metering feature.
6. Click Select to define which digital input is the pulse source for the input metering channel.

7. Clear the Standard quantity check box. The screen changes to display custom input
metering parameters.

8. Configure the remaining parameters as required.
9. Click OK to save your configuration.

10. Configure your meter to log the input metering data if required.

Parameter Description

Pulse Weight Enter the value per pulse.

Select the measurement units associated with the pulse.
Units Note: Include source identification information by entering “@” followed by
the source identifier.

Enter the frequency in minutes that input metering data is calculated in your
energy management system.

Demand Period

Rate Select the rate associated with the defined Units.
Scaling Select the scaling value based on the relationship between Units and Rate.
Time Base Select the value and units to match the Rate.

Digital outputs

Digital output applications

Digital outputs are typically used in switching applications, for example, to provide on/off control
signals for switching capacitor banks, generators, and other external devices and equipment.

The digital output can also be used in demand synchronization applications, where the meter
provides pulse signals to the input of another meter to control its demand period. The digital
output can also be used in energy pulsing applications, where a receiving device determines
energy usage by counting the kWh pulses coming from the meter’s digital output port.

Configuring onboard digital outputs using ION Setup

To configure the meter’s digital outputs using ION Setup:
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1. Start ION Setup.
2. Open the Setup Assistant for your meter.

3. Click Onboard I/O > Digital Outputs and select a digital output tab. Configure the digital
output by selecting the parameter and clicking Edit. Enter the meter password if prompted.

Parameter Value/range Description

Link this input to the value that drives the state of the

digital output.
Source Digital/Boolean
If Source is not linked, the digital output state is

driven by the Force ON, Force OFF values.

Link this input to a pulse that forces the digital output
Force ON Pulse on for the PulseWidth duration, regardless of the
Source input.

Link this input to a pulse that forces the digital output
Force OFF* Pulse

off.
Pulsing this input will switch the driver of the digital
Normal* Pulse
output from Force ON to Source.
. . . . Specifies if the signal to the digital port is inverted or
Polarity Inverting/non-inverting

not inverted.

Specifies the duration of the pulse, in seconds.
PulseWidth 0-2,000,000 Setting this parameter to 0 sets the digital output
continuously on.

The physical digital output port connection. Only
available ports are shown.

Assigned Port

Open/Closed/Not . .
State i Indicates the status of the digital output.
Available

* These parameters are only valid when pulse width is setto 0.

Configuring option module digital outputs using ION Setup
To configure the option module digital outputs using ION Setup:
1. Start ION Setup.
2. Open the Setup Assistant for your meter.

3. Click Expansion Module > Option I/O Modules and select the module tab that
corresponds to the option module with the digital output you want to configure.

4. Select the digital output channel and click Edit. The setup screen for that digital output is
displayed.

5. Configure the digital output by selecting the parameter and clicking Edit.
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Parameter Value/Range Description

Link this input to the value that drives the state of the
digital output.

Source Digital/Boolean
If Source is not linked, the digital output state is driven by
the Force ON, Force OFF values.
Link this input to a pulse that forces the digital output on
Force ON Pulse for the PulseWidth duration, regardless of the Source
input.
Force OFF* Pulse Link this input to a pulse that forces the digital output off.
Pulsing this input will switch the driver of the digital output
Normal* Pulse

from Force ON to Source.

EventLog Mode Log OfflLog On  Specifies if events generate log entries.

Polarit Inverting/non- Specifies if the signal to the digital port is inverted or not
v inverting inverted.
Specifies the duration of the pulse, in seconds.
PulseWidth 0-2,000,000 Setting this parameter to 0 sets the digital output
continuously on.
Port The physical digital output port connection. Only available

ports are shown.

* These parameters are only valid when pulse width is set to 0.

Energy pulsing

You can configure the meter’s energy pulsing LEDs or onboard digital outputs for energy pulsing
applications.

When an LED or output is set to energy pulsing, the meter sends a readable pulse or signal based
on the measured energy source value. This pulse can be used for accuracy verification or as an
input to another energy monitoring system.

Default energy pulsing LED sources

Your meter’s energy pulsing LEDs have default energy source values configured for accuracy
verification testing.

For LED locations, see your meter’s installation guide.

Calibration Pulser LED LED Default energy pulsing source

kWh pulse LED
WATT LED kW del-rec
kWh pulse infrared LED

kVARh pulse LED
VAR LED kVAR del-rec
kVARNh pulse infrared LED
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NOTE: The energy pulsing LEDs are configured in pairs. For example, changing the energy
source value will change it for both the regular and infrared LEDs.

NOTE: To modify your default energy source value, go into the advanced mode of ION Setup and
modify the associated Calibration Pulser module. This is an advanced procedure that should only
be performed if you have advanced knowledge of ION and the power system your meter is
connected to.

For more information on the Calibration Pulser module, see ION Reference, available on
WWww.se.com.

For more information on other LED indicators, see "Alarm and status LED indicators" on page
169.

Configuring LED energy pulsing using ION Setup

You can configure your meter’s energy pulsing LEDs for energy pulsing using ION Setup.
1. Start ION Setup.
2. Open the Setup Assistant for your device.
3. Select LED pulsing.
4. Selectthe tab that corresponds to the energy pulsing LED you want to configure.
5

. Configure the following basic parameters for your meter’s energy pulsing LEDs.

Energy pulsing LED parameters available through ION Setup

Parameter Description

Source Link this input to the value that you want to pulse on the LED.

Configuring this setting should only be performed by users with advanced
Enable knowledge of ION, the device template and the power system the device is
connected to.

Specifies the integration mode for the LED (forward, reverse, absolute or

Int Mode
net).
Kt The amount of source energy required to make the LED pulse.
Pulse Width The minimum time in seconds between LED pulse transitions.
Select when the energy pulsing LEDs will pulse:
Pulser Mode * Always: the energy pulsing LEDs are always pulsing based on their
energy source value.
Pulsing normally indicates that the energy pulsing LED should be operating
normally.
Pulse ovrld Pulsing suspended indicates that the energy pulsing LED is not able to pulse

quickly enough. Modify the Kt value to decrease the number of energy pulses
or decrease the pulse width, if supported by the device collecting pulses.

148

Public 7EN02-0390-08



PowerLogic™ ION9000 series - User manual Inputs/Outputs

NOTE: To perform specialized configuration go into the advanced mode of ION Setup and modify,
disable or add a new Calibration Pulser module. These are advanced procedures that should only
be performed if you have advanced knowledge of ION and the power system your meter is
connected to.

For more information on the Calibration Pulser module, see ION Reference, available on
www.se.com.

Configuring digital output energy pulsing using ION Setup

You can configure your meter’s onboard digital outputs for energy pulsing using ION Setup.

When configuring your meter, the configuration interface may show all the possible ports,
regardless of what is physically available on your meter.

Ensure that the digital output port is available for energy pulsing and not associated with another

function.

NOTE: For applications where accuracy is important, use the digital output located on the meter
base.

1. Start ION Setup.

2. Open the Setup Assistant for your device.
3. Select Energy pulsing.
4

. Select an energy pulsing source tab (such as Wh Del) to configure energy pulsing using
your meter’s digital output.

Digital output energy pulsing parameters available through ION Setup
Parameter Description

The amount of energy source required to trigger the digital output. For
Kt example, in the Wh Del tab, the Kt value would be amount of real energy
delivered (Wh Del) per pulse.

Pulse Width The minimum time in seconds between pulse transitions.
Select the desired output mode:

* Pulse: the digital output sends a complete pulse when triggered.

OutputMode
* KYZ: the digital output makes a transition (off-to-on, or on-to-off) when
triggered.
Port Select an output port from the list. Only available output ports are shown
(ports that are not associated with another function).
Pulsing normally indicates that the output port should be operating normally.
(energy source)
ovrld Pulsing suspended indicates that the output port is not able to pulse quickly

enough. Modify the Kt value to decrease the number of energy pulses.
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NOTE: To perform specialized configuration go into the advanced mode of ION Setup and modify
or add a new Calibration Pulser module. This is an advanced procedure that should only be
performed if you have advanced knowledge of ION and the power system your meter is
connected to.

For more information, see ION Reference, available on www.se.com.

Calculate your maximum kWh/pulse (pulse weight) value

To calculate the kWh/pulse (pulse weight) value, divide the highest kW value you can expect by
the required pulse rate.

Make sure the required pulse rate does not exceed the maximum pulse rate for the digital output.

NOTE: To convert from kWh/pulse to pulse/kWh you must invert (take the reciprocal) of the value.
For example, 1.8 kWh/pulse becomes 0.556 pulse/kWh.

Example pulse weight calculation

For a maximum load of 1600 kW and a pulse rate of two pulses per second, calculate the
kWh/pulse value as follows:

1. Convert 1600 kW load into kWh/second:
(1600 kW)*(1hr) = 1600 kWh
(1600 kWh)/(3600 sec) = (X kWh)/(1sec)
X=0.444 kWh/sec
2. Calculate the kWh required per pulse:
(0.444 kWh/sec)/(2 pulses per second) = 0.222 kWh/pulse

3. Ifusing KYZ Output Mode, adjust for the KY giving one pulse per two transitions if
necessary.

(0.222 kWh/pulse)/(2) = 0.111 kWh/pulse

For more information on the Calibration Pulser module, see ION Reference, available on
www.se.com.
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Webpages

Webpages
Webpage interface

Your meter comes with default webpages that contain typical elements.
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Meter type and model, device name

Username

Main menu

Webpage menu
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Webpage content

NOTE: This graphic is representative only. Your meter's webpages may appear differently than

shown.

Default meter webpages

The following table lists the available webpages and their content.

Monitoring
Webpage Content
* Basic Readings
* Energy Readings
Instantaneous Readings * Demand Readings

Voltage Readings

Power Quality

Trending & Forecasting

Select the target and interval for trending and forecasting and view
the results.
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Webpage Content

* Harmonics Chart

* ITI (CBEMA)-SEMI

* NEMA Motor Derating Curve
Power Quality Summary

* EN50160

* IEEE 519 Harmonics

* HSTC (ION900OT only)

* Digital Inputs
* Digital Outputs

Inputs/Outputs
* Analog Inputs
* Analog Outputs
View waveforms from your meter, using the meter's COMTRADE
Waveforms i
files.
Control
Webpage Content
Resets Perform resets, and view when previous resets were performed.
Diagnostics
Webpage Content
* Communications
* Ethernet
Statistics * Serial Port
* Meter - Basic
* Meter - Advanced
Phasor Diagram View the phasor diagram and numeric values.
Setup
Webpage Content
* Basic Settings
Ethernet
* Advanced Settings
* Basic Settings
Serial Port
* Advanced Settings
SNMP Parameters Configure your meter's SNMP parameters.
NTP Configure your meter's NTP parameters.
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Webpage Content
SMTP Configure your meter's SMTP parameters.
Date & Time Configure your meter’s time and time synchronization.
Preferences Enter your meter’s nameplate information.
* Basic Settings
Metering
* Advanced Settings
HTTPS Certificate Management.

Maintenance

Webpage Content

Custom. No default content.

- By default, the Maintenance menu is empty and the menu is not
displayed until information is added to it.

Accessing webpages for data viewing and meter configuration

You can access the meter's webpages through the meter’s Ethernet connection using a web
browser.

You must have cookies enabled to access your meter's webpages.

You may need to configure your meter’s security settings to view webpages and configure your
meter using webpages.

On a hardware-locked meter, you cannot add, delete, or modify any webpage files.

If you are connected to your device over Ethernet, changing Ethernet configuration parameters
without another method of configuration enabled may cause loss of communications with your
device and render it inaccessible.

NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

1. Open a web browser and enter your meter’s IP address in the address bar. The webpage
login prompt is displayed.

If the browser cannot connect to the webserver, check the web protocol setting.

2. Enter avalid username and password.
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5.
6.

Select your desired Language from the drop-down list box, and click Log In.

Your meter’'s webpages are displayed. The default page is the Monitoring webpage,
showing real-time data.

Select the main menu tab that corresponds to the category of information you want to view
and select the webpage menu from the list.

The webpage content is displayed.
Click the webpage content headings to expand and view the meter’s data.

Select Setup to view and edit your meter’s configuration.

Embedding images and files in meter webpages

Upload images, documents, audio and video files to meter webpages using SFTP.

NOTE: Images cannot be scaled after they are uploaded. Format images to the desired size
before uploading.

1.
2.

Access your meter’s internal SFTP site.

Open the web folder. Copy your file into the subfolder that corresponds to the webpage
main menu tab you want to access your file from.

Connect to your meter’'s webpages. Select the main menu item that corresponds to the
folder you previously selected. Your file is listed in the webpage menu.

Select your file from the webpage menu to view it.

Creating custom webpages

Create custom webpages to view data or access configuration parameters from your meter.

Download the meter's Modbus registers map from www.se.com.

1.
2.

Open SFTP client software.

Go to web > examples. Select samplereadings.html to create a data value webpage or
select sampleconfiguration.html to create a configuration parameters webpage.

Save a copy of the sample file. This filename is the webpage name.
Open your webpage in an HTML or webpage editor program.

Modify the webpage to reference the desired meter data or parameters from the Modbus
registers map, and update the other fields where required.

Save your custom webpage.

The meter will display translated content if it exists in the meter’'s memory. If translated
content is not available, English is displayed.
Connect to your meter’s internal SFTP site.

— If you have created a data viewing webpage, copy your custom webpage to web >
monitoring.
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— If you have created a configuration webpage, copy your custom webpage to web >
setup.

8. Login to your meter’'s webpages.

Your custom webpage is available from the webpage menu under the Monitoring (data viewing)
or Setup (configuration) tab.

Watch the video on how to create custom webpages: How to Create Custom Webpages for Your
Meter

Deleting custom webpages

1. Open the SFTP client software.

2. Connect to the meter using the meter’s IP address and SFTP port number. See "Protocols,
ports, and connections" on page 75 for information on port numbers.

3. Open the web folder in SFTP file directory and delete all files in subfolders.

4. Close the SFTP client software.

Loading webpages using ION Setup

Prerequisites:
* Webpage files in the upgrade .zip folder. Go to www.se.com to download upgrade files.

* Meter connection using SFTP client application.

To load webpages using ION Setup:

1. Obtain the webpage upgrade files (.zip folder) that you want to upload onto your meter. Save
the files where they can be accessed by the computer running ION Setup.

2. Start ION Setup.
3. Open the Setup Assistant for your meter.
4. Click Template > Web.
NOTE: You can preview meter webpages using the Test Web Viewing feature. Select an

IP addressing method from the drop-down list box to generate a test link using your default
web browser.

5. Click Upload to navigate to the folder (.zip) containing the meter upgrade files. Select the
folder and click Open.

6. An ION Setup dialog box will open. Click Yes to confirm uploading of the webpage files.
NOTE: The upload process replaces files with matching filenames only.

Confirmation of uploaded files is displayed in the bottom status bar.

Loading webpages using SFTP

You can upgrade your meter's webpages using your meter’s internal SFTP site.

7EN02-0390-08

Public 155


https://youtu.be/1EUguCYXKPQ
https://youtu.be/1EUguCYXKPQ

Webpages PowerLogic™ ION9000 series - User manual

Prerequisites:
* Your meter’s webpage upgrade files. Go to www.se.com to download upgrade files.

* Access to your meter’s internal SFTP site.

To load webpages using SFTP:
1. Connect to your meter’s internal SFTP site and open the web folder.
2. Navigate to the location on your local machine where you saved the webpage .zip file.
NOTE: Extract the contents of the upgrade file.
3. Drag the resources and examples folders into the web folder. Confirm to overwrite existing
files when prompted.

The files are transferred to the meter.

Sample data viewing webpage

You can create custom data viewing webpages using the sample webpage stored on your meter.
The sample webpages are stored in the documents folder on your meter’s internal SFTP site.
Your meter’s Modbus register map is available from www.se.com.

If required, your meter’s ION handles document is packaged with the meter firmware file which is
available for download from www.se.com.

The data viewing webpage must be stored on your meter’s internal SFTP site in the
web/monitoring folder. The custom webpage is viewed by selecting the Monitoring main menu
tab on your meter's webpage.

Configuring the HTML code other than where described is an advanced procedure and should
only be performed by those with an advanced understanding of webpages and how your meter
processes them.

Sample webpage data viewing result

NOTE: The following graphic is representative only. Your meter's webpages may appear different

than shown.
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B  Content pane title
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Row heading

Units

Column heading

Named register instantaneous value

QMmoo

Second content pane A title

7EN02-0390-08 Public 157



Webpages PowerLogic™ ION9000 series - User manual

Sample HTML code for data viewing webpage content

Content and formatting of a data viewing webpage is controlled by its HTML code.

Sample data viewing webpage content

1| SampleMonitorPane.html
2 <div class="content-fit">
3 <div class="accordion">
4| <h3 target="sample-readings">$%localizedString(Basic Readings)#$</h3>
5 <div id="sample-readings">
6 <table class="datatable">
7 <tr>
8 <th>&nbsp;</th>
9 <th>$%localizedString(Minimum)#$</th>
10 <th>$%localizedString(Present)#$</th>
11 <th>$%localizedString(Maximum)#$</th>
12 </tr>
13 <tr class="minor">
14 <td>$%localizedString(I a)#$ <span unitsreg="I a"></span></td>
15 <td regname="I a mn"></td>
16 <td regname="I a"></td>
17 <td regname="I a mx"></td>
18 </tr>
19 <tr class="minor">
20 <td>$%localizedString(I b)#$ <span unitsreg="I b"></span></td>
21 <td regname="I b mn"></td>
22 <td regname="I b"></td>
23 <td regname="I b mx"></td>
24 </tr>
25 </table>
26 </div>
27 | <h3 target="sample-energy">$%localizedString(Energy Readings)#$</h3>
28 <div id="sample-energy">
29 <table class="datatable">
30 <tr>
31 <th>&nbsp;</th>
32 <th>$%localizedString(Present)#$</th>
33 </tr>
34 <tr>
35 <td>$%localizedString(Active Energy)#$ <span unitsreg="kWh del-rec"></span></td>
36 <td regname="kWh del-rec"></td>
37 </tr>
38 <tr>
39 <td>$%localizedString(Reactive Energy)#$ <span unitsreg="kVARh del-rec"></span></td>
40 <td regname="kVARh del-rec"></td>
41 </tr>
42 </table>
43 </div>
44 </div>
45
46
47 | <script type="text/javascript">
48
49 | instantaneousReadings.initInstantaneousReadings('sample-readings');
50
51| </script>
52| </div>
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Sample webpage data viewing content description

Line # Description

SampleMonitorPane.html

1 The HTML filename, including the HTML extension (.html). This filename must comply with SFTP
filename requirements (no spaces or special characters). The filename (without the HTML extension) is
the name shown on the webpage menu.

<h3 target="sample-readings">

This creates the first webpage content pane. “sample-readings” is the name of the webpage content.
4 This name must be unique.

$%localizedString (Basic Readings) #$</h3>

Basic Readings is the title of the webpage content pane. This title is translated if possible.

<div id="sample-readings">
This must match the name of the webpage content in line 4.

<th>$%localizedString (Minimum) #$</th>

Minimum is the heading for the first column. This heading is translated if possible.

<th>$%localizedString (Present) #$</th>
10
Present is the heading for the second column. This heading is translated if possible.

<th>$%$localizedString (Maximum) #$</th>
11
Maximum is the heading for the last column. This heading is translated if possible.

<td>$%$localizedString (I a) #$

| ais the row heading. This heading is translated if possible.
14
<span unitsreg="I a"></span></td>

This displays the units that the meter has defined for the named register | a.

<td regname="I a mn"></td>
15
This displays the instantaneous value of the named register | a mn.

<td regname="I a"></td>
16
This displays the instantaneous value of the named register | a.

<td regname="I a mx"></td>
17
This displays the instantaneous value of the named register | a mx.
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Line # Description

<td>$%localizedString (I b) #$

I b is the second row heading. This heading is translated if possible.

20
<span unitsreg="I b"></span></td>
This displays the units that the meter has defined for the named register | b.
<td regname="I b mn"></td>

21
This displays the instantaneous value of the named register | b mn.
<td regname="I b"></td>

22
This displays the instantaneous value of the named register | b.
<td regname="I b mx"></td>

23

This displays the instantaneous value of the named register | bmx.

<h3 target="sample-energy">

This creates the second webpage content pane. Sample-energy is the name of the webpage content.
27 This name must be unique.

$%localizedString (Energy Readings) #$</h3>

Energy Readings is the title of the webpage content pane. This title is translated if possible.

<div id="sample-energy">

2 This must match the name of the webpage content in line 27.
<th>$%localizedString (Present) #$</th>

- Present is the heading for the last column. This heading is translated if possible.
<td>$%$localizedString (Active Energy) #5$
Active Energy is the row heading. This heading is translated if possible.

% <span unitsreg="kWh del-rec"></span></td>
This displays the units that the meter has defined for the named register kWh del-rec.
<td regname="kWh del-rec"></td>

% This displays the instantaneous value of the named register kWh del-rec.”
<td>$%localizedString (Reactive Energy) #$

39 Reactive Energy is the row heading. This heading is translated if possible.

<span unitsreg="kVARh del-rec"></span></td>

This displays the units that the meter has defined for the named register kVAR del-rec.
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Line # Description

40

49

<td regname="kVARh del-rec"></td>

This displays the instantaneous value of the named register kVARh del-rec.’

instantaneousReadings.initInstantaneousReadings ('sample-readings') ;

Sample-readings is the unique name of the first webpage content name. This HTML code updates all the
webpage’s values.

' Named registers are listed in the Modbus registers map. You can also reference a value by its ION handle using the
following format: <td regname="_0x####"></td>.

Sample setup webpage

You can create custom setup webpages using the sample webpage stored on your meter.
Sample webpages are stored in the documents folder on your meter’s internal SFTP site.
Your meter’'s Modbus register map is available from www.se.com.

If required, your meter’s ION handles document is packaged with the meter firmware file which is
available for download from www.se.com.

Custom setup webpages must be stored on your meter’s internal SFTP site in the web/setup
folder. The custom webpage is viewed by selecting the Setup main menu tab on your meter’s
webpage.

Configuring the HTML code other than where described is an advanced procedure and should
only be performed by those with an advanced understanding of webpages and how your meter
processes them.

Sample webpage setup result

NOTE: The following graphic is representative only. Your meter's webpages may appear different
than shown.

HTML filename

Content pane title

Sub-heading
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Row heading
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Named register value
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Second content pane title
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Sample HTML code for setup webpage content

Content and formatting of a setup webpage is controlled by its HTML code.

Sample setup webpage content

VWoONOOUTDA WNER

SampleSetupPane.html

<div class="content-fit">
<form id="formSampleSettings">

<div class="accordion">

<h3 target="sample-basic">$%localizedString(Basic Settings)#$</h3>
<div id="sample-basic">

<table class="formtable">

<tr>

<th>&nbsp;</th>

<th>&nbsp;</th>

</tr>

<tr>

<td>$%localizedString(Ethernet)#$</td>
<td>&nbsp;</td>

</tr>

<tr class="minor">

<td>$%localizedString(MAC Address)#$</td>

<td regname="MAC Address"></td>

</tr>

<tr class="minor">

<td>$%localizedString(Ethernet Device Name)#$</td>
<td><input name="Ethernet Device Name" type="text" /></td>
</tr>

<tr class="minor">

<td>$%localizedString(IP Address)#$</td>
<td><input name="IP Address" type="text" /></td>
</tr>

</table>

</div>

<h3 target="sample-advanced">$%localizedString(Advanced Settings)#$</h3>
<div id="sample-advanced">

<table class="formtable" id="frameFormatDropdownContainer">

<tr>

<th>&nbsp;</th>

<th>&nbsp;</th>

</tr>

<tr>

<td>$%localizedString(TCP Keep Alive Minutes)#$</td>

<td><input type="text" name="TCP Keep Alive Minutes" class="small" /> <span unitsreg="TCP Keep

Alive Minutes"></span></td>

</tr>

<tr>

<td>$%localizedString(Enable Web Server)#$</td>
<td><select name="Enable Web Server"></select> </td>
</tr>

</table>

</div>
</div>

<input type="submit" class="apply" value='$%localizedString(Apply)#$' />
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56 | </form>

57

58

59 | <script type="text/javascript">
60

61 | SetupPane.init('formSampleSettings');

62 | formChangeDetection.initFormChangeDetection('#formSampleSettings', '#dialogFormChanges');
63

64 </script>

65| </div>

Sample setup webpage content description

Line # Description

SampleSetupPane.html

1 The HTML filename, including the HTML extension (.html). This filename must comply with SFTP
filename requirements (no spaces or special characters). The filename (without the HTML extension) is
the name shown on the webpage menu.

<form id="formSampleSettings">
“formSampleSettings” is the name of the webpage content. This name must be unique
<h3 target="sample-basic">

This creates the first webpage content pane. “sample-basic” is the name of the webpage content. This
7 name must be unique.

$%localizedString (Basic Settings) #$</h3>
Basic Settings is the title of the webpage content pane. This title is translated if possible.

<div id="sample-basic">

° This must match the name of the webpage contentin line 7.
<td>$%$localizedString (Ethernet) #$</td>

1 Ethernet is the subheading. This heading is translated if possible.
<td>$%localizedString (MAC Address) #$</td>

"9 MAC Address is the row heading. This heading is translated if possible.
<td regname="MAC Address"></td>

20 This displays the value of the read-only named register MAC Address.

- <td>$%localizedString (Ethernet Device Name) #$</td>

Ethernet Device Name is the row heading. This heading is translated if possible.
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Line # Description

<td><input name="Ethernet Device Name" type="text" /></td>

This displays the instantaneous value of the configurable named register Ethernet Device Name in a

24 text-edit field.
The type must match the named register type, in this case, an alphanumeric string.
<td>$%$localizedString (IP Address) #$</td>

27 IP Address is the row heading. This heading is translated if possible.
<td><input name="IP Address" type="text" /></td>

28 This displays the instantaneous value of the configurable named register IP Address in a text-edit field.

The type must match the named register type, in this case, an alphanumeric string.
<h3 target="sample-advanced">

This creates the second webpage content pane. Sample-advanced is the name of the webpage content.
34 This name must be unique.

$%$localizedString (Advanced Settings) #$</h3>

Advanced Settings is the title of the webpage content pane. This title is translated if possible.

<div id="sample-advanced">
% This must match the name of the webpage content in line 34.

<td>$%$localizedString (TCP Keep Alive Minutes) #$</td>
2 TCP Keep Alive Minutes is the row heading. This heading is translated if possible.

<td><input type="text" name="TCP Keep Alive Minutes" class="small" />

This displays the instantaneous value of the configurable named register TCP Keep Alive Minutes in a
text-edit field.

43 The type must match the named register type, in this case, an alphanumeric string.
<span unitsreg="TCP Keep Alive Minutes"></span></td>
This displays the units that the meter has defined for the named register TCP Keep Alive Minutes.
NOTE: There are no defined units for TCP Keep Alive Minutes, so no units are displayed.
<td>$%$localizedString (Enable Web Server) #$</td>

“° Enable Web Server is the row heading. This heading is translated if possible.

<td><select name="Enable Web Server"></select> </td>

Enable Web Server is the named register that is displayed. Named registers are listed in the meter’'s
47 registers map.

The type must match the named register type, in this case, an enumerated value that is displayed as a
drop-down list box.
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Line # Description

SetupPane.init ('formSampleSettings') ;

61
This must match the webpage content name from line 4.
formChangeDetection.initFormChangeDetection ('#formSampleSettings',
'#dialogFormChanges"') ;

62

This must match the webpage content name from line 4. This HTML code updates all the webpage’s
values.
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Display
Display overview
The display allows you to view meter data and perform basic configuration.

NOTE: The display backlight dims after a defined period of inactivity. When the meter detects an
unacknowledged active high priority alarm, the display flashes until the alarm is acknowledged.

Display
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A Display port K Home button

Optional 24 V DC AUX power input (label
B . L  Power/status LED, green orred
not pictured)

Date and time Alarm LED, red

Mode indicator VAR visible energy pulsing LED, orange

Revenue lock icon VAR infrared energy pulsing LED, 940 nm

Alarm icon Watt visible energy pulsing LED, orange

Touch-screen display Watt infrared energy pulsing LED, 940 nm

T O|M{Mm[{O|O

USB ports cover ANSI optical port

w|xm|IO|T|O|Z|Z

USB host port (Type A) IEC optical port adapter (optional)

J  USB device port (Mini-B)

Mode indicator

The display mode indicator identifies whether the meter is in normal (NORM), alternate display
(ALT) or test (TEST) mode.

7EN02-0390-08 Public 167



Display PowerLogic™ ION9000 series - User manual

Home button
Press the Home button to access display menus or return to the active menu.

Press the Home button twice to access the last data screen displayed or the Summary screen, if
in ALT mode.

The function of the home button varies:
* NORM mode: Displays Energy and Demand screens.

* ALT mode: Displays ALT mode display and setup menus. Select Normal Display Mode from
the ALT display menu to exit the ALT display mode.

* TEST mode: Displays Test mode and Setup menus.

* Setup Menu: Displays active menu item.

Revenue lock icon

The revenue lock icon indicates the lock status of the meter.

When gray and open, the meter is unlocked. When green and closed, the meter is locked. You
can lock and unlock your meter using the revenue lock switch located on the body of your meter.

Alarm icon

The alarm icon indicates the highest level and state of alarms detected by your meter.

For example, if the meter detects a low priority and a high priority active alarm, the alarm icon
indicates a high priority active alarm.

NOTE: Alarms can only be viewed and acknowledged through the display.

Icon Description

Active alarm indicator:
* Red: high priority alarm state detected
* Yellow: medium priority alarm state detected
* Blue: low priority alarm state detected
gy
‘ The alarm indicator flashes until you acknowledge the alarm.
The alarm indicator changes to the historic alarm indicator of the appropriate

level when the alarm state is no longer detected by the meter.

NOTE: The display backlight flashes for unacknowledged high priority active
alarms.
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Icon

Description

Q

Unacknowledged historic alarm indicator:
* Red: unacknowledged high priority historic alarm

* Yellow: unacknowledged medium priority historic alarm
NOTE: Low priority historical alarms are not indicated.

The active alarm indicator changes to the historic alarm indicator of the
appropriate level when the alarm state is no longer detected by the meter.

Gray: no active or unacknowledged high or medium priority historic alarms

Alarm and status LED indicators

Your meter has alarm and status LEDs.

These LEDs cannot be configured for other uses.

LED

Description

Status

Off: unpowered

Steady green: normal operation

Flashing red: no communications (remote display only)
Steady red: firmware upgrade required (remote display only)

Flashing red/green: startup or firmware upgrade sequence in progress

Alarm

Off: no active or unacknowledged historic alarms
On: acknowledged active alarm

Flashing: active alarm

NOTE: The display backlight flashes for unacknowledged high priority active
alarms.

Display icons

Icons are displayed on the bottom of the screen.

NOTE: If the icon is gray, the function is not available.

Icon

Description

+

Tap More to access additional screens.

Tap Left arrow to select item to the left or to return to the previous screen.

Tap Right arrow to select item to the right.

<
>
A

Tap Up to navigate menu items or screens.
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Icon Description

v Tap Down to navigate menu items or screens.

o Tap Select to confirm selection or change.

9 Tap Cancel to exit and return to previous screen.

[t Tap Graphic to view graphical representation of data.
888 Tap Numeric to view numerical representation of data.

Tap Info to display screen details.

Tap Edit to enter parameter values or select setting.

N & @

Tap Check Box to perform an action.

s‘ > Tap double-arrow to select parameter.

More screens access

You can access additional screens.

Pressing the More icon opens a list of additional screens related to the active screen. Press
Cancel to close the list. If you do not select a screen, you are returned to the last data screen
displayed.

Overrange indication

If any value measured by the meter is too large to fit on the display, the meter initially reduces the
size of the text to try and make the value fit.

If the value is still too large to be displayed, the meter truncates the value starting with the least
significant digit and encloses the truncated value in a red box.

Interrupted display data

The meter updates the display data every second during normal operation.

If the display detects a data interruption, the following occurs:

Date/time information is cleared.

Display mode indicator is set to normal (NORM) mode.

Revenue lock icon indicates a locked state (green and closed).

Alarm icon indicates an unacknowledged high priority historic alarm (red outline bell).

All parameter labels and associated parameter data are cleared.

Display screen title bar and display icons are retained.
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Auto-scaling feature

Measurement units on the meter display and webpages automatically scale, depending on the
value of PT Primary and CT Primary.

Voltage units are scaled based on the PT Primary value:

PT Primary value Units or scaling
<1000 \
1000-999,999 kv

Current units are scaled based on the CT Primary value:

CT Primary value Units or scaling
<1000 A
1000—999,999 kA

Power units are scaled according to the value of (CT Primary x PT Primary x 3):

(CT Primary x PT Primary x 3) value Units or scaling
< 1,000,000 kW, kVAR or kVA
1,000,000-999,999,999 MW, MVAR or MVA
21,000,000,000 GW, GVAR or GVA

Display screens

Display modes
Your meter has three display modes and provides access to your meter’s setup screens:

* Normal Mode Screens (NORM) — In Norm mode, your meter automatically scrolls through a
series of customizable display screens. You can add or remove Norm mode display screens.
If there are no Norm mode display screens, the meter displays a message stating that there
are no available screens. To exit Norm mode, press the home button to access the display
modes selection screen.

* Alt Display Mode (ALT) - In Alt mode, you can navigate to view the different alternate
screens. You cannot modify the default Alt mode display screens, but you can add custom
screens. To exit Alt display mode, select Normal Display Mode to access the display modes
selection screen.

* Test Mode (TEST) — In Test mode, you can manually scroll through a series of default

screens. To exit Test mode, press the home button and select Exit Test Mode.

NOTE: In Test mode, your meter’s billing quantities stop accumulating and the data is sent to
special test mode registers. These registers are cleared when you exit Test mode.

Access your meter’s setup screens by pressing the home button in NORM, ALT or TEST mode.
To exit the setup screens, press the home button.
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Norm mode display menu

The Norm mode display screens show measured and calculated information about the power
system being monitored.

NOTE: Your meter's menus may appear slightly different than shown depending on your display
settings.

Mormal Mode Screens Active Enargy

Reaclive Energy

Apparent Energy
Peak Demand Delverad
Peak Demand Reset Count

Alt mode display menu

The alt mode display menu allows you to view data screens and access the setup menu.

Alt mode data display screens

Your meter’s default display screens show measured and calculated information about the power
system being monitored.

NOTE: Minimum, maximum (peak), average and time of use (TOU) values are typically accessed
by pressing More to open a list of additional screens.

Menu Submenu Content
Summary Summary Power system summary
Alarms Active alarms, Active alarms can be viewed and acknowledged.

Historical alarms Historical alarms can be viewed and acknowledged.

Basicreadings Voltage * Power system voltage (line-to-line or line-to-neutral),
current and frequency values.
Current
* Average, minimum, and maximum values are also
Frequency provided.
Power Power summary Per-phase and total kW, kVAR and kVA values, along with
minimum and maximum values.
Demand Delivered and received demand values including peak
demand.
Power factor Per-phase and total power factor along with minimum and

maximum values.
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Menu Submenu Content
Energy Energy Energy delivered-received, delivered and received.
Events Events Meter event log entries listing and details.

Power quality = EN50160

EN50160 values.

Harmonics

Voltage and current harmonics, with individual and total
harmonic values.

Phasors

Phasor diagram with magnitude and angle values.

Inputs/outputs  Digital inputs

Digital outputs

Analog inputs

Analog outputs

Digital and analog I/O values and counts.

Nameplate Nameplate

Owner and tag information, meter model, and serial
number.

Meter feature set, firmware version, and firmware
CRC.

RMD serial number and firmware version.

Meter volts mode, meter nominals (voltage, current,
and frequency), and PT/CT ratio.

Demand configuration values.

Regulation tag.

Custom —
screens

Custom screens

Setup Menu —

Access to the setup menu screens.

Setup menu

Meter configuration can be performed through the display.

Configure your meter’s security settings to allow front panel (display) programming to set up the

meter using the display.

NOTE: Your display may appear differently than shown, depending on your meter’'s power
system, configuration, and display settings.

NOTE: Some setup parameters cannot be configured when revenue security is enabled.
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Menu Submenu

Meter Setup Volts Mode
PT/CT Setup
Voltage Polarity Setup
Current Polarity Setup

Nominal Values

Ethernet Port Enable Setup Ethernet Port Enable Setup

Communications Setup IPv4 Assignment Mode Setup
Stored IPv4 Address Setup
IPv6 Link Local Address

IPv6 Assignment Mode Setup
Stored IPv6 Global Address

Ethernet Device Name
DNS Setup

COM1 Setup

COM4 Setup

NTP Address

SMTP Address

Display Setup Screen Setup
Label & Symbol Setup

Numeric Format Setup

Date/Time/Clock Setup Date & Time Setup
Clock Setup

Alarm Setup Alarm Setup

Language Setup Language Setup

Time of Use Setup TOU Active Rates
TOU Season

Resets Resets

Meter setup using your display

Navigate to Setup screens and enter parameters to configure your meter.

Your meter’s default display password is 0 (zero).

NOTE: Your meter locks you out of display configuration after you have exceeded the maximum
number of attempts to enter a password.

The following example shows how to use the navigation icons to select parameters, enter numeric
information or select parameter values from lists.
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NOTE: Your display may appear differently than those shown, depending on your meter’s power
system and display and localization settings.

Example: Setting volts mode and PT/CT ratios
Use the display navigation icons to set your meter’s volts mode and PT ratios.

NOTE: Potential transformers (PT) are also known as voltage transformers (VT).

v

the Setup Menu. The Setup Menu lists the setup selections on your meter.

1. Press @to display the menu. Press until Setup Menu is highlighted. Presso to display

[ & Mameplate
%, Custormn Scraens
H Setup Menu

P L e -]

¥ E1.I'.;2r'.r.r|::1.r’n:rt Enablz Schup
» COEnmmumGaions Selup
¥ Display Setup

£l F g L

2. PressA or v to highlight the different setup menu selections. Highlight Meter Setup and

presso to select the meter setup screens. The Volts Mode setup screen is displayed.

s
3. Press ™ to highlight Volts Mode. Press @ to edit the volts mode. The Enter Password
screen is displayed.

Voits Mas DEMO
Fhasetider SBC
i Py W | =R

4. Press A to change the value of the highlighted digit (0 - 9). Press < to go to the next digit.

Press o to enter your password using the onscreen keyboard. The Volts Mode
configuration screen is displayed.

Enter Passimtd

0000000
e € Al ©
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. PressA or v to highlight the desired volts mode from the list, in this case, 3W-WYE.
Press 0 to select the highlighted volts mode. A confirmation screen is displayed, showing
your meter’s previous setting and newly selected setting.

Volle Mode
a | A v | O
. Press 0 to confirm, and the new setting is applied to your meter. Press @ to cancel and
maintain your meter’s original setting.
QN 3-.-.'.1.-;~.-E
fzrept change'*
& L]

. Inthe Volts Mode screen, press v to go to the PT/CT Setup screen.

. Inthe PT/CT Setup screen, press ‘ , to highlight the potential transformer (PT) or
current transformer (CT) value for editing. Press @ to edit the highlighted value.

NOTE: If you have exceeded the password timeout period, you are prompted to enter your
meter’s display password.
PT/CT Setup
Primary Secondary

PT 120.00 120.00

CT [ 5.000 | 5.000

14CT 5.000 5.000

<> A v | @

. Press A to change the value of the highlighted digit (0 - 9). Press ( to go to the next digit.
Press 0 to enter the new value. When the confirmation screen is displayed, press 0 to
confirm the new value or @ to revert to the original value.

Display setup

You can configure basic display parameters using the display.
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Screen setup

Parameter  Values Description

Backlight 07200 Specifies how many seconds the display’s backlight
Timeout remains lit after the last button press

Label and symbol setup

Parameter Values Description

Phase Lbls ABC, 123 Sets the voltage and current phase labels
Measurement IEEE. IEC Specifies whether IEEE or IEC measurement
Symbols ' symbols are applied to displayed values

Specifies whether IEEE or IEC power factor

PF Convention IEEE, IEC ) , ,
conventions are applied to displayed values

Numeric format setup

Parameter Values Description

Digit Grouping  1000.0, 1,000.0, 1 000,0 Specifies how digits are grouped for display

Volts 1., 1.X, 1.XX, 1.XXX, Specifies the number of decimal places displayed
Resolution 1. XXXX for voltages

Current 1., 1.X, 1.XX,1.XXX, Specifies the number of decimal places displayed
Resolution 1.XXXX for currents

Power 1., 1.X, 1.XX, 1.XXX, Specifies the number of decimal places displayed
Resolution 1. XXXX for power and energy measurements

Language setup
Set your meter display to one of the following languages:
* English (default)
* Spanish
* French
* Russian
* German
* ltalian
* Portuguese
* Chinese (simplified)
Creating custom displays using ION Setup
Use ION Setup to create new custom displays.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Click Displays > Front Panel.
4. Select Displays and click Edit.

ION Setup loads your meter’s display information into the Display Editor screen.

5. Select the display mode of the custom screens from the drop-down list box, and rename,
delete, or change the order of custom displays.

a. Click New to add a new display screen in the selected display mode.

b. Click Edit to open the Display setup screen, where you can configure new or existing
custom displays.

6. Configure your screen.

— Screen Type: Specify the number of parameters displayed on the screen.
— Screen Title: Enter the title to be shown at the top of your custom display.
7. Click Edit to select the displayed parameters.

The number of parameters displayed is determined in the Screen Type selection described
above.

8. Select your digit display properties.

— Resolution: Specifies the number of decimal places displayed.
— Last Digit: Specifies if the last digit is rounded or truncated.

9. Click Send to save the changes in the meter.

Display units scaling

You can customize the units for metered values shown on the display and webpages.

You can configure the units for voltage, current, power and energy values shown on the display
and webpages from their default units, and you can set the resolution for the display. To identify
which values will have the modified units, refer to the display and web units information in your
meter's Modbus map, available from www.se.com.

Configuring display units scaling using ION Setup

You can customize the units for metered values shown on the display and webpages using ION
Setup.

Configuring display units scaling is an advanced procedure that requires in-depth knowledge of
your meter, its underlying architecture, and the system in which it is installed.

To identify which values will have the modified units, refer to the display and web units information

in your meter's Modbus map, available from www.se.com.

NOTE: Custom units and resolution settings are automatically adjusted for current and voltage
values to help prevent the display from showing incorrect zero values.

1. Start ION Setup.
2. Connect to your meter in advanced mode.

3. Navigate to the Display Options Modules folder and double-click on the module in the right-
hand pane.
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The Display Options screen is displayed.
4. Selectthe Setup Registers tab.

5. Select the display units you want to configure: Voltage Units, Current Units, Power Units or
Energy Units. Click Edit.

A unit selection screen is displayed.
6. Select the desired units from the drop-down list, and then click OK.

7. When you have finished configuring the display units, click Send to send your changes to
the meter and close the Display Options screen.

For more information on the Display Options module and your meter’s ION architecture, see ION
Reference, available on www.se.com.

Remote display troubleshooting icons

The remote display shows troubleshooting icons in addition to the meter’s status LED information.

Icon Description
=[]
wll The display is connecting to your meter.
The display cannot communicate to your meter. Check the connection
9 between your meter and the display. Check the meter’s status LED to
confirm that the meter is operating normally.
o The display needs updated firmware for compatibility with your meter.
{!,_ The display is downloading a firmware upgrade. Do not disconnect the
— display from your meter.
e The display is undergoing a firmware upgrade. Do not disconnect the
~ display from your meter.
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Alarms and alerts

Alarms

Alarm types

An alarm is the meter's means of notifying you when an alarm condition is detected, such as an
error or an event that falls outside of normal operating conditions. Alarms are typically setpoint-
driven and can be programmed to monitor certain behaviors, events, or unwanted conditions in
your electrical system.

You can configure your meter to generate and display high, medium, and low priority alarms when
predefined events are detected in the meter's measured values or operating states. Your meter
also logs the alarm event information.

The meter ships with some alarms already enabled from the factory. Other alarms need to be
configured before the meter can generate alarms.

Customize meter alarms as required, such as changing the priority. You can also create custom
alarms using the advanced features of your meter.

Your meter has five types of alarms:

Alarm type Description

Setpoint alarms compare the actual value of a parameter to a specified limit
or range of values. These include measured voltage and current values and

Setpoint calculated power quality values.

(standard)
Some setpoint alarms use high-speed measurements for up to 1 millisecond
resolution.

Digital Digital alarms are triggered on a digital input’s on/off state.

Disturbance , .
Disturbance alarms are triggered on a measured sag or swell.

(sag/swell)
Transient Transient alarms are triggered on a measured transient event.
Unary Unary alarms are not configurable and generate an alarm based on the

meter’s state, for example, the meter powering up.

Alarms have two states:

Alarm state Description

Active The meter detects the alarm condition is met.

The alarm condition previously existed but the condition has since returned
to a non-alarm state.

Historical

For more information on Setpoint, Relative Setpoint, Digital Input, Disturbance Analyzer,
Transient, High-Speed Transient (ION900OT only), and Sag/Swell modules, see /ON Reference,
available on www.se.com.
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Standard and high-speed alarms

Alarm speed is determined by the update rate of the framework for the particular alarm.

Standard alarm

Standard alarms have a detection rate of once every one second.

High-speed alarm

High-speed alarms have a detection rate of once every half-cycle.

3-phase alarms
Alarms on 3-phase systems are evaluated per phase and reported for each phase.

Some alarms, such as the sag/swell alarm, are evaluated per phase, but reported as a single
alarm: Each of the three phases are evaluated for the setpoint condition individually, but there is
only one alarm generated. The alarm pickup occurs when the first phase exceeds the alarm
pickup magnitude for the pickup time delay. The alarm is active as long as any phase remains in
an alarm state. The alarm dropout occurs when the last phase drops below the dropout
magnitude for the dropout time delay.

Over and under setpoint (standard) alarm operation - Example
The meter supports over and under setpoint conditions on standard alarms.

A setpoint condition occurs when the magnitude of the signal being monitored crosses the limit
specified by the pickup setpoint setting and stays within that limit for a minimum time period
specified by the pickup time delay setting.

The setpoint condition ends when the magnitude of the signal being monitored crosses the limit
specified by dropout setpoint setting and stays within that limit for a minimum time period
specified by dropout time delay setting.

Over setpoint

When the value rises above the pickup setpoint setting and remains there long enough to satisfy
the pickup time delay period (AT1), the alarm condition is set to ON. When the value falls below
the dropout setpoint setting and remains there long enough to satisfy the dropout time delay
period (AT2), the alarm condition is set to OFF.
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Max2

- AT3 § >

EV1 ' Ev2

A Pickup setpoint

B Dropout setpoint

ATA1 Pickup time delay period (in seconds)

EV1 Start of alarm condition

AT2 Dropout time delay (in seconds)

EV2 End of alarm condition

AT3 Alarm duration (in seconds)

Max1  Maximum value recorded during pickup period

Max2 Maximum value recorded during alarm period

The meter records the date and time when the alarm event starts (EV1) and when it ends (EV2).
The meter also performs any task assigned to the event, such as operating a digital output. The
meter also records maximum values (Max1, Max2) before, during or after the alarm period.

Under setpoint

When the value falls below the pickup setpoint setting and remains there long enough to satisfy
the pickup time delay period (AT1), the alarm condition is set to ON. When the value rises above
the dropout setpoint setting and remains there long enough to satisfy the dropout time delay
period (AT2), the alarm condition is set to OFF.
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- T3 ————————

Min2

BV ' EvV2

A Pickup setpoint

B Dropout setpoint

ATA1 Pickup time delay period (in seconds)

EV1 Start of alarm condition

AT2  Dropout time delay (in seconds)

EV2 End of alarm condition

AT3  Alarm duration (in seconds)

Min1  Minimum value recorded during pickup period

Min2  Minimum value recorded during alarm period

The meter records the date and time when the alarm event starts (EV1) and when it ends (EV2).
The meter also performs any task assigned to the event, such as operating a digital output. The
meter also records minimum values (Min1, Min2) before, during or after the alarm period.

Relative setpoint

The meter’s Relative Setpoint modules behave similarly to the Setpoint modules, except the
pickup and dropout levels are set relative to the Nominal input source.

For more information on Relative Setpoint modules, see /ION Reference, available on
www.se.com.

Sag/swell alarms

Your meter monitors your power system’s voltage and current for sags and swells.

When sag/swell limits are defined and alarming is enabled, the meter reports the disturbance’s
magnitude and duration, and logs data and waveform records associated with the disturbance.

You must configure nominal voltage and current for these alarms to function.
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You can manually enter the limits (criteria) used by the meter to identify a sag or swell, or you can
have your meter learn sag/swell limits by monitoring your power system.

For more information on the Sag/Swell and Disturbance Analyzer modules, see ION Reference,
available on www.se.com.

Digital alarms

These alarms are triggered when the associated digital input changes state.

You can configure the alarm to be active when the digital input is on or off, depending on the
alarm’s purpose.

For example, if you used a digital input to monitor a breaker that is always supposed to be on, you
would set the alarm to be active when the breaker has tripped.

NOTE: To stop a digital alarm from being displayed, set the alarm priority to Info Only. Disabling
the digital alarm will disable all alarming functions of the associated digital input.

For more information on the Digital Input module, see ION Reference, available on www.se.com.

Transient alarms

Transient alarms are triggered by voltage transient activity (for example, ITI CBEMA Type 1
disturbances).

You must configure nominal voltage for these alarms to function.

The Threshold setup register in the Transient module defines what voltage disturbance
magnitude should be considered as transient activity. Threshold is interpreted as a percentage of
the nominal system voltage, plus 100. For example, if you want transients recorded when voltage
deviates from nominal by 20%, enter 120 into the Threshold setup register.

For more information, see "Transients" on page 202.
For more information on the Transient module, see /ION Reference, available on www.se.com.

Alarm event priorities

Your meter’s alarm priorities correspond to event priority ranges.

Alarm priority Event priority
High (red) 192-255
Medium (yellow) 128—-191

Low (blue) 64-127

Info Only (no alarm)* 1-63

None (no alarm or event)* 0

* Alarms with priority of Info Only or None are not indicated or displayed.

Info Only and None event priority

Alarms with a priority of Info Only or None are not shown on the meter’s display, and do not
function as alarms. If the alarm’s priority is set to Info Only, and the event priority is greater than
the event log cutoff value, the associated event is recorded in the meter’'s event log. If the alarm’s
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priority is set to None, the event priority is automatically set to zero, and no associated event is

logged in the meter’s event log.

For events that you want to log for future reference or troubleshooting, but don’t want alarm
functions, set the alarm priority to Info Only.

For nuisance events that frequently occur, and you have no desire to log for reference or
troubleshooting, set the alarm priority to None.

Alarm indicators

Your meter’s display has an alarm indicator to show you what alarm levels have been detected
(active or historic) and whether they have been acknowledged.

For active high priority alarms, the display will also flash until the alarm is acknowledged. There is

also an alarm LED to indicate the meter’s alarm condition.

Alarm Alarm icon
Active high Red solid bell
Yell lid
Active medium CHoW SOl
bell
Active low Blue solid bell
Historic high Red outline
e bell
. . . Yellow outline
Historic medium
bell
Historic low Gray solid bell
No active or
unacknowledged  Gray solid bell
alarms

Alarm icon flash Alarm LED

Flash if not
acknowledged

Flash if not
acknowledged

Flash if not
acknowledged

Flash if not
acknowledged

Flash if not
acknowledged

No flash

No flash

Off

Off

Flash if not
acknowledged

Steady if
acknowledged

Flash if not
acknowledged

Steady if
acknowledged

Flash if not
acknowledged

Steady if
acknowledged

Flash if not
acknowledged

Steady if
acknowledged

Flash if not
acknowledged

Steady if
acknowledged

Display

Flash if not
acknowledged

No flash

No flash

No flash

No flash

No flash

No flash

If there are multiple active alarms, the alarm condition associated with the highest priority is
displayed. If there are multiple unacknowledged historic alarms, the meter displays the alarm

condition associated with the highest priority unacknowledged historic alarm.
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NOTE: To stop an alarm from being displayed without impacting other metering features, set the
alarm priority to Info Only.

Default alarms

Your meter comes with default alarms. Some alarms are enabled by default.

NOTE: Some alarms require configuration to operate.

Name Priority Description Default

Current Sag Ph1 -3 High Current sag alarms for phase 1,2, 3 Disabled
Current SwellPh1-3  High g”rre"t swellalarms forphase 1,2, 1 bled
Sag/Swell High Voltage sag/swell alarm Disabled
Over | unbal Medium Over unbalanced current alarm Disabled
Over V unbal Medium Over unbalanced voltage alarm Disabled

. Over total harmonic distortion
Over THD V1 -3 Medium Enabled
(THD) voltage alarms

Over kW (P) sd Medium Over kW sliding demand alarm Disabled
Overla-c,(1-3)4 Medium Over current alarms Disabled
V1 - V3 Setpoint Medium Voltage setpoint alarms Disabled
Freq Setpoint Medium Frequency setpoint alarm Enabled

4-30 voltage interruption power
4-30 VoltIntrp Ph1-3  Low . Enabled
quality alarms

Transient/Waveshape High Transient alarm Disabled
High-speed Transient High High-speed transient alarm Disabled
(ION90OOT only) g gh-sp
Digital input alarms
Number of alarms determined by
Digital In Info Only the total number of available digital S
inputs
Note: Info Only alarms are not
displayed.

Alarm information

You can view information about an alarm from your meter’s display.

Only alarms with a priority of low, medium, or high are displayed.
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Parameter Description

Alarm The name of the alarm (for example, Over THD V1).

Priority Low, medium, or high alarm priority.

Date The date and time the alarm was triggered.

Duration The duration of the alarm (only applies to inactive alarms).

Ack The date and time when the alarm was acknowledged (only applies to

acknowledged alarms).

Active alarm: The minimum or maximum value detected when the alarm was

triggered.
Value
Historic alarm: The minimum or maximum value detected during the duration

of the alarm.

Viewing and acknowledging alarms using the display

To view and acknowledge alarms using the display:
1. Press the Home button on the display.
2. Press Alarms > Active Alarms or Historical Alarms.
3. Press Select.
4. Press the up or down icons to navigate alarms. A gray bar appears behind the active
selection.

NOTE: You can press Info to display alarm details.

5. To acknowledge alarms press Acknowledge All.

Alarm configuration

Topics in this section:

Alarm setup using the display

You can enable and disable alarms through the display.

A& WARNING

INACCURATE DATA RESULTS

» Do not use data displayed on the display or in software as a substitute for proper workplace
practices or equipment maintenance.

» Confirm your alarm is properly configured.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Default alarms available on the display
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Parameter* Description

Over | unbal

Over THD V1
Over THD V2
Over THD V3
Over kW sd

Over la

Over b

Over Ic

Over 14

Over V unbal

V1 Setpoint

V2 Setpoint

V3 Setpoint

Freq Setpoint
Sag/Swell 1
Current Sag Ph1**
Current Sag Ph2**
Current Sag Ph3**

4-30 Volt Intrp Ph1

4-30 Volt Intrp Ph2

4-30 Volt Intrp Ph3

Current Swell Ph1**
Current Swell Ph2**
Current Swell Ph3**

HSTC 1 (ION900OT
only)

Over unbalanced current alarm

V1 over total harmonic distortion (THD) voltage alarm
V2 over total harmonic distortion (THD) voltage alarm
V3 over total harmonic distortion (THD) voltage alarm
Over kW sliding demand alarm

la over current alarm

Ib over current alarm

Ic over current alarm

I4 over current alarm

Over unbalanced voltage alarm

V1 setpoint alarm

V2 setpoint alarm

V3 setpoint alarm

Frequency setpoint alarm

Voltage sag/swell alarm

Current sag alarms for phase 1

Current sag alarms for phase 2

Current sag alarms for phase 3

4-30 voltage interruption power quality alarm for phase
1

4-30 voltage interruption power quality alarm for phase
2

4-30 voltage interruption power quality alarm for phase
3

Current swell alarms for phase 1
Current swell alarms for phase 2

Current swell alarms for phase 3

High-speed transient alarm

* Any Setpoint or Relative Setpoint module with an event priority greater than or equal to the Low
alarm event priority is also displayed on this screen.

** Enabling or disabling one phase for each alarm type will enable or disable all phases for that

type.

NOTE: Configuring alarms must be done using ION Setup.
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Alarms with a priority less than Low (Info Only or None) are not displayed.

You must configure all the parameters related to the alarm for alarm functions to operate. For
example, for the Over la alarm to operate, you must enter the nominal value and the conditions
that define an alarm state, even if the alarm is shown as Enabled on the Alarm Setup screen.

Disabling and enabling alarms using the display

Disable alarms using the display when you are performing maintenance tasks on your system and
want to prevent nuisance alarms.

NOTE: To stop an alarm from being displayed without impacting other metering features, set the
alarm priority to Info Only.

To disable alarms using the display:

1.

o M @D

© © ®o N o

Press the Home button on the display.
Press Setup Menu > Alarm Setup.
Press Select.

Press Edit. Enter your meter’s password, if prompted.

Press the up or down icons to navigate alarms. A gray bar appears behind the active

selection.

To select the item(s) press Select for Enable/Disable.
Press Select to accept the change.

Press Select to confirm.

Complete the system maintenance tasks.

Enable the alarms you disabled.

Configuring setpoint/standard alarms using ION Setup

To configure standard alarm settings using ION Setup:

1.

2
3
4.
5

Start ION Setup.

. Open the Setup Assistant for your meter.

. Click Alarming > Standard.

Select a setpoint and click Edit.

Enter the password and click OK, if required.
The Setpoint Setup screen is displayed.
Configure the setpoint values as required.

Click Save to save the settings to your meter.

7EN02-0390-08

Public

189



Alarms and alerts PowerLogic™ ION9000 series - User manual

Parameter Value/Range Description

When available, specifies if the Pickup and
By Percentage/By Dropoff entries are by percentage or by value. If
Value the option is not available, pickup and dropoff
entries are by value.

By Percentage

Forcing the alarm off disables all functions of the
associated input.

Disabled/Enabled  Checked/Unchecked  To stop an alarm from being displayed without
affecting other meter features, set the alarm
priority to Info Only.

When available, lets you modify the default label
Label String value so it more clearly identifies the alarm. Letters,
numbers, and underscores are permitted.

Use this setting to provide a value for when the

Pickup Numeric value
alarm turns on.
This specifies the number of seconds the input
Pickup Delay Numeric value must be over the alarm pickup value before the
alarm turns on.
: Use this setting to provide a value for when the
Dropout Numeric value

alarm turns off.

This specifies the number of seconds the input
Dropout Delay Numeric value must be below the alarm dropoff value before the
alarm turns off.

Specifies the priority level of the standard alarm.
. None, Info Only, Low, o
Alarm Priority Medium or Hiah When priority is set to Info Only, the alarm does
e not appear on the display.

Select custom priority to view and configure the
event priority of the event associated with the

Custom Priority 0-255 alarm. The event log cutoff value is displayed for
reference; priorities above the cutoff are stored in
the meter’s event log.

Sag/swell overview

Your meter monitors your power system’s voltage and current for sags and swells (INCITS
(CBEMA) Type 2 and Type 3 disturbances).

When sag/swell limits are defined and alarming is enabled, the meter reports the disturbance’s
magnitude and duration, and logs data and waveform records associated with the disturbance.

You can manually enter the limits (criteria) used by the meter to identify a sag or swell, or you can
have your meter learn sag/swell limits by monitoring your power system.
Configuring sag/swell alarms using ION Setup

To configure sag/swell alarm settings using ION Setup:
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1. Start ION Setup.
Open the Setup Assistant for your meter.

Click Alarming > Sag/Swell.

P DN

Select the parameter you want to configure and click Edit.

The setup dialog box for that parameter appears.

5. Configure the parameters as required.

The values you need to set vary depending on the type of sag/swell alarm you are

configuring.

Voltage sag/swell setup parameters

Parameter Value/Range Description
. Enabled or . . L
Enable/Disable Disabled Specifies if sag/swell recording and alarming is enabled.

The primary RMS voltage for the power system. Use the
line-to-line voltage for a Delta configured device and line-
Nominal 1-999,999 to-neutral voltage for a Wye configured device.

For more information on configuring Volts Mode, see
"Configuring metering parameters" on page 71.

Percentage of Specifies the swell limit expressed as a percentage of the

Swell Limit : )
nominal nominal voltage.
Saq Limit Percentage of Specifies the sag limit expressed as a percentage of the
: nominal nominal voltage.
Specifies the difference in magnitude between the sag or
swell limit and the threshold for the power quality event to
be considered over.
) Percentage —
Hysteresis For example, if the meter has the sag limit set to 90% of

see description
nominal and the hysteresis is set to 2%, this means that in

a sag event, the voltage needs to return to 92% of nominal
for the sag event to be considered over

Select the alarm priority you want to associate with

Al iorit See Sag/Swell alarms.
arm priority o
description To stop an alarm from being displayed without affecting

other meter features, set the alarm priority to Info Only.

Current sag/swell setup parameters

Parameter Value/Range Description
) Enabled or e . .
Enable/Disable . Specifies if sag/swell recording and alarming is enabled.
Disabled
Specifies the nominal current value used for current sag or
Nominal 1-999,999 2 _ -
current swell detection.

7EN02-0390-08

Public 191



Alarms and alerts

PowerLogic™ ION9000 series - User manual

Parameter Value/Range Description
Picku Percentage of  Specifies the percentage the current must deviate from the
P nominal nominal current to be classified as a sag or a swell.
Dropout Percentage of  Specifies the percentage of nominal to which the current
. nominal must recover to signal the end of the sag or the swell.

Displays the difference in magnitude between the sag or
swell Pickup and Dropout values.

Hysteresis N/A
To change the hysteresis, change the Pickup or Dropout
values.
Select the alarm priority you want to associate with
Sag/Swell alarms.

Alarm priority See description
To stop an alarm from being displayed without affecting
other meter features, set the alarm priority to Info Only.

Configuring transient alarms using ION Setup
To configure transient alarm settings using ION Setup:
1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Click Alarming > Transient.
4. Select Transient/Waveshape and click Edit.
The setup dialog box for that parameter appears.

5. Configure the parameters as required.

Transient setup parameters

Parameter Value/Range Description
Enabled or Specifies if transient recording and alarming is
Enabled/Disabled P g g
Disabled enabled.
Specifies the nominal voltage value used for transient
Nominal 1-999,999 e 2
detection.
Specifies the threshold expressed as a percentage of
Percentage of the nominal voltage, plus 100.
Threshold .
nominal For example, if you want transients recorded when
voltage deviates from nominal by 20%, enter 120.
Select the alarm priority you want to associate with
Transient alarms.
Alarm priority See description  To stop an alarm from being displayed without
affecting other meter features, set the alarm priority to
Info Only.

192

Public 7EN02-0390-08



PowerLogic™ ION9000 series - User manual

Alarms and alerts

Alerts

Configuring digital input alarms using ION Setup

To configure digital alarm settings using ION Setup:

1. Start ION Setup.

. Open the Setup Assistant for your meter.

2
3. Click Alarming > Digital Input.
4

. Configure the digital input alarm settings by selecting an input and clicking Edit. Some
settings are not configurable and are grayed out.

5. Click Save to save the changes to the meter.

Parameter

Input

Disable/Enable

Label

Alarm Priority

Custom Priority

Value/Range

Input On/Input Off

Checked/Unchecked

String value

None, Info Only, Low,
Medium, or High

0-255

Description
Specifies the input state/alarm behavior:

* Input On: the alarm is on when the digital input
is on.

* Input Off: the alarm is on when the digital input
is off.

Disable or enable the associated alarm.

To stop an alarm from being displayed without
affecting digital input features, set the alarm priority
to Info Only.

When available, lets you modify the default label so
it more clearly identifies the alarm. Letters,
numbers, and underscores are permitted.

Specifies the priority level of the digital input alarm.
To disable the alarm, set priority to Info Only.

Select custom priority to view and configure the
event priority of the event associated with the
alarm. The event log cutoff value is displayed for
reference; event priorities above the cutoff are
stored in the meter’s event log.

An alert is an external naotification from the meter to indicate changes, for example, a change of
state for a digital input, or a power quality event such as a sag or swell.

When an alert condition occurs, a pulse or trigger is sent and generates the alert. You can
configure alerts to send notification emails or messages to your energy management system
through your meter’s existing Ethernet communications connections. You can configure alert
messages as a simple text string or you can also include device information. You can configure
the alert’s priority so that alerts are also recorded in the meter’s event log.

You can configure multiple alerts on a single meter, each having different activation triggers,
messages and/or transmission types. For instance, you can have two alerts, one generating an
email, the other sending a message to your energy management system, but using the same
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trigger conditions; or you can have two alerts with different conditions that send two unique emails
to two different email addresses. You can also generate alerts based on triggers from devices
connected to your meter.

Creating alerts is an advanced feature that requires familiarity with ION architecture and your
power system and communications network. To create an alert, you must configure the Alert
module using a configuration tool. You must also configure your device’s communications as
needed to send the alerts, such as configuring your meter's SMTP settings and connecting it via
Ethernet to an SMTP mail server in order to send an alert by email.

For more information, see the ION Meter Alerts technical note, available on www.se.com.

Setpoint learning

Your meter can learn acceptable ranges or thresholds by monitoring normal operating values to
determine what constitutes a voltage sag, swell or transient to help identify high and low setpoints.

NOTE: To help your meter learn the most accurate values possible, it is important that learning
occur during a period of normal operation. Do not schedule learning during a period of unusual
operations in your system. Do not modify your meter’s configuration during the learning period as
it may stop the learning process.

You can configure the meter so that learned values are applied automatically after the learning
period is complete or require that they are reviewed and manually applied. If a learned value is
invalid, the learned values are not automatically applied, but logged for review.

Setpoint learning can be used to identify the following values:

Feature Values

High limit

Low limit
Setpoints (Alarms)
Sustain until ON

Sustain until OFF

Sag Voltage sag limit
Swell Voltage swell limit
Transient Threshold

Learning installation mode and learning duration

You can configure learning for manual or automatic mode.
There are two learning installation modes:

1. Manual: The meter learns the applicable values but does not begin using the learned
values. The learned values are recorded for review, and you can decide to use the learned
values or adjust them as required before manually implementing the learned values.

2. Automatic: The meter learns the applicable values and begins using those learned values
automatically at the end of the learning period. If a learned value is invalid, the meter does
not apply the value, but the value is recorded in the event log.
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You can configure the maximum learning duration. The actual learning duration may vary,
depending on the stability of the system. If the system is stable for a period equal to one quarter of
the maximum learning duration, learning is complete; otherwise, the learning period will be the

maximum learning duration.

Example: Setpoint learning duration in a stable system

In this example, the learning duration is 30 days. When the system is stable for 7.5 days (one
quarter of 30 days) learning is complete.

115%
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Maximum duration remaining

Stable learming time
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Example: Setpoint learning duration in an unstable system

In this example, the learning duration is 30 days. Because the system is not stable for 7.5 days
(one quarter of the 30 days) learning is complete at the end of the maximum learning duration.
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For more information on Sag/Swell, Setpoint, and Relative Setpoint modules, see ION Reference,

available on www.se.com.

Implementing standard alarm setpoint learning using ION Setup

You can use ION Setup to implement setpoint learning, which analyzes your power system and

recommends settings.
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NOTE: To learn valid setpoint values the meter’s power system must be stable.

To implement setpoint alarm setpoint learning using ION Setup:
1. Start ION Setup.
2. Open the Setup Assistant for your meter.

3. Click Alarming > Standard.

NOTE: You can manually configure setpoint values by selecting the setpoint and clicking
Edit.

4. Selecta setpoint and click Learn.

The Global Setpoint Learning screen is displayed.
5. Select the setpoint tabs to view existing configured or learned setpoint information.
6. Click Setup.

The Alarm Learning Setup screen is displayed.

Setpoint learning parameters

Parameter Value/Range Description
— Automatic: The learned values are automatically
Automatic, applied.
Install mode
Manual — Manual: The learned values are stored for you to
review and enter.
Duration 1-365 Days for maximum learning duration.

7. Configure the learning parameters for each setpoint and click Save.
8. Click Start All to begin setpoint learning for all setpoints. Click Yes to confirm or No to
cancel.
— Learning status and time remaining are indicated in the Learning Status box.

— Click Abort to stop learning for a specific setpoint. To stop all setpoint learning, repeat
for each setpoint tab.

9. Apply the learned setpoint values:

— Automatic: The setpoint values are automatically applied unless the learning process
has issues or the learned values are invalid.

— Manual: Navigate to Alarming > Setpoints, and then click Learn. On each setpoint
tab, click Install to apply the learned values to that setpoint.

NOTE: If you click Install while learning is in progress (in either manual or automatic
installation mode), it stops the learning process and prompts you for confirmation that you
want to stop learning and install the learned values. Once you confirm, the learned values
are automatically installed or prepared for manual installation.
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Implementing sag and swell limit learning using ION Setup

You can use ION Setup to implement voltage sag/swell learning, which analyzes your power
system and recommends settings.

NOTE: Your meter’s power system must be stable to learn valid sag/swell limits.

NOTE: Learning is not supported for Current Swell and Current Sag.

To implement sag/swell limit learning using ION Setup:

1.

Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Sag/Swell.

4. SelectVoltage and click Learn.

NOTE: You can manually configure the limit values by selecting the parameter and clicking
Edit.

The Global Setpoint Learning screen is displayed.
Click Setup.

The Alarm Learning Setup screen is displayed.

Sag/swell limit learning parameters

Parameter Value/Range Description
— Automatic: the learned values are automatically
Automatic, applied.
Install mode
Manual — Manual: the learned values are stored for you to
review and enter.
Duration 1-365 Days for maximum learning duration.

Configure the sag/swell limit learning parameters and click Save.

Click Start to begin sag/swell limit learning.

— Learning status and time remaining are indicated in the Learning Status box.
— Click Abort to stop sag/swell limit learning.

Apply the learned sag/swell limits.

— Automatic: the limits are automatically applied unless there are issues with the learning
process.

— Manual: navigate to Alarming > Sag/Swell. Select Voltage and click Learn. Click
Install to apply the learned limits.

NOTE: If you click Install while learning is in progress (in either manual or automatic
installation mode), it stops the learning process and prompts you for confirmation that you
want to stop learning and install the learned limits. Once you have confirmed, the learned
limits are automatically installed or prepared for manual installation.
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Implementing transient learning using ION Setup

You can use ION Setup to implement voltage transient learning, which analyzes your power
system and recommends settings.

NOTE: Your meter’s power system must be stable to learn valid transient thresholds.

To implement transient learning using ION Setup:
1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Click Alarming > Transient.
4. Select Transient/Waveshape and click Learn.
The Global Setpoint Learning screen is displayed.
5. Click Setup.
The Alarm Learning Setup screen is displayed.
6. Configure the transient threshold learning parameters and click Save.

7. Click Start to begin transient learning.

— Learning status and time remaining are indicated in the Learning Status box.
— Click Abort to stop transient learning.

8. Apply the learned values.

— Automatic: the threshold is automatically applied unless there are issues with the
learning process.

— Manual: Click Alarming > Transient. Select Transient/Waveshape and click Learn.
Click Install to apply the learned values.

NOTE: While learning is in progress (in either manual or automatic installation mode), it
stops the learning process and prompts you for confirmation that you want to stop learning
and install the learned limits. Once you have confirmed, the learned values are automatically
installed or prepared for manual installation.

Transient learning parameters

Parameter Value/Range Description
— Automatic: the learned values are automatically
Automatic, applied.
Install mode
Manual — Manual: the learned values are stored for you to
review and enter.
Duration 1-365 Days for maximum learning duration.
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Power quality

Your meter measures voltage and current harmonics, and calculates several harmonic distortion
values, including K-factor and crest factor.

Configure your meter with the power system’s nominal values for voltage, current, and frequency
for the meter to perform power quality calculations.

Power quality configuration

Use ION Setup to configure sag/swell, transient and advanced power quality logging.

NOTE: For waveform recording to trigger automatically, enter your system’s nominal (normal)
voltage and current values and the amount of deviation from the nominal that is considered a sag
or a swell using the Metering > Basic or Alarming screen

NOTE: Changing your meter’s data logging (including burst data logging) and waveform
recording configuration clears your meter’s existing data logs, waveform records and
COMTRADE waveform files.

Before setting up the Power Quality (PQ) parameters, make sure the meter is configured
correctly:

* Metering parameters such as volts mode and PT/CT ratios

* Time sync settings, for integrating the meter in an energy management system such as
EcoStruxure™ Power Monitoring Expert

* Nominal system parameters (nominal volts, nominal current and nominal frequency), for
detecting power quality events

* Amount of deviation from the nominal that is considered a sag or swell

Make sure you understand:
* The structure of the meter’s logging framework
* The meter’s existing logging configuration

* Your data logging requirements

Changing the meter’s data recorder and waveform recorder configuration clears existing data and
waveforms in those recorders.

NOTICE

DATA LOSS

Ensure that all important data and waveforms have been recorded before configuring the data
and waveform recorders.

Failure to follow these instructions can result in data loss.
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Power quality logging
Sags and swells

Your meter monitors your power system’s voltage and current for sags and swells (INCITS
(CBEMA) Type 2 and Type 3 disturbances).

When sag/swell limits are defined and alarming is enabled, the meter reports the disturbance’s
magnitude and duration, and logs data and waveform records associated with the disturbance.
Configuring sag and swell logging

Use ION Setup to configure your meter to log data and waveform records related to sag/swell
events, and to export the waveform data to COMTRADE files.

There are two data recorders for logging sag/swell related data:
* Sag/Swell Log (Data Rec 5) records data for plotting the ITIC (CBEMA) curve.

* Sg/Sw HS Log (Data Rec 6) records voltage and current data from the High-Speed Power
Meter module.

To configure the Sag/Swell Log, Sg/Sw HS Log, Sag/Swell Waveform Log, and Sag/Swell
COMTRADE files:

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Click Power Quality > Sag/Swell Logging.
4. Selectthe data log and click Edit.
5. Enter the meter password, if prompted.

The Sag/Swell Logging Wizard appears.

6. The Device setting verification screen shows results of the meter configuration check for
possible errors related to sag/swell monitoring and reporting. Click Fix to view details or click
Next to ignore the results and proceed to the next screen.

7. The Disturbance Logging Setup screen displays the Log Depth setting for the Sag/Swell
Log (Data Rec 5). (Optional) Change the maximum number of records to store in this log.

8. Click Next.

9. The High Speed Recording screen displays the settings for the high-speed Sag/Swell data
recorder (Sg/Sw HS Log - Data Rec 6). Configure these settings for the meter to perform
burst data logging.

Parameter Description

Enable Burst Data Select or clear this check box to
Logging turn burst data logging on or off.
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Parameter Description

Specifies, in seconds, how many
pre-event records to capture.
The actual number of records
Pre-trigger recording :et in the high’-speed §ag/SweII
ata recorder’s Pre-trigger
Records setup register = (2 x
system frequency) x (number of

seconds).

Specifies, in seconds, how many
post-event records to capture.
The actual number of records
set in the high-speed Sag/Swell
data recorder’s Post-trigger
Records = (2 x system
frequency) x (number of
seconds).

Post-trigger
recording

Specifies how many burst data
log sets to save in long-term
memory (NVRAM). The actual
number of records is configured
in the high-speed Sag/Swell
Tl eisedliee dat«’.a recorder’s Depth setu;?
register = (Total # of recordings)
x (Pre-trigger Records + Post-
trigger Records + 1). For details
on how a data log set is
calculated, see "Data recorder

burst data" on page 217.

Notes

If system frequency is changed,
the recording duration for Pre-
trigger recording and Post-
trigger recording automatically
adjusts to reflect the new
frequency setting.

If system frequency is changed,
the recording duration for Pre-
trigger recording and Post-
trigger recording automatically
adjusts to reflect the new
frequency setting.

When burst data logging is
enabled, the equivalent number
of records for 2 burst data log
sets is allocated in short-term
memory (RAM). The actual
number of records set in the
high-speed Sag/Swell data
recorder’s Buffer Depth setup
register = 2 x (Pre-trigger
Records + Post-trigger Records
+1).

10. Click Next.

11.

Use the Waveform Log Setup screen to configure the waveform recorder for Standard or
Delayed waveform capture.

NOTE: The Sag/Swell Logging Wizard does not support Extended waveform capture. For
more information on Standard, Delayed, and Extended waveform capture, see "Waveform
capture" on page 218.

Parameter Description

Specifies the maximum number of waveform records stored on the

Waveform Depth
meter.

Specifies the number of samples per cycle and the number of

Waveform Format .
cycles that are stored in a waveform record.
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Transients

Parameter Description

Specifies the number of cycles to capture before the waveform
Trigger Position versus after the waveform. Trigger position can be set using the
pre-cycle arrows or the slider bar.

NOTE: The maximum number of cycles (pre-event + post-event) cannot exceed the total
number of cycles in the waveform format.
12. Click Next.

13. Configure your meter's COMTRADE settings:

a. Select or clear the Generate COMTRADE files checkbox to enable or disable the
creation of COMTRADE records.

NOTE: The waveform viewer on your meter's webpages uses the meter's COMTRADE
files. If you want to view waveforms on the meter's webpages, select Generate
COMTRADE files.

NOTE: The factory-default configuration for COMTRADE only supports Standard
waveform capture.

b. Setthe Log depth for the COMTRADE files to specify the maximum number of records
stored on your meter’'s SFTP site.
14. Click Finish.

You are returned to the Sag/Swell Logging screen and the entry shows your new
configuration.

If nothing happens after you click Finish, check the log depths and buffer depths for your
other data logs to make sure that the meter has enough memory for these changes. Adjust
the log depth and buffer depth of the data and waveform recorders, if needed.

Your meter monitors your power system’s voltage and detects ITI (CBEMA) type disturbances
related to transients.

When voltage transient limits are defined and alarming is enabled, the meter reports the
disturbance’s magnitude and duration, and logs data and waveform records associated with the
disturbance.

Configuring transient logging using ION Setup

Use ION Setup to configure your meter to log data and waveform records related to voltage
transient events, and to export the waveform data to COMTRADE files.

NOTE: Transient Log (Data Rec 15) records voltage transient related data.

To set up the Transient Log, Transient Waveform Log, and Transient COMTRADE files:
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P DN

Start ION Setup.

Open the Setup Assistant for your meter.

Click Power Quality > Transient Logging.

Select the data log and click Edit. Enter the meter password if prompted.
The Transient Logging Wizard appears.

The Device setting verification screen displays the results of meter configuration check
for potential errors related to transient monitoring and reporting. Click Fix to view details or
click Next to ignore the results and proceed to the next screen.

The Transient Logging Setup screen displays Transient data recorder’s Log Depth
setting. You can change the maximum number of records to store in the Transient data log.
Click Next to proceed to the next screen.

The Waveform Log Setup screen allows you to configure the waveform recorder for
Standard or Delayed waveform capture.

NOTE: The Transient Logging Wizard does not support Extended waveform capture. See
“Waveform capture” for details on Standard, Delayed and Extended waveform capture.

Parameter Description

Waveform Specifies the maximum number of waveform records stored on the
Depth meter.

Waveform Specifies the number of samples per cycle and the number of cycles that
Format are stored in a waveform record.

Triaqer Specifies the number of cycles to capture before the waveform versus
Poiﬁion after the waveform. Trigger position can be set using the pre-cycle

arrows or the slider bar.

NOTE: The maximum number of cycles (pre-event + post-event) cannot exceed the total
number of cycles in the waveform format.

Click Next.

Configure your meter's COMTRADE settings:

a. Select or clear the Generate COMTRANDE files check box to enable or disable the
creation of COMTRADE records.

NOTE: The waveform viewer on your meter's webpages uses the meter's COMTRADE
files. If you want to view waveforms on the meter’s webpages, select Generate
COMTRADE files.

NOTE: The factory-default configuration for COMTRADE only supports Standard
waveform capture.

b. Setthe Log depth for the COMTRADE files to specify the maximum number of records
stored on your meter’s internal SFTP site.
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9.

Click Finish.

You are returned to the Transient Logging screen and the entry shows your new
configuration.

If nothing happens when you click Finish, check the log depths and buffer depths for all your
other data logs to make sure that the meter has enough memory for these changes. Adjust
the log depth and buffer depth of the data and waveform recorders if needed.

Configuring Advanced Power Quality

Use ION Setup to configure your meter’s power quality monitoring and logging settings for IEC
61000-4-30, EN 50160, IEEE 519, and Rapid Voltage Change (RVC).

Prerequisites and notes

Ensure that Sag/Swell alarming is enabled and configured. For details on how to setup Sag/Swell
alarming, see "Configuring sag/swell alarms using ION Setup" on page 190.

NOTE: IEC 61000-4-30 must be enabled before configuring EN 50160 or IEEE 519 logging.

NOTICE

DATA LOSS
* Enable Sag/Swell alarming before configuring power quality disturbance related features.

* Enable IEC 61000-4-30 before enabling other power quality monitoring and recording
features.

Failure to follow these instructions can result in data loss.

To configure Advanced Power Quality:

1.

N oo o M e D

Start ION Setup.

Open the Setup Assistant for your meter.
Click Power Quality > Advanced PQ.
Configure IEC 61000-4-30.

(Optional) Configure EN 50160.

(Optional) Configure IEEE 519.

(Optional) Configure RVC.

Configuring IEC 61000-4-30
To configure IEC 61000-4-30:

1.
2.

Select 4-30 Enable.

Click Edit to configure your meter’s IEC 61000-4-30 logging parameters.
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3. Configure the settings as needed:

IEC 61000-4-30 Setup

Parameter Description

Select if you want to enable IEC 61000-4-30 monitoring.

Enabled NOTE: This option must be enabled when monitoring EN 50160 or
IEEE 519 parameters.

Specifies the percentage of nominal voltage that defines a disturbance.
Threshold For example, if you set this to 10% of 120 V nominal, the disturbance
occurs when the voltage dips to 12 V and below.

Specifies the percentage above the Threshold that defines the end of
the disturbance. For example, if you set this to 2%, the end of the

Hysteresis , . .
disturbance occurs when the voltage rises to (10% + 2%) of nominal, or
14.4V and above.

Log 4-30 3s Select if you want to enable IEC 61000-4-30 3-second interval data

measurements  logging.

Log 4-30 10s Select if you want to enable IEC 61000-4-30 10-second interval data
measurements  logging.

4. Click Send to save your changes.

The Advanced PQ screen shows the new configuration.

Configuring EN 50160
To configure EN 50160:

1.

Select EN50160 Enable.
If you want to delete all logged EN 50160 data, click Reset, and then click Yes to confirm.

Click Edit to configure your meter’s EN 50160 logging parameters.

NOTE: You must enable IEC 61000-4-30 before the meter can start monitoring EN 50160
parameters.

Configure the settings as needed:

EN 50160 Setup

Parameter Description

Enabled Select if you want to enable EN 50160 monitoring.

Nominal Voltage Specifies the nominal voltage value used for EN 50160.

Nominal - .

Specifies the nominal frequency used for EN 50160.
Frequency
Log EN50160 Select if you want to log EN 50160 parameters.

measurements  NOTE: You need to enable EN 50160 monitoring to log the parameters.
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4. Click Send to save your changes.

The Advanced PQ screen shows the new configuration.

Configuring IEEE 519
To configure IEEE 519:
1. Select 519 Enable.

2. Click Edit to configure your meter’s IEEE 519 logging parameters.

NOTE: You must enable IEC 61000-4-30 before the meter can start monitoring IEEE 519
parameters.

3. From the Harmonics Limits drop-down list, select the IEEE 519 edition you want the meter
to use when analyzing harmonic data.

4. Click Next.

5. Configure the voltage settings as needed:

IEEE 519 Setup

Parameter Description

Displays the nominal voltage value used for IEEE 519.

Nominal Voltage ~ NOTE: If you change the Nominal Voltage, you must return to this
setup screen and update the IEEE 519 configuration.

<Bus voltage Select the bus voltage at the point of common coupling.

options> Select Disabled if you do not want to log IEEE 519 related data.

6. After specifying the bus voltage, click Next to configure the IEEE 519 current parameters.

IEEE 519 Setup

Parameter Description

Maximum short Enter the maximum short-circuit current at the point of common
circuit current coupling.

Maximum demand Enter the maximum demand load current at the point of common
load current coupling.

This displays the maximum short-circuit to maximum demand load
Ratio ratio. This is used to determine the voltage and current distortion
limits.

7. Click Next to view the screen that displays the voltage and current distortion limits for the
harmonic content.

Harmonics 2 to 50 and THD/TDD are displayed, with the corresponding set limits for Voltage
Distortion % and Current Distortion %.

8. Click Finish to save your changes.

The Advanced PQ screen shows the new configuration.
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Configuring RVC
To configure RVC:
1. Select RVC Enable.

2. Click Edit to configure your meter's RVC feature.

NOTE: You must enable the Sag/Swell module before the meter can start monitoring and
detecting RVC.

3. Configure the settings as needed:

Rapid Voltage Change Setup

Parameter Description

— Disabled: ION Setup has detected that the Sag/Swell module is
disabled. Go to Alarming > Sag/Swell and enable Sag/Swell

Enabled first for the meter to detect RVC.

— Yes: RVC monitoring is on.
— No: RVC monitoring is off.

Specifies, as a percentage, the RMS voltage limit that must be

Threshold
exceeded for an RVC event to occur.

Specifies, as a percentage, the difference in magnitude between the

Hysteresis
start and end thresholds for an RVC event.

4. Click Send to save your changes.

The Advanced PQ screen shows the new configuration.

Rapid Voltage Change

Rapid Voltage Change (RVC) is a quick transition in RMS voltage between two steady-state
conditions, during which the voltage does not exceed the sag/swell thresholds.

You can configure the Sag/Swell module to detect and measure RVC and record the eventin the
meter’s Event Log.

For more information on the Sag/Swell module, see ION Reference, available on www.se.com.

Harmonics

Harmonics are integer multiples of the fundamental frequency of the power system.

Harmonics information is valuable for power quality analysis, determining properly rated
transformers, maintenance, and troubleshooting. Evaluation of harmonics is required for
compliance with system power quality standards such as EN 50160 and meter power quality
standards such as IEC 61000-4-30.

Harmonics measurements include per-phase magnitudes and angles (relative to the fundamental
frequency of the phase A voltage) for the fundamental and higher order harmonics relative to the
fundamental frequency. The meter’s power system setting defines which phases are present and
determines how line-to-line or line-to-neutral voltage harmonics and current harmonics are
calculated.
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Harmonics are used to identify whether the supplied system power meets required power quality
standards, or if non-linear loads are affecting your power system. Power system harmonics can
cause current flow on the neutral conductor, and damage to equipment such as increased heating
in electric motors. Power conditioners or harmonic filters can be used to minimize unwanted
harmonics.

Viewing harmonics information using the display

To view detailed harmonics data through the display:
1. Press the Home button on the display.

2. Press Power Quality > Harmonics. The total harmonic distortion (THD) screens are
displayed.

3. Press More, then use the up or down icons to select the desired harmonics. The per-phase
harmonics are graphically displayed.

4. Press the left and right icons to move to individual harmonics. The harmonic number,

magnitude and phase angle are displayed.

Voltage crest factor

Crest factor is the ratio of peak to RMS voltage values.
For a pure sinusoidal waveform, crest factor is equal to 1.414. The meter uses the following

equation to calculate crest factor:

C = Crest factor

= 1"

Vpeak = Voltage peak

= | ==

Ry

Vgrus = Voltage RMS

Current crest factor

Crest factor is the ratio of peak to RMS current values.

For a pure sinusoidal waveform, crest factor is equal to 1.414. The meter uses the following
equation to calculate crest factor:

C = Crest factor

C= I lpeak = Current peak

Irms = Current RMS

K-factor

K-factor relates the heating effect of a distorted current in a transformer to a sinusoidal current
with the same RMS magnitude — it describes a transformer’s ability to serve non-linear loads
without exceeding rated temperature rise limits.

The K-factor is equal to the sum of the squares of the harmonic currents multiplied by the squares
of the harmonic order. The meter uses the following equation to calculate K-factor:
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h
YOI %Y

n= i
K =
h
% Ik
den
n=1

Where K is the K-factor, h is the harmonic order and It is the true RMS current of harmonic order
h.

Harmonic content calculations

Harmonic content (Hc) is equal to the RMS value of all the non-fundamental harmonic
components in one phase of the power system.

The meter uses the following equation to calculate Hc:

HC = J{H,F + (Hy)* + (H P

THD% calculations

THD% is a quick measure of the total distortion present in a waveform and is the ratio of harmonic
content (H¢) to the fundamental harmonic (H,).

By default, the meter uses the following equation to calculate THD%:

H
THD = —S x 100%
|'-ll

thd and TDD

Your meter can be configured to provide thd (total harmonic distortion using the total RMS value
for the content rather than the fundamental content) and TDD (total demand distortion, the
harmonic current distortion against the maximum demand of the electrical system).

thd = Hz / RMS *100%
TDD = H¢ / Demandya, *100%

For more information on the Harmonics Measurement module, see /ION Reference, available on
www.se.com.

Phasors

Phasors are used to represent the voltage and current magnitude and angles.

The length of the lines in the phasor diagram represent the relative magnitude of the voltages with
respect to the other phase voltages, and the currents with respect to the other phase currents. All
angles are measured with respect to the Va/VV1 phase. The Va/V1 phasor is fixed to the right-hand
horizontal axis (positive x-axis). Positive angles are measured counterclockwise.
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Measured values are provided for the magnitude and relative angle for each voltage and current
phase.

Delta vector diagrams can be configured to display two different ways:

* Instrument (voltage vectors appear 60 degrees apart - showing the actual voltage and current
values that the meter is measuring).

* System (voltage vectors appear 120 degrees apart - showing true system operation including
any calculated values).

Phasor information can be used to troubleshoot incorrect connections on the meter’s voltage and
current inputs (for example, switched phase wiring or polarity errors), if you know how the phasors
should be oriented for your power system.

Phasor information can be viewed using ION Setup, meter webpages, or the display.

Power quality standards compliance

Meter compliance

Your meter is compliant with the following power quality standards.

IEC 62586-1 and IEC 62586-2

Your meter is compliant with IEC 62586-1 and IEC 62586-2. The meter classification is PQI-A-
F11, defined as follows:

Product Code Description

PQl Power quality instrument
A Functions class A according to IEC 61000-4-30
F Fixed installed equipment

I Indoor application

1 Indoor environment with uncontrolled temperature variations

NOTE: Your meter has Power station electromagnetic immunity compliance in accordance with
IEC 61000-6-5.

IEC 61000-4-30

IEC 61000-4-30 power quality standard compliance is provided by ION modules including: Power
Quality Aggregator, Harmonics Measurement, Disturbance Analyzer, Symmetrical Components,
Mains Signaling Evaluation, and Sag/Swell.

For more information, see the IEC 61000-4-30 compliance and ION meters technical note,
available on www.se.com.

Power quality standards compliance reporting

Your meter can measure and record compliance data for the following power quality standards.

EN 50160

The EN 50160 framework includes ION modules such as Flicker, Mains Signaling Evaluation,
Harmonics Evaluation, and Voltage Harmonics.
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NOTICE

DATA LOSS

Use an Uninterruptible Power Supply (UPS) to help maintain EN 50160 framework operation
during a power outage.

Failure to follow these instructions can result in data loss.

For more information about EN 50160, see the Power Quality: ION Meters and EN50160:2010
technical note, available on www.se.com.

IEEE 519

The IEEE 519 framework includes ION modules, such as: Harmonics Evaluation, Harmonics
Measurement, and Counter.

Disturbance direction detection

Your meter has disturbance direction detection capabilities to help you determine the location of a
power system disturbance.

When a disturbance occurs, the meter analyzes the disturbance information to determine the
direction of the disturbance relative to the meter. This analysis includes a confidence level
indicating the level of certainty that the disturbance is in the determined direction and is stored in
your meter’s event log.

Disturbance direction detection is enabled on your meter by default and does not require any
additional configuration beyond setting the nominal voltage and nominal frequency.

Disturbance direction detection can help locate the source of a disturbance when used in a
system of disturbance direction detection devices. In the diagram below, meters (B), (C) and (D)
are installed on the power consumer side, while meter (E) is installed on the utility side.
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Disturbance location

Meter (B) reports downstream disturbance

Meter (C) reports upstream disturbance

Meters (D) report upstream disturbance

m o|Oo|®|>

Meter (E) reports downstream disturbance

The arrows show the direction the meters have determined for the disturbance. With this
information, you can determine that the disturbance occurred between meter (B) and meter (C)
and can focus on that section of your system to find the cause of the disturbance.

Disturbance direction detection events

The results of the disturbance direction detection algorithm appear in the meter’s event log.

The image below shows an example of how a Disturbance Direction Detection event appears in
your meter's event log when viewed using ION Setup.
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[ Eile Edit Wiew Insert Tools Window Help

EIE] ezl QR 20 =] o|alvF] 2

Ewent Log |

[rate/Time | Cause | Walue | Effect | Walue
1042242007 2:29:11.918 PM San/Swel 1 Disturbance End 551 DistState Mormal
10/22/2007 2:29:10.702 P Dist Direction Detection 1 DDD Analysis Done Dist Direction Detection 1 Disturbance Direction Detected - Upstream - High Confidence
10/22/2007 2:29:10.702 P Sag/Swell 1 Disturbance Start 551 DistState Disturbance

You can view your meter’s event log through ION Setup or display.
For details on how to view the event log, see "Viewing and downloading an event log" on page 54.

For more information on the Disturbance Direction Detection module, see ION Reference,
available on www.se.com.

COMTRADE

The meter provides waveforms in COMmon format for TRAnsient Data Exchange (COMTRADE)
format. IEC 60255-24 defines the COMTRADE format. COMTRADE files simplify the retrieval,
analysis, and exchange of power quality event (disturbance) data between many sources and
vendors.

COMTRADE records are generated from the existing Waveform Recorder modules that are
connected to the COMTRADE module.

Your meter can generate COMTRADE files and store them on the meter’s internal SFTP site.
COMTRADE can be used in conjunction with IEC 61850.

For more information, see the COMTRADE and ION technology technical note, available on
WWW.S€e.com.

COMTRADE implementation

COMTRADE is configured as part of the default waveform recording framework.

COMTRADE records are created for sag/swell events. Configure your meter's nominal voltages
to enable waveform recording. COMTRADE records are stored as read-only files on the meter’s
internal SFTP site. A master reset, firmware upgrade, or waveform recorder change will delete the
records.

NOTE: Sag/Swell alarms must be enabled when using COMTRADE. For details on how to set up
Sag/Swell alarming, see "Configuring sag/swell alarms using ION Setup" on page 190.

By default:

* The meter is configured so COMTRADE records are created for the default waveform
recorders.

TIP: If you create a waveform recorder, the recorder will not create COMTRADE files by
default. Configure a new COMTRADE module if you want COMTRADE files created by new
recorders. You can configure up to three COMTRADE modules using ION Setup in
Advanced mode. For more information on how to switch ION Setup to Advanced mode, see
"Meter configuration" on page 23.

* The oldest COMTRADE record is overwritten by the newest record when the COMTRADE
depth is exceeded.
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NOTE: COMTRADE files can only be downloaded using an Ethernet connection. They cannot be
downloaded using serial, modem, or Ethernet gateway connections.

For more information, see the COMTRADE and ION technology technical note, available on
www.se.com.

Waveforms on the meter webpages

You can use the waveform viewer on the meter's webpages to view waveforms generated as a
result of power quality events.

Set up the meter to view waveforms on the webpages

Before you can view waveforms on the meter’'s webpages, you need to perform some basic
configuration to enable waveform capture and store the waveforms in COMTRADE format.

]

1. Enable waveform 2. A waveform is captured when 3. View the waveform on the
capture on your meter a power quality event occurs meter's webpages

Set the meter’s nominal A COMTRADE record is Go to the waveform viewer
voltage using ION Setup or generated and saved to your (Monitoring > Waveforms) to
meter webpages. meter’s internal SFTP site. explore the waveform data.

The waveform viewer uses the meter's COMTRADE files to display the waveforms. If the events
you want to capture are not included in the default framework, you can customize the meter’s
waveform recording framework.

Webpage waveform viewer

After COMTRADE files are generated by your meter, you can view them using the waveform
viewer.
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Select the COMTRADE module to view (COMTRADE_1 is set up by default; you can also
set up COMTRADE_2 or COMTRADE_3)

>

Select the particular COMTRADE waveform to view

Show/hide parameters

View details

m|o|O|®

Zoom in/out

Viewing waveforms on meter webpages

Use the waveform viewer on your meter's webpages to view the meter's COMTRADE waveform
files.

Prerequisites:

Ensure the meter is configured to record waveforms by setting the nominal voltage.
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To view waveforms on meter webpages:

1. Open a browser and go to the IP address for your meter, entering valid login credentials
when requested.

2. Navigate to Monitoring > Waveforms.

A screen displays with accordion menus for three COMTRADE modules (regardless of
whether or not that COMTRADE module is being created by the meter). The waveform
viewer for COMTRADE_1 is expanded.

By default, COMTRADE _ 1 displays the sag/swell waveform records. COMTRADE_2 and
COMTRADE_3 are used if you have configured additional waveform recorders and
connected them to COMTRADE modules.

3. Select the accordion menu for the COMTRADE records you want to view, for example
COMTRADE_2.

The waveform viewer for those COMTRADE records is displayed.
4. Select the file you want to view from the record drop-down list box.

The numbering starts at 0 (zero), which means you select cmt0_00004 to view the fifth file
for COMTRADE_1.

5. Click or tap an individual voltage or current channel in the legend to show or hide it in the
waveform viewer.

- @ Visible
— ©Hidden

6. Use the bar at the bottom to zoom in/zoom out on a particular section of the waveform, or to
scan through the waveform with the selected zoom level.

& EnH TN

— Draw a window over a particular area to zoom in on that section of the waveform.
— Drag the selected area to move the zoom across the waveform.
— Drag the start and end points to expand or narrow the zoom.

7. Hover over or tap a spot on the waveform to view the values associated with that particular
moment in time.

Tima 5] - 880233

i -
[ -
1] 3 o

Burst data logging

Burst data logging is a recording method that captures a snapshot of data that occurred
immediately before and immediately after a triggered recording.
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Burst data logging is analogous to continuous shooting mode or “burst mode” in photography. An
understanding of pre and post event data assists in the analysis of undesired power quality events
such as sags or swells.

Burst logging is typically used for high-speed RMS (half-cycle) data capture, but the data recorder
supports standard speed (1-second) recording as well, depending on the ION modules connected
to the inputs of the Data Recorder module.

NOTE: To maximize the performance of your power management system, it is recommended that
devices be connected directly to an Ethernet network.

Data recorder burst data

The meter’s Data Recorder modules support burst data logging.

The Data Recorder module’s Pre-trigger Records setup register specifies how many pre-event
records are saved with each triggered recording. The Post-trigger Records setup register
specifies how many post-event records are saved with each triggered recording.

Both Pre-trigger Records and Post-trigger Records are set to zero by default. To configure the
data recorder for burst data logging, either or both of these setup registers must be set to a non-
zero positive integer value.

The data log set for each triggered recording is equal to the sum of Pre-trigger Records + Post-
trigger Records + 1 (where 1 is the actual record when the Data Recorder module’s Record input
was triggered).

For example, if Pre-trigger Records is set to 10 and Post-trigger Records is set to 5, the number of

records for each data log set is 16:
1 record triggered

10 Pre-frigger Records § Post-Irigger Records

butter Dot ¢ i
er !
Ex 16 LS

=

| Data Log register
[ firiguar racord) 3 Crepth
input 1 valus =~ 16 % 16
- input 2 value = 258
I input 3 value . ., /

™, ]
\ -

[ 2

| — -
| -

Data log setis 10+ 1+ 5= 16

Burst data log set = [pre-trigger records] + [post-trigger records] + [actual trigger record] =10+ 5 +
1=16.

When burst data logging is enabled, both Buffer Depth and Depth setup registers must be setto a
positive integer multiple of the data log set.
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Waveform capture

Standard waveform capture

Use the system frequency to calculate the number of records needed to capture 1 second of data:

* For 60 Hz, total number of records per second = 60 cycles/second x 2 half-cycles = 120

* For 50 Hz, total number of records per second = 50 cycles/second x 2 half-cycles = 100

You can use the Power Quality setup assistant in ION Setup to specify how many seconds of
pre-trigger and post-trigger data you want to capture. ION Setup automatically calculates the

required number of records based on your input.

Use the meter’'s Waveform Recorder modules to capture waveform data.

The Waveform Recorder module captures one waveform record every time its Record input is

triggered.

A waveform record is defined by the module’s Format setup register, expressed as (hnumber of
samples per cycle) x (number of cycles per waveform record). For example, if Format is set to
128x7, that means one waveform record is made up of 7 cycles of waveform data at 128 samples

per cycle.

The meter supports 3 waveform capture types: standard, delayed, and extended.

The meter’'s Waveform Recorder modules support standard waveform capture.

A standard waveform capture saves one buffered waveform record at the Record trigger time.
Only pre-trigger waveform data is captured in this mode. No post-trigger waveform cycles are

recorded.
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A Waveform recording triggered

B  Waveform record captured at trigger

Delayed waveform capture

The meter's Waveform Recorder modules support delayed waveform capture.

The Waveform Recorder module’s Record Delay Cycles setup register specifies how many

cycles to delay the waveform capture after the Record input is triggered. This is for capturing post-

trigger waveform data.
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Waveform recording triggered

Waveform record if Record Delay Cycles was set to zero

Delay period (number of cycles specified in Record Delay Cycles setup register)

o/ 0| >

Delayed waveform capture recorded in waveform log

Extended waveform capture

The meter’'s Waveform Recorder modules support extended waveform capture.

The Waveform Recorder module’s Pre-trigger Records setup register specifies how many pre-
event records are saved with each triggered recording. The Post-trigger Records setup register
specifies how many post-event records are saved with each triggered recording.

7EN02-0390-08

Public

219




Power quality PowerLogic™ ION9000 series - User manual

Both Pre-trigger Records and Post-trigger Records are set to zero by default. To configure the
waveform recorder for extended waveform capture, either or both of these setup registers must
be set to a non-zero positive integer value. If you do this, you must also set the Record Delay
Cycles setup register to zero in order to properly configure the extended waveform capture.

Waveform recording triggered

Waveform record captured at trigger

Pre-trigger waveform records captured

o O|o|>

Post-trigger waveform records captured

The waveform log set for each triggered recording is equal to the sum of Pre-trigger Records +
Post-trigger Records + 1 (where 1 is the actual record when the Waveform Recorder module’s
Record input was triggered).

For example, if Pre-trigger Records is set to 2 and Post-trigger Records is set to 6, the number of
records for each waveform log set is 9:
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1 record friggered

2 Pre-trigger Records | 6 Postrigger Records
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Waveform log setis2+1+6=9

T

The waveform log set for the extended waveform capture = [pre-trigger records] + [actual trigger
record] + [post-trigger records]. The total waveform records captured in this exampleis2+1 +6 =
9.

When extended waveform capture is enabled, both Buffer Depth and Depth setup registers must
be set to a positive integer multiple of the waveform log set.

NOTE: The COMTRADE module does not support extended waveform capture. The
COMTRADE files saved are only for the trigger waveform record.
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High-Speed Transient Capture (HSTC)

High-Speed Transient Capture overview

The ION900OT continuously monitors incoming voltage signals. In addition to standard transient
monitoring, the ION9000T detects sub-microsecond high-voltage transients up to a peak voltage
of 10 kV.

NOTE: The high-speed transient capture (HSTC) feature is available on the ION9000T
(METSEION95030 and METSEION95040).
The ION900OOT meter is equipped with firmware and frameworks that enable the HSTC feature.

The default HSTC related settings suit most applications. Use the default settings or make
changes based on your system needs.

Use the HSTC feature to:

* Expand power quality event detection capabilities when combined with standard transient
capture.

* Record pre-event data to see the characteristics of the incoming voltage signal before the
disturbance.

* Receive alarm notifications when a transient has been detected.

* Chart waveforms to better understand the transient event. For example, peak magnitude,
duration and initial polarity of the transient.

* Record statistics, such as voltage stress, to provide an indication of cumulative impact to
loads within the electrical system.

* Sort voltage transients by peak magnitude and duration.
* Quantify transients on a per phase basis.

* Detect and characterize transients to create mitigation strategies.

For more information on the HSTC, HSTC waveform recorder, and Data set recorder modules,
see ION Reference, available on www.se.com.

Go to www.se.com and search for “An Overview of Transients in Power Systems”for information
on transients and their effects in electrical power systems.

HSTC prerequisites
To use the HSTC feature, you need the following:
* ION900O0T meter.
* ION9000T frameworks files (v2.2.x or later).
* ION Setup (v3.2.x or later).
The HSTC feature is not supported on other ION9000 series meters.
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Verify the correct meter framework

The HSTC option is displayed as the HSTC feature set.

View the meter’s feature set using ION Setup, meter webpages, or the display.

Viewing feature set using ION Setup
1. Open ION Setup and select the Setup Assistant for your meter.
2. Click Template > Save to PC > FAC1 Feature Set.

Viewing feature set using the meter webpages

1. Open a web browser and enter the IP address for your meter. Enter your login credentials
when prompted.

2. Click Diagnostics > Statistics > Meter - Basic > Feature Set.

Viewing feature set using the display
Select Alt Display Mode > Nameplate > Feature Set.

See "Display modes" on page 171 for information about display modes.

Verify the correct ION Setup version

To verify the ION Setup version:
1. Open ION Setup.

2. Click Help > About ION Setup. An ION Setup dialog box opens and displays the ION Setup
version.

If your version is earlier than v3.2.x., download the latest version of ION Setup

Downloading the latest ION Setup version

1. Browse to https://www.se.com/en/download/document/ION Setup Latest Release for the
latest version of ION Setup.

2. Download the installation file, then run it to upgrade ION Setup.

Commission HSTC

This section supplements the meter installation guides and provides guidance on commissioning
your meter to enable HSTC.

See your device installation guide for information related to installation.
System voltage

Potential transformer (PT) scaling is not applied in high-speed transient capture.

High-speed transient measurements are performed on voltage levels present at the meter’s
voltage terminals.

Voltage reference

Set the voltage reference, Ve or Vn, according to your system configuration.
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High-speed transient voltage measurements are calculated between V1-V4 and neutral (Vn), or
between V1-V4 and earth (Ve) depending on this setting.

Communications

Ethernet communication is recommended. HSTC waveform viewing is not supported over serial
connections.

Set up HSTC

HSTC alarms are disabled by default. The HSTC feature is enabled when HSTC alarms are
enabled.

HSTC related settings, such as magnitude and duration thresholds, are pre-configured at the
factory. Use the default settings or make changes based on your system needs.

Review and configure the settings for the following functions before enabling the HSTC feature:
* HSTC alarms
* HSTC logging.

HSTC alarms

Use HSTC alarms to notify you when a specific condition is met, such as a voltage transient that
exceeds a defined magnitude threshold.

HSTC alarms are included in the ION9000 series alarm system and are shown in the meter’s
Historical Alarm screen(s).

Default HSTC alarm settings

Setup Register Value/Range Default
HSTC Alarm status Disabled, Enabled Disabled
Voltage Reference Ve, Vn Ve
Magnitude Threshold (Vgys) 120-7100 1000
Duration Threshold (us) 0-250.0 0

Alarm Priority None, Info Only, Low, Medium, High High
Custom Priority 0-255 192

To use HSTC alarms, perform the following:
* Enable HSTC alarms.

* Configure HSTC alarms.

— Set the voltage reference.
— Set the peak magnitude threshold and duration threshold.
— Assign alarm priority.
— Set a custom alarm priority.
* View and acknowledge alarms.

See "Alarms and alerts" on page 180 for additional information about the ION9000 series alarms.
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Enable and configure HSTC alarms
Enable HSTC alarms using ION Setup or the display.
Configure HSTC alarms using ION Setup.

Changing your meter's HSTC alarm configuration deletes all existing Data setand HSTC
waveform logs.

NOTICE

DATA LOSS

Ensure that all important data has been recorded before configuring HSTC alarms.

Failure to follow these instructions can result in data loss.

Enabling and configuring HSTC alarms using ION Setup
To enable and configure HSTC alarms using ION Setup:
1. Open ION Setup and select the Setup Assistant for your meter.
2. Click Alarming > Transient.
3. Select High Speed Transient, and then click Edit.
4

. InHigh Speed Transient Setup, enable or configure the setup registers:

Setup Register Value/Range Description

. Enabled, . : .
Enabled/Disabled ) Specifies if HS Transient capture is enabled.
Disabled

Determines the voltage reference. Set the voltage

Voltage Reference Ve, Vn i i
reference to match your system configuration.

Specifies the absolute voltage threshold that must be
120-7100 exceeded to trigger a HS transient capture.
Note: This value is entered in RMS volts.

Magnitude
Threshold (Vgys)

Specifies the length of time that the magnitude
. threshold must be exceeded to trigger a HS transient
Duration Threshold ) , ,
(15) 0-250.0 capture. If this register is set to zero, any voltage that
. exceeds the magnitude threshold will trigger a HS
transient capture.

None, Info Select the alarm priority you want to associate with

Alarm Priorit Only, Low, the HS transient alarms. To stop an alarm from being
y Medium, displayed without affecting other meter features, set
High the alarm priority to Info Only.
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Setup Register Value/Range Description

Select custom priority to view and configure the
priority associated with the alarm. The event log

Custom Priority 0-255 cutoff value is displayed for reference. Event
priorities above the cutoff are stored in the meter’s
event log.

5. Click Save. ION Setup performs a configuration check and displays a message if the
Magnitude Threshold setting is below the configured nominal voltage.
Enabling HSTC alarms using the display
To enable and disable HSTC alarms using the display:
1. Review your meter’s nominal voltage settings.

2. Setthe HSTC magnitude threshold to a value higher than the nominal voltage.

See "Disabling and enabling alarms using the display" on page 189 for instructions.

Log HSTC

Topics in this section:

HSTC logging

The HSTC logging function is enabled with HSTC alarms. When defined transient thresholds are
exceeded the meter performs the following:

* HSTC data set logging.
* HSTC waveform logging.

The meter performs a set of calculations and stores separate records for each voltage phase.
Records are captured for V1-V4 regardless of which phase the transient occurred on.

HSTC logging default settings

Data Set Logging HSTC Waveform Storage

100 records 40 records, 20.0 ms

See "Configuring HSTC logging using ION Setup" on page 228 for information about these
settings.

HSTC Data set logging

Use data set logging to record transient event information such as peak voltage magnitude and
duration.

This feature also provides summary information such as volts-seconds stress accumulations for
each phase and total unique transient events.

Each time the HSTC trigger criteria are met, the meter performs a set of calculations for each
voltage phase:
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HSTC Data set Event based analytics

* Peak voltage amplitude

* Risetime

* Duration

* Voltage stress (volt-seconds)
* Average voltage

* Timestamps

HSTC Summary Event accumulations and statistics

* Total number of transient events on voltage phases V1-V4

* Total number of unique events
* Date and time of the last transient event counter reset

* Accumulated voltage stress (volt-seconds) for voltage phases
V1-V4

* Date and time of the last voltage stress accumulations reset

* Total number of transient events grouped by peak magnitude
and duration. There are a total of nine bins:

— Magnitude 1/Duration 1
— Magnitude 1/Duration 2
— Magnitude 1/Duration 3
— Magnitude 2/Duration 1
— Magnitude 2/Duration 2
— Magnitude 2/Duration 3
— Magnitude 3/Duration 1
— Magnitude 3/Duration 2
— Magnitude 3/Duration 3

HSTC waveform logging

Use HSTC waveform logging to capture voltage transient waveform data.

A transient detected on any voltage phase triggers a waveform capture for all connected voltage
phases. The HSTC waveform recording feature detects long duration and repetitive disturbances
and automatically extends high-speed transient capture if conditions persist.

Each transient waveform recording includes pre-event data to analyze the characteristics of the
incoming voltage signal prior to the event that triggered the high-speed transient capture.

Use ION Setup or EcoStruxure™ Power Monitoring Expert to chart and view waveforms.
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Enable and configure HSTC logging

View HSTC

HSTC logging is enabled when HSTC alarms are enabled. Use the default settings or make
changes based on your system needs.

Changing your meter's HSTC logging configuration deletes all existing data log and waveform
records.

NOTICE

DATA LOSS

Ensure that all important data and waveforms have been recorded before configuring the data
and waveform recorders.

Failure to follow these instructions can result in data loss.

Enabling HSTC logging
The HSTC logging function is enabled with HSTC alarms.

See “Enable and configure HSTC alarms” for instructions on how to enable or disable the HSTC
alarms.

Configuring HSTC logging using ION Setup
Configure data set and waveform logging using ION Setup.
To set different conditions:
1. Open ION Setup and select the Setup Assistant for your meter.
2. Click Power Quality > HSTC logging.
3. Select the data log and click Edit.
The HSTC Logging Wizard displays
4. Setthe Data Set Depth to the number of records to keep
5. Click Next.

ION Setup prompts you if the number of records exceeds file size limits. Enter a lower
number, then click Next to proceed.

6. Setthe waveform storage Log Depth to the number of waveforms to keep. The total
duration of log storage in milliseconds (ms) is displayed consistent with the Log Depth
setting.

ION Setup prompts you if the Log Depth setting exceeds the recommended memory
allocation.

7. Click Finish to return to the HSTC Logging tab.

The ION900OT continuously monitors incoming voltage signals. When HSTC is enabled and
defined transient thresholds are met the meter performs the following functions:
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* HSTC alarms

* HSTC logging
— Data set logging
— HSTC waveform logging

View and acknowledge alarms

HSTC alarms are classified as historical alarms. Use the display to view and acknowledge HSTC
alarms.

See "Viewing and acknowledging alarms using the display" on page 187 for instructions.

View HSTC logs
The following logs are generated when a high-speed transient has been detected:
* HSTC data set logs
* HSTC summary logs
* HSTC waveform recorder logs

View HSTC logs using ION Setup, the meter webpages or the display.

Viewing HSTC data sets using ION Setup
1. Open ION Setup and select your meter.
2. Click View > Data Screens.
3. Gotothe High Speed Transient Capture folder, then select the HSTC Data Set log.
The HSTC Data Set Recorder log displays.

Viewing HSTC summary using ION Setup
1. Open ION Setup and select your meter.
2. Click View > Data Screens.
3. Gotothe High Speed Transient Capture folder, then select the HSTC Summary log.
The HSTC Summary log displays.

Viewing HSTC summary using meter webpages
1. Open a web browser and enter your meter’s IP address in the address box.
The webpage login displays.
2. Enteryourlogin credentials.
3. Select Monitoring > Power Quality Summary > HSTC.

The High-Speed Transient Summary screen displays.

View HSTC waveforms

Use ION Setup or EcoStruxure™ Power Monitoring Expert to view HSTC waveforms.

Viewing HSTC waveforms using ION Setup

Use the ION Setup waveform viewer to plot captured waveform logs.
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1. Open ION Setup and select your meter.
2. Click View > Data Screens.

3. Gotothe High Speed Transient Capture folder, then select the HSTC Waveform log. The
HSTC Waveform log displays. A progress bar at the bottom of the screen indicates when all
waveform logs have been retrieved from the meter.

NOTE: Records are sorted by Start Date/Time, with the newest entries appearing at the
top.
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4. Selectthe data to plot:

a. Select the record you want to view.

b. Hold the SHIFT key while selecting the first and last entries to plot multiple records in the
same view.

5. Click the charticon to plot the selected records.
A Chart Properties box opens.

6. Click OK.
The HSTC Waveform Plot displays.

HSTC waveform viewer navigation

The HSTC waveform viewer provides user interface elements to help understand transient event
information such as the peak magnitude, duration and initial polarity of the transient.
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Element Name Description

This window displays a portion of the overall captured
disturbance.

A Active window

HSTC V1-V4 phase

B Click to select a single voltage phase V1 through V4.
selector
) Click and drag to focus on an event in the Active window. The
Slider control (top . . .
C and bottom) values shown in the information panel at the bottom of the
screen will update to reflect the new slider positions.
Auto generated value based on the magnitude of the detected
transient.
D Scale Note: The color of the text matches the voltage phase

selected. For example, blue text indicates HSTC V3 phase
has been selected.

The time when the transient thresholds are exceeded.
Note: The color of the trigger point indicator arrow matches
the voltage phase selected. For example, a red arrow
indicates HSTC V1 phase has been selected.

E Trigger point

The histogram shows the complete captured disturbance.
F Histogram Waveform samples are grouped into bins based on the peak
magnitude of the sample.
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Element Name Description

This window functions as a coarse zoom. Select and drag the
window to any point in the histogram to focus on a specific set

of waveform samples. The waveform samples contained
within this histogram window are displayed in the active
window above.

Note: The waveform samples in the active window reflect the
selected HSTC phase.

Active histogram
window

The peak magnitude of captured high-speed transients is
sorted into three bin thresholds to aid in the classification and
analysis of the captured event.

Mag < 1500 V

1500 V < Mag < 4000 V
Magnitude

thresholds 4000 V < Mag < 10 000 V

Right click in the histogram to set the number of active bins
and their corresponding thresholds.

Note: The updated threshold settings are used for
informational purposes only. They do not change the
conditions set to detect transients, nor are they retained when
the HSTC waveform viewer is closed.

Timestamp representing the point in time that the transient

| Trigger timestamp i
condition was detected.

This window functions as a fine zoom. Click, hold and drag
your cursor across any waveform portion in the active

J Active window zoom  window.
Note: The waveform samples in the active window zoom
reflect the selected HSTC phase.

Right click within the histogram window to view the spectral
analysis of the selected samples.

Note: The spectral analysis window reflects the selected
HSTC phase.

K Spectral analysis

HSTC events

HSTC events are logged the same as other meter events:
* External events such as the detection of a high-speed transient
* Configuration changes such as editing the HSTC magnitude threshold
* Other meter events

See the "Event log" on page 245 for more information about logging meter events.

Viewing HSTC events
View the event log using ION Setup or the display.
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HSTC resets
There are two HSTC reset methods, depending on what information you want to clear:

Use the meter’'s Master reset to clear HSTC Data set and Waveform logs.

Use the meter's HSTC reset to clear HSTC event accumulations and statistics.

NOTICE

DATA LOSS

Ensure all important data from the device has been recorded before performing a reset.

Failure to follow these instructions can result in data loss.

Master reset
Perform a Master reset using ION Setup.
Alternatively, you can use the meter webpages or meter display.

See "Resets" on page 274 for more information about meter resets.

Resetting HSTC using ION Setup
1. Open ION Setup and select your meter.
2. Click View > Data Screens.
3. Gotothe High Speed Transient Capture folder, then select the HSTC Summary log.
The HSTC Summary log displays
4. Click the HSTC Reset icon.
5. Click Yes to confirm HSTC reset.
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Logging
Logging overview
The meter’s logging frameworks include factory-configured data recorders, waveform recorders,
and event logs.
The logging frameworks store data related to:
* Power quality and compliance
* Energy and demand
* Revenue metering
* Trending and forecasting
* Meter events

When your system’s nominal parameters are programmed into the meter, power quality events
such as sags, swells and transients are automatically detected, and associated voltage and
current data and waveforms are logged. Meter data is stored in non-volatile memory, so data is
retained even if the meter loses power. If your system nominal values fluctuate, you can configure
the meter’s setpoint learning feature to learn your power system’s normal operating values, then
use that information to help identify voltage sags and swells.

The meter’s logging framework also supports burst data logging for sag/swell events. When burst
data logging is enabled, additional data records immediately before and immediately after the
sag/swell event are captured. Energy management systems can then retrieve this information for
use in applications, such as power event analysis.

TIP: Connect devices directly to an Ethernet network to help maximize the performance of your
power management system.

You can also configure the meter to email data from the logging frameworks. For more
information, see the PowerlLogic MeterM@il Internal Email Client Feature technical note,
available on www.se.com.

Meter events are recorded in the meter’s onboard event log. You can also configure the meter to
record events to an external syslog server.

For details on how to set up syslog, see "Configuring Syslog network settings using ION Setup”
on page 247.

Default data logging configuration

The meter’s default template includes factory-configured data logs (Data Recorder modules).

These data logs and their configuration are used by other components of your power monitoring
system.

NOTE: Do not change the default configuration of any of the logs unless you understand the
impact of the change on these power monitoring system components, the data they use, and your
meter's memory.
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The meter can support up to 100 data recorders, which can each record up to 16 different
parameters.

Revenue Log

The Revenue Log (Data Rec 1) is configured for use with UTS MV-90 billing software.

Factory settings for this data recorder:
* Log depth = 3360 records (35 days)

* Interval = 900 seconds (15 minutes)

By default, it logs the following values:

Parameter Description

kWh del int Interval kWh delivered
kWh rec int Interval kWh received
kVARh del int Interval kVARh delivered
kVARh rec int Interval KVARh received

Historic data logs

Three historic data logs are used to record standard power system quantities, such as phase
current, phase voltage, and power factor. These logs are labeled Hist Mean Log, Hist High Log,
and Hist Low Log.

Factory settings for these data recorders:
* Log depth = 3360 records (35 days)

* Interval = 900 seconds (15 minutes)

By default, they log the following values:

Hist Mean Log (Data Rec 2)

VIl ab mean V unbal mean | avg mean kVA tot mean
VIl bc mean la mean 14 mean PF lag mean
VIl ca mean Ib mean kW tot mean PF lead mean
VIl avg mean Ic mean kVAR tot mean Freq mean
VIl ab high V unbal high | avg high kVA tot high
VIl be high la high | 4 high PF lag high
VIl ca high Ib high kW tot high PF lead high
VIl avg high Ic high kVAR tot high Freq high
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Hist Low Log (Data Rec 4)

VIl ab low V unbal low | avg low kVA tot low
VIl be low la low 14 low PF lag low
VIl ca low Ib low kW tot low PF lead low
VIl avg low Ic low kVAR tot low Freq low

Loss Log

The Loss Log (Data Rec 9) is configured to record loss values.

Factory settings for this data recorder:
* Log depth = 3360 records (35 days)

* Interval = 900 seconds (15 minutes)

By default, it logs the following values:

Parameter Description

MU la”2h int Phase A interval current squared hours

MU Ib”2h int Phase B interval current squared hours

MU Ic*2h int Phase C interval current squared hours

MU Vllab”2h int Phase A interval voltage Line-to-Line squared hours
MU Vilbc*2h int Phase B interval voltage Line-to-Line squared hours
MU Vlica*2h int Phase C interval voltage Line-to-Line squared hours
MU Vin a*2h int Phase A interval voltage Line-to-Neutral squared hours
MU VIn bA2h int Phase B interval voltage Line-to-Neutral squared hours
MU Vin c*2h int Phase C interval voltage Line-to-Neutral squared hours

Harmonics logs

Two harmonics logs record various harmonics data, including K-factor and Total Harmonic
Distortion (THD). These recorders are labeled Harm Mean Log and Harm High Log.

Factory settings for these data recorders:
* Log depth = 840 records (35 days)

* Interval = 3600 seconds (1 hour)

By default, they log the following values:

Harm Mean Log (Data Rec 7)

V1 THD mean 11 THD mean 11 KFac mean
V2 THD mean 12 THD mean 12 K Fac mean
V3 THD mean I3 THD mean I3 KFac mean
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Harm High Log (Data Rec 8)

V1 THD high [1 THD high I1 K Fac high
V2 THD high 12 THD high 12 K Fac high
V3 THD high I3 THD high I3 K Fac high

Energy and Demand Log

The EgyDmd Log (Data Rec 10) records energy and demand data used by energy management
software to generate reports.

Factory settings for this data recorder:
* Log depth = 3360 records (35 days)
* Interval = 900 seconds (15 minutes)

By default, it logs the following values:

Parameter Description

kWh del Active energy delivered

kWh rec Active energy received

kWh del-rec Active energy delivered minus received

kVARNh del Reactive energy delivered

kVARh rec Reactive energy received

kVARh del-rec Reactive energy delivered minus received

kVAh del+rec Apparent energy delivered plus received

kW sd del-rec Active power demand delivered minus received
kVAR sd del-rec Reactive power demand delivered minus received
kVA sd del+rec Apparent power demand delivered plus received

Daily Nominal Log
The DailyNom Log (Data Rec 39) provides information about the meter’'s nominal settings.
Factory settings for this data recorder:
* Log depth =450 records

* Interval = Triggered on demand

By default, it logs the following values from the Factory module’s setup registers:

Parameter Description
FAC1 Vnominal Nominal voltage setting
FAC1 NomFregNum Expected frequency of operation
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Rapid Voltage Change Log

The RVC Log (Data Rec 23) provides details of rapid voltage changes related to sag/swells
(power quality events). This data recorder is disabled by default.

Factory settings for this data recorder:
* Logdepth =100 records

* Interval = Triggered on demand

If enabled, it logs the following by default:

SS1 Delta Umax SS1 Delta Uss SS1 RVC Duration

For more information on how to enable the Rapid Voltage Change Log, see "Configuring
Advanced Power Quality" on page 204.

Sag/swell Log
The Sag/swell Log (Data Rec 5) provides details of power quality events.
Factory settings for this data recorder:
* Log depth =100 records
* Interval = Triggered on demand

By default, it logs the following values:

SS1 DistDur SS1 DistV1Min SS1 DistV1Max SS1 DistV1Avg
SS1 DistV1Engy SS1 DistV2Min SS1 DistV2Max SS1 DistV2Avg
SS1 DistV2Engy SS1 DistV3Min SS1 DistV3Max SS1 DistV3Avg
SS1 DistV3Engy SS1 DistNominal SS1 Swell Lim SS1 SagLim

For more information on how to configure sag/swell logging, see "Configuring sag and swell
logging" on page 200.

Sg/Sw HS Log

The Sg/Sw HS Log (Data Rec 6) captures high-speed (half-cycle) voltage and current data that
includes pre-event and post-event records related to the sag/swell event. This data recorder is
disabled by default.

If enabled, it logs the following by default:

HSVina HS Vil ab HSIla HS Freq

HSVinb HS VIl be HS I b PQA1 Vavg Sliding
Ref Voltage

HS Vinc HS Vil ca HSIc

For more information on how to enable the Sg/Sw HS Log, see "Configuring sag and swell
logging" on page 200.
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Transient Log

The Transient Log (Data Rec 15) provides details of power quality events. Factory settings for this
data recorder:

Factory settings for this data recorder:
* Logdepth =100 records
* Interval = Triggered on demand

By default, it logs the following values:

TR1 TranV1Dur TR1 TranV3Dur PM1 PT Prim
TR1 TranV1Max TR1 TranV3Max PM1 PT Sec
TR1 TranV2Dur TR1 TranNominal PM1 CT Prim
TR1 TranV2Max TR1 Threshold PM1 CT Sec

EN 50160 compliance logs

The EN 50160 compliance logs are used to record EN 50160 compliance counters:

Data recorder Description

EN50160 Flicker (Data Rec 18) Flicker

EN50160 Frg/Mg (Data Rec 17) Power frequency and supply magnitude
EN50160 Hrm VIt (Data Rec 29) Voltage harmonics

EN50160 Ihm VIt (Data Rec 30) Voltage interharmonics

EN50160 Intrp (Data Rec 24) Short/long interruptions

EN50160 MSignal (Data Rec 31) Evaluation of mains voltage signals
EN50160 Prm-f/V (Data Rec 32) Frequency and supply voltage statistics
EN50160 Prm-Flk (Data Rec 33) Flicker statistics (Pst and PIt)

EN50160 PrmHrm1 (Data Rec 12) Harmonics statistics

EN50160 PrmHrm2 (Data Rec 11) Harmonics statistics overflow

EN50160 Swell (Data Rec 25) Voltage swells

EN50160 VIt Dp1 (Data Rec 19) Supply voltage dips

EN50160 VIt Dp2 (Data Rec 20) Supply voltage dips

EN50160 Vunbal (Data Rec 28) Voltage unbalance

The meter logs EN 50160 counter data for present and previous observation periods as well as
EN 50160 events.

For more information about EN 50160, see the Power Quality: ION Meters and EN50160:2010
technical note, available on www.se.com.
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IEC 61000-4-30 logs

The IEC 61000-4-30 logs are used to log parameters related to the International Electrotechnical
Commission’s IEC 61000-4-30 standard and to create reports:

4-30 3s RMS Log (Data Rec 38)

PqgFlag 2s ivd I13s V1 OverDev 3s V3 OverDev 3s
V1 3s 12 3s V2 UnderDev 3s

V2 3s I3 3s V2 OverDev 3s

V3 3s V1 UnderDev 3s V3 UnderDev 3s

4-30 10mRMS Log (Data Rec 16)

PgFlag 10m PQA1 11 10m V1 OverDev 10m V3 OverDev 10m
V1 10m PQA1 12 10m V2 UnderDev 10m Power Freq 10m
V2 10m PQA1 13 10m V2 OverDev 10m

V3 10m V1 UnderDev 10m V3 UnderDev 10m

4-30 2hrRMS Log (Data Rec 37)

PqFlag 2hr 1 2hr V1 OverDev 2hr V3 OverDev 2hr
V1 2hr 12 2hr V2 UnderDev 2hr Power Freq 2hr
V2 2hr 13 2hr V2 OverDev 2hr

V3 2hr V1 UnderDev 2hr V3 UnderDev 2hr

4-30 3s THD Log (Data Rec 26)

PgFlag 3s THD V3 THD 3s I3THD 3s IlUnbal u2 3s
V1 THD 3s 11 THD 3s Vunbal u2 3s IUnbal u0 3s
V2 THD 3s 12 THD 3s Vunbal u0 3s

4-30 10mTHD Log (Data Rec 27)

PgFlag 10m V3 THD 10m PQ I3 THD 10m IUnbal u2 10m
V1 THD 10m PQI1 THD 10m Vunbal u2 10m IUnbal u0 10m
V2 THD 10m PQI2 THD 10m Vunbal u0 10m

4-30 2hrTHD Log (Data Rec 34)

PgFlag 2hr V3 THD 2hr I3 THD 2hr IUnbal u2 2hr
V1 THD 2hr 11 THD 2hr Vunbal u2 2hr IUnbal u0 2hr
V2 THD 2hr 12 THD 2hr Vunbal u0 2hr
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4-30 10s Freq (Data Rec 21)

Power Frequency PqgFlag 10s

4-30 Intrp Log (Data Rec 22)

V Intrp DrtnAll (voltage interruption duration - all voltages)

For more information, see the IEC 61000-4-30 compliance and ION meters technical note,

available on www.se.com.

IEEE 519 compliance logs

The IEEE 519 compliance logs are used to record IEEE 519 compliance parameters:

Data recorder Description

Current harmonics statistics and counters:

519 Hrm I-X (Data Rec 35
( ) Weekly 95th percentile 10 min intervals

Current harmonics statistics and counters:

519 Hrm I-Y (Data Rec 36
( ) Weekly 99th percentile 10 min intervals

Current harmonics statistics and counters:

519 Hrm I-Z (Data Rec 14
( ) Daily 99th percentile 3 s intervals

Voltage harmonics statistics and counters:

519 Hrm V-X (Data Rec 42
( ) Weekly 95th percentile 10 min intervals

Voltage harmonics statistics and counters:

519 Hrm V-Z (Data Rec 13
( ) Daily 99th percentile 3 s intervals

11 Hrm 1-16 (Data Rec 44) 11 current harmonics - 10 min

1 Hrm 17-32 (Data Rec 50) 11 current harmonics - 10 min

11 Hrm 33-48 (Data Rec 56)
12 Hrm 1-16 (Data Rec 45)
12 Hrm 17-32 (Data Rec 51)
12 Hrm 33-48 (Data Rec 57)
I3 Hrm 1-16 (Data Rec 46)
I3 Hrm 17-32 (Data Rec 52)
I3 Hrm 33-48 (Data Rec 58)
V/I Hrm 49-50 (Data Rec 59)
V1 Hrm 1-16 (Data Rec 40)
V1 Hrm 17-32 (Data Rec 47)
V1 Hrm 33-48 (Data Rec 53)
V2 Hrm 1-16 (Data Rec 41)
V2 Hrm 17-32 (Data Rec 48)

11 current harmonics - 10 min
12 current harmonics - 10 min
12 current harmonics - 10 min
12 current harmonics - 10 min
I3 current harmonics - 10 min
I3 current harmonics - 10 min
I3 current harmonics - 10 min
V1,V2,V3, 1,12, 13 harmonics - 10 min
V1 voltage harmonics - 10 min
V1 voltage harmonics - 10 min
V1 voltage harmonics - 10 min
V2 voltage harmonics - 10 min

V2 voltage harmonics - 10 min
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Data recorder Description

V2 Hrm 33-48 (Data Rec 54) V2 voltage harmonics - 10 min
V3 Hrm 1-16 (Data Rec 43) V3 voltage harmonics - 10 min
V3 Hrm 17-32 (Data Rec 49) V3 voltage harmonics - 10 min
V3 Hrm 33-48 (Data Rec 55) V3 voltage harmonics - 10 min

Configuring data logging using ION Setup
Use ION Setup to configure the meter’s data recorders.

Changing the meter’s data recorder configuration clears existing data in that data recorder.

NOTICE

DATA LOSS

Ensure that all important data is recorded before configuring data recording.

Failure to follow these instructions can result in data loss.

To configure data logging using ION Setup:
1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Click Logging > Memory.
4. Inthe Status tab, select the data log and click Edit.
The Log Depth Setup window appears.

5. Configure the settings as applicable:

Parameter Description

Log Interval How frequently records are logged
Log Depth Maximum number of records stored in the log

Information only. This is automatically calculated, and displays
Log Memory how much memory the log uses based on the Log Interval
and Log Depth

Information only. This is automatically calculated, and displays
Log Storage how much total memory is left after subtracting the Log
Memory usage

Waveform recording

The meter’s factory-configured waveform recorders store waveform data related to power quality
events.
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Waveform information is used to help identify power system disturbances, which are an
increasing concern for industrial plants, hospitals, data centers and other facilities where the
equipment is sensitive to voltage or current sags, swells, transients, and momentary interruptions.
Waveform information is also used to help ensure compliance with power quality standards.

In addition to measuring and recording numerical values for voltage and current, your meter can
also capture the sinusoidal waveform data. The current and voltage waveform data provides
additional information for analysis of the system’s power quality or a power quality event.

When your system’s nominal parameters are programmed into the meter, power quality events
such as sags, swells and transients are automatically detected and voltage and current waveform
data is logged. The default factory settings for sag/swell and transient detection are sufficient for
most applications, but you can also modify the amount of deviation from the nominal required to
trigger waveform recording.

Waveform data storage format

Your meter’'s waveform data storage format is defined by:
* Cycles: the number of cycles included in the waveform (its duration).

* Samples: samples per cycle, which is the number of waveform data points collected in each
cycle.

This gives you the option to record a lot of information for a very short duration or less information
over a longer duration. You can also configure the waveform recording to record pre-event and
post-event data.

Types of waveform data

Key terms

You can use your meter to detect ITI (CBEMA) - type disturbances, and determine information
regarding the magnitude and duration of each disturbance. This information can be used by your
energy management system to plot the disturbance on an ITI (CBEMA) curve.

COMTRADE waveform data is available from your meter.
NOTE: If you are generating COMTRADE waveform information, the associated waveform

recorders cannot be modified unless COMTRADE is disabled. If the waveform recorders are not
configured identically, COMTRADE waveform information will not be generated.

Term Definition

COMmon format for TRAnsient Data Exchange (COMTRADE) is
a common format for waveform data.

COMTRADE

A curve that graphically describes an AC input voltage envelope
which can be typically tolerated by information technology
equipment. Meter waveform information is plotted on this curve to
help evaluate power quality.

ITI (CBEMA)

The normal or usual parameter value. For example, the nominal
voltage for many power systems is 120 V.

Nominal
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Term Definition

Sa A power event where the voltage or current drops below the
9 nominal value.
Swell A power event where the voltage or current rises above the
we
nominal value.
: A power event where a short duration surge of electrical energy is

Transient

detected.

For more information on the Waveform Recorder module, see ION Reference, available on
www.se.com.

Default waveform recording configuration

The meter’s default framework includes factory-configured waveform logs (waveform recorders).

These waveform logs and their configuration are used by other components of your power
monitoring system. Do not change the default configuration of any of the logs unless you
understand the impact of the change on these power monitoring system components, the data
they use and your meter's memory.

Waveform Recorder modules

The factory-default Waveform Recorder modules are preconfigured to capture sag/swell and
transient power quality events.

Waveform recorder Description

V1 voltage waveforms recorded during a defined sag or

Wfm Rc V1-Sg/Sw (Wform Rec 1)
swell event.

V2 voltage waveforms recorded during a defined sag or

Wfm Rc V2-Sg/Sw (Wform Rec 2)
swell event.

V3 voltage waveforms recorded during a defined sag or

Wfm Rc¢ V3-Sg/Sw (Wform Rec 3)
swell event.

11 current waveforms recorded during a defined sag or

Wfm Rc 11-Sg/Sw (Wform Rec 5)
swell event.

12 current waveforms recorded during a defined sag or

Wfm Rc 12-Sg/Sw (Wform Rec 6)
swell event.

I3 current waveforms recorded during a defined sag or

Wfm Rc I13-Sg/Sw (Wform Rec 7)
swell event.

V1 voltage waveforms recorded during a defined

Vfm Rc V1-Trnst (Wform Rec 9) i
transient event.

V2 voltage waveforms recorded during a defined

Vfm Rc V2-Trnst (Wform Rec 10) i
transient event.

244 Public 7EN02-0390-08



PowerLogic™ ION9000 series - User manual Logging

Waveform recorder Description

V3 voltage waveforms recorded during a defined

Vfm Rc V3-Trnst (Wform Rec 11) i
transient event.

11 current waveforms recorded during a defined

Vfm Rc I1-Trnst (Wform Rec 13) i
transient event.

12 current waveforms recorded during a defined

Vfm Rc 12-Trnst (Wform Rec 14) )
transient event.

I3 current waveforms recorded during a defined

Vfm Rc I3-Trnst (Wform Rec 15) i
transient event.

COMTRADE modules

Event log

The factory-default COMTRADE modules are preconfigured with their inputs linked to the Trigger
outputs of the waveform recorders for sag/swell and transient monitoring.

COMTRADE 1 inputs (sag/swell) Linked Waveform Recorder (Trigger output)

Waveform Trigger 1 Wfm Rc V1-Sg/Sw (Wform Rec 1)
Waveform Trigger 2 Wfm Rc V2-Sg/Sw (Wform Rec 2)
Waveform Trigger 3 Wfm Rc V3-Sg/Sw (Wform Rec 3)
Waveform Trigger 4 Wfm Rc 11-Sg/Sw (Wform Rec 5)
Waveform Trigger 5 Wfm Rc 12-Sg/Sw (Wform Rec 6)
Waveform Trigger 6 Wfm Rc 13-Sg/Sw (Wform Rec 7)

COMTRADE 2 inputs (transient) Linked Waveform Recorder (Trigger output)

Waveform Trigger 1 Vfm Rc V1-Trnst (Wform Rec 9)
Waveform Trigger 2 Vfm Rc V2-Trnst (Wform Rec 10)
Waveform Trigger 3 Vfm Rc V3-Trnst (Wform Rec 11)
Waveform Trigger 4 Vfm Rc I11-Trnst (Wform Rec 13)
Waveform Trigger 5 Vfm Rc 12-Trnst (Wform Rec 14)
Waveform Trigger 6 Vfm Rc I13-Trnst (Wform Rec 15)

Your meter records events produced by the meter’'s ION modules or external meter events.

Meter events, such as meter configuration or changes to I/O state, have priority values associated
with them, so you can control what events are logged. Each event has a priority based on its type
and severity, and for most events you can configure the priority. The event log records the date
and time of the event, along with relevant details about the event.

Your meter’s event log can be viewed through ION Setup and the display.

For more information on how to view the event log, see "Viewing and downloading an event log"
on page 54.
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Default event log configuration
Your meter logs all configuration changes, meter access events, and power system events.

You can configure certain features, such as the digital inputs, so an event is logged when the
feature changes state (for example, the digital input changes from off to on).

Your meter’s event log might be used by other components of your power monitoring system. Do
not change the default event log configuration unless you understand the impact of the change on
the power monitoring system components and the data they use and on your meter’'s memory.

Changing the default event log configuration should only be undertaken by those with an
advanced understanding of ION architecture and their meter’s template.

The event log is controlled by the Event Log Controller module, which allows you to set a priority
cutoff for event logging. Events with a priority number greater than the cutoff value are logged,
and events with lower priorities are discarded. By default, this value is set so that all relevant
events are recorded in the meter’s event log. Event priority values range from 0 to 255 with a
typical cutoff value of 5.

NOTE: Alarms are generated by events from certain ION modules. The alarm level is determined
by the priority of the associated event. To disable the alarm but still record the associated event,
set the alarm priority to Info Only. To disable the alarm and the event, set the alarm priority to
None.

For more information on the Event Log Controller module and event priorities for specific ION
modules, see ION Reference, available on www.se.com.

User triggered event log entries

The Event Log includes an association between security-related events and the username that
was logged in to the meter during the event.

When a user produces an event, such as a reset, successful or unsuccessful login attempts, user
lockout or setup change, it is written to the event log. Events created in advanced security through
ION Setup or the display are associated with the username that was logged into the meter
(USER1 - USER50).

Unread events in event log

View unread events in the event log. Log into ION Setup as the designated reader and switch ION
Setup into Advanced mode to view unread events. A customized framework is required to setup
notifications for unread events.

Assigning a designated reader for event log notification

A user can be assigned the role of designated reader for the event log.

When the Designated Reader is configured, an entry in the event log is considered unread until it
is reviewed or backed up to external storage by the designated reader. When the designated
reader is informed that the event log is nearly full, an event log review or backup strategy can be
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Syslog

implemented before older entries are overwritten. This feature can assist in ensuring that event
log entries are not overwritten before they can be reviewed. Use ION Setup to select a user to be
the designated reader.

1. Open ION Setup.

Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.
Open the EventLogCtl Modules folder and double click EventLogCtl.

Enter login credentials as necessary.

Click the Setup Registers tab.

Select Designated Reader and click Edit.

N o g M w DN

Set Designated Reader to the user that reviews the event log (USERO - USER50) and click
OK.

Syslog uses the User Datagram Protocol (UDP) to transport event log information from the meter
directly to a centralized syslog server.

The syslog server can receive logs from multiple devices, including meters, then store and filter
the log information as needed. You can use ION Setup to modify the syslog network settings for
your device. Syslog is a useful feature to help maintain meter log information for extended periods
of time.

NOTE: Ethernet is required to use the syslog feature.

Syslog is an open standard allowing you to use any one of a number of syslog server applications
currently available. The decision regarding which syslog server solution to use can be based on
budget and your technical requirements. See the individual syslog server’'s documentation for
more information.

Configuring Syslog network settings using ION Setup

To configure Syslog network settings using ION Setup:
1. Start ION Setup.
Open the Setup Assistant for your meter.
Click Communications > Advanced Ethernet > SysLog.
Select Enable Syslog and click Edit.
Select Yes to enable the syslog server feature or select No to disable it.
Click OK.

Select Syslog Server and click Edit.

© N o ok 0N

Enter the IPv4 address or an IPv6 address for the syslog server.

NOTE: You must enter the IP address for the syslog server, not the server’s fully-qualified
domain name.
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9. Click OK.

10. Verify that the Syslog server is receiving log information from the meter.

NOTE: If the Enable Syslog register is enabled but the Syslog Server register does not
contain an IP address, an event is generated in the event log to indicate that syslog is
enabled with no server IP.

Syslog severity to event log priority mapping
Syslog severities map to ION event priorities (0-255).

Only four of the syslog severities are used in the mapping.

Syslog severity ION event priority name ION event priority range
2 - Critical condition High 192-255
4 - Warning condition Medium 128-191
- Normal but significant
iond‘i)tiona but significa Low 64-127
6 - Informational None 0-63

Advanced log setup and memory optimization

You can configure your meter’s logs to help ensure the integrity of critical data and to optimize the
meter's memory usage.

Before you configure your meter’s logs, it is important to understand how logging functions and
how the settings work together.

NOTE: Configuring your meter’s logs requires an in-depth understanding of the meter's memory,
how the logs function and the data you are capturing.

Viewing log configuration and memory usage information

You can use ION Setup to view log settings and memory usage information for your meter’'s
default logs.

This information can help you understand your log usage and how to optimize your logging
configuration for your situation.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Click Logging > Memory screen.
The Status tab:

— Lists the default logs, their interval (Duration) and depth (Records), if applicable, and
the percentage of available memory used by the log.

— Provides information on how much of the meter's memory is used for system tasks in
the System Resources list item.

— Displays the total meter memory and the percentage of memory in use versus memory

available.

Log depth configuration

You can change the number of records (depth) stored in the log.

Use ION Setup to change the maximum number of records (depth) stored in the log in the meter’'s
long-term memory.

Data logs and circular-format waveform recorders have a minimum depth of 1 record. The

maximum depth is dependent on your meter’'s memory and the configuration of your other logs.
Log interval configuration

You can configure the logging interval, which is how frequently records are logged.

You can change the logging intervals for most logs using the ION Setup Assistant Logging >
Memory screen.

Changing the interval for other logs (for example, logs that are related to standards or triggered by
disturbances) is an advanced procedure that involves using the Advanced mode of ION Setup to
modify settings in the module that is linked to the log’s Record input. See the ION Setup help and
the ION Reference for more information.

Programming your meter to write to any data recorder at continuous intervals shorter than 60
seconds (heavy logging configuration) can cause loss of data in the event of a power failure.

NOTICE

DATA LOSS

Use an uninterruptible power supply (UPS) if you program your meter for heavy logging.

Failure to follow these instructions can result in data loss.

Log mode configuration
You can configure the log record mode, or how the log behaves when full.

Changing how the log records information (circular or stop-when-full) is an advanced procedure
that requires changing the RecordMode setup register in the Data Recorder and Waveform
Recorder modules.
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(B

Circular (FIFO) logging mode: when the log is full, a new record
overwrites the oldest record

Stop-when-full logging mode: when the log is full, any new records are
not logged

Log buffer configuration

The log buffer depth is the maximum number of records that can be stored in the meter’s short-
term memory (RAM) for a particular log.

After records are captured in the log buffer in the meter’s short-term memory, they are replicated
to the long-term memory. Because of inherent differences between short-term (volatile) and long-
term (non-volatile) memory, records can be added more quickly to the short-term memory than
they can be copied to long-term memory.

The logs in the default logging framework have their log buffer depths pre-configured to a value
suitable for most applications. But you can configure the log buffer depth for your applications, if
required (for example, to help ensure the continuity of critical data in high-speed logging
scenarios or to optimize usage of your meter’'s memory for your particular logging configuration).

If you are logging data at high speeds, it is important to review your logging needs, and find the
right balance between data retention and memory optimization for your particular situation.

NOTE: If you get a message that you do not have sufficient memory when you try to create a new
log or change the configuration of an existing log, you may need to reduce the log buffer depths of
other logs in order to make memory available for the new log.

Fully buffered logs

A fully buffered log (e.g., a Data Recorder or Waveform Recorder module) is one where the value
of the Buffer Depth setup register is the same as the Depth setup register. This means the buffer
(short-term memory) is set up to use all the available long-term memory allocated for that log. This
ensures the buffer does not run out of space before all the records are replicated to the long-term
memory, regardless of the recording speed (i.e., the rate of record captures).
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You may want to use this configuration if you are logging critical data (for example, revenue logs)
or logging data at frequent intervals (for example, intervals less than 60 seconds). However, it is
important to note that this configuration uses the most short-term memory, or RAM (the meter has
a maximum 10 MB of RAM available for the log buffer depth).

Partially buffered logs

A partially buffered log (e.g., for a Data Recorder or Waveform Recorder module) is one where
the value of the Buffer Depth setup register is less than the Depth setup register. This means the
buffer (short-term memory) is set up to use only a portion of the available long-term memory
allocated for that log. This configuration allows for a larger log size (i.e., number of records).
However this does not ensure that the buffer does not run out before all the records are replicated
to the long-term memory (e.g., in the case of high-speed recording).

You may want to use this configuration for logs with intervals greater than 60 seconds or with less
critical data. Because the records are partially replicated, this configuration uses less of the
meter’s short-term memory, or RAM, in a log that is otherwise configured the same. This allows
you to make more RAM available for other logs with a higher logging frequency or more critical
data.

However, depending on your configuration, there may be instances where the log buffer fills up
faster than it can replicate records to long-term memory. In this case, you may lose records and
see gaps in your data.

NOTE: The Insert Outage Records functionality does not work if the data recorder is configured
as partially buffered. In order to use this functionality, you must configure the data recorder to be
fully buffered. See ION Reference, available from www.se.com, for more information about
configuring the Data Recorder module.

Example: Fully buffered log records replicated from short-term to
long-term memory

In the following example, the log buffer equals the log depth and all the records are replicated in
both the short-term memory and the long-term memory.
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A Log buffer

B  Long-term memory

C Total available space in the log buffer (for example, 20 records)

Example: Partially buffered log records replicated from short-term

memory to long-term memory

In the following example, the buffer depth equals 20. The first record has already replicated to the
long-term memory, making room in the log buffer for the new records (including the newest

record, in gray).

00— | | o
o |

A Log buffer

B  Long-term memory

C Total available space in the log buffer (for example, 20 records)

Example: Resulting gaps in data when a partially buffered log is
full

In the graphic on the left, the log buffer (A) is full, and the oldest record has not replicated to the
long-term memory yet. This means that the new record (C) is not logged, and is permanently lost.
In the graphic on the right, the oldest record (D) was replicated to long-term memory, making
space in the buffer. The new record at the next interval (E) is logged but there is a gap in the data

for the lost record (C).
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© o

Log buffer

Long-term memory

Record that cannot be logged because log buffer is full (this record is lost)

Record moving from short-term memory to long-term memory

m o|lOo|®| >

New record at next interval

Changing log interval and depth settings using ION Setup

You can configure log intervals, log depths and buffer depths to optimize your memory usage.
Before you begin, make sure you understand:

* the structure of the meter’s logging framework
* the meter’s existing logging configuration
* your data logging requirements

Changing your meter’s log configuration deletes all existing records from that log.

NOTICE

DATA LOSS

Ensure that all important data is recorded before configuring a log.

Failure to follow these instructions can result in data loss.

The default log settings are designed to meet the needs of most users.

This procedure provides the steps for configuring settings for a subset of data logs using the ION
Setup Assistant. Configuring these settings for custom logs, and logs not listed in the Logging >
Memory screen, is an advanced procedure; see the ION Setup help for more information.
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Start ION Setup.
Open the Setup Assistant for your meter.
Click Logging > Memory.
Select the log you want to edit and click Edit.
Set the log depth and log interval as required for your logging needs.
— Log Interval: you can change the interval units to seconds, minutes, hours or days.

— Log Depth: You can set the depth in time (seconds, hours, days, etc.) or the number of
records.

NOTE: For some log types, you only set the log depth (for example, waveform recorders).

Log Memory shows the estimated impact of the changes on the total size of the log and
Log Storage displays the estimated available log memory on the meter.

NOTE: If you receive a message stating that there is not enough memory when you change
alog’s configuration, check the configuration of your meter’s other logs. You may not have
enough RAM, or short-term memory, to allow for the new configuration. You may need to
use Advanced mode to check the detailed configuration of your logs.

Click Finish.

NOTE: You may see a Next button instead of Finish. In this case, the next screen allows
you to configure the buffer depth for the log. The screen displays the overall log depth and a
field for setting the log buffer depth. It also shows the impact of the Buffer Depth setting to
your meter’s short-term memory (RAM).
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Time and timekeeping

Time and timekeeping overview

Your meter’s internal clock is used for keeping time, timestamping data, and determining intervals
for time-based measurements.

Local meter time is displayed based on the meter’s time sync source and the settings used for
time zone and daylight savings time. You can configure and view your meter’s date and time
information using ION Setup, or the display.

Your meter monitors time using the frequency of an internal oscillator or the frequency of the line
power being measured. Your meter’s battery powers the internal clock so that time is maintained
when the meter is unpowered.

Your meter supports different time types and time synchronization methods to adjust its internal
clock. To improve your meter clock’s accuracy, you can use an external time reference such as a
Global Positioning System (GPS) signal, Network Time Protocol (SNTP/NTP) server or Precision
Time Protocol (PTP) leader.

For more information, see the Time Synchronization and Timekeeping technical note, available
on www.se.com.

For more information on the Clock module, see ION Reference, available on www.se.com.

Internal clock temperature compensation

The time accuracy of the meter has been improved by compensating for clock drift if the meter’s
operating temperature falls outside the optimum temperature range.

Your meter’s internal clock is adjusted based on the internal clock temperature compensation
parameters.

Time synchronization

Your meter’s clock controls the timing of metering parameters, such as demand intervals or power
quality measurement aggregation over time intervals.

Adjustments to the clock are made by synchronizing the meter’s time with another time source,
determined by the Time Sync Source. Time synchronization messages can be automatically
generated and sent to your meter from your energy management system software or other time
sources such as an SNTP/NTP server, PTP leader, or GPS receiver. You can also manually
trigger a time synchronization message from your energy management system or configuration
software.

NOTE: To help maintain data integrity, some energy management systems impose a blackout
rule where time synchronization messages near energy interval boundaries are ignored.
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Supported time synchronization sources

Several time synchronization sources are available to your meter.

Time sync

source

Meter
configuration
software (ION
Setup)

Energy
management
system

GPS receiver
(IRIG-B)’

GPS over serial

Simple Network
Time Protocol
(SNTP)

Network Time
Protocol (NTP)

Precision Time
Protocol (PTP)?

Description

Configuration software can manually synchronize the time of your meter
based on the clock of the computer running the configuration software.
Configuration software synchronization is usually performed when the meter
is initially commissioned.

Energy management systems can synchronize the time of your meter to be
consistent with other meters on the network.

A GPS receiver using IRIG-B can synchronize the time of a meter up to + 1
ms of Coordinated Universal Time (UTC). A dedicated serial network is
required to implement a GPS scheme. For IRIG-B, one of your meter’s
digital inputs must be connected to the IRIG-B network, and the digital input
must be configured for IRIG-B time synchronization in addition to
configuring your meter’s clock.

A GPS receiver can synchronize the time of a meter up to £ 1 ms of
Coordinated Universal Time (UTC). For GPS over serial, your meter’s serial
port must be connected to a GPS receiver, and the serial port
communications must be configured with the correct protocol setting.

SNTP can synchronize the time of your meter up to + 1 second of other
meters on an Ethernet network. For SNTP time synchronization, your meter
must be connected to an Ethernet network that has an active SNTP server
and be configured with the server’s information.

NTP can typically synchronize the time of a meter to + 10 to 100 ms,
depending on network configuration. To implement NTP time
synchronization, your meter must be connected to an Ethernet network that
has an active NTP server and be configured with the server’s information.

PTP can synchronize the meter time to £ 1 ms of other devices connected to
alocal area network. To implement PTP time synchronization, your meter
must have PTP selected as the time sync source and be connected to an
Ethernet network that has a valid PTP grandmaster.

' Use the digital inputs located on the meter base for IRIG-B time synchronization and other high-
accuracy applications.

® This clock precision assumes your meter is installed in a Star network topology only.

Clock source

The Clock Source setup register defines the meter’s representation of a one second period, and
can be set to:
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Setting option Description

The meter monitors the ISO Grid Operation line frequency, and
adjusts the one second period based on the measured line
frequency. All devices connected to the grid network are
synchronized to maintain a consistent time base. If a power
outage occurs, the clock automatically synchronizes with the
meter’s internal crystal until power is restored. Once power is
restored, the clock resynchronizes with the line frequency.

Line Frequency

NOTE: Do not use line frequency when your meter is
synchronized to an external time sync source.

Internal The meter clock is synchronized to the meter’s internal crystal.

The meter clock is synchronized to an external time sync source.
Use this for the Clock Source if:

* The Time Sync Source setup register is set to a serial
communications port to receive GPS time synchronization

Comm signals.

* The Time Sync Source setup register is set to ETHERNET-PTP
and your meter is installed in a trusted PTP network.

* The Time Sync Source setup register is set to IRIG-B.

Clock source time quality flag

The meter’s clock source time quality flag is primarily used to report time quality information for
digital input events, such as status alarms, in Sequence-of-Events Recording (SER) applications.

The meter keeps track of the time difference between the meter’s internal clock and the time sync
source.

When the meter’s Clock module’s Use Clock Source Qual Flag is set to use flag, the Diagnostics
module’s Receiver Status output register is set to:

* LOCKED if the time difference between the GPS time sync source or PTP leader and meter
clock is within +1 ms of each other

* UNLOCKED if the time difference between the GPS time sync source or PTP leader and meter
clock is greater than 1 ms of each other

PTP system setting recommendations

By default, your meter is configured to be compatible in typical PTP supported systems.

In a PTP system, the grandmaster clock determines the reference time for the entire system. To
ensure correct implementation and operation of the protocol, it is recommended to set the
following parameters in your system grandmaster clock:
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Parameter Setting Description
End to End A transparent clock that supports the use of the end-to-
PTP device type end delay measurement mechanism between slave
transparent clock
clocks and the leader clock.
A clock that provides time information using the
Peer delay L
) 2 step combination of an event message and a subsequent
mechanism

Clock domain 0-3

Ethernet
switches

PTP V2
compatible

general message.

A logical grouping of clocks that synchronize to each
other using the protocol, but that are not necessarily
synchronized to clocks in another domain

All switches and other devices in the network must
support IEEE 1588 PTP V2 to achieve the stated time
precision and accuracy

Star network topology

In addition to PTP system related settings, the accuracy of your meter clock also depends on your
physical network configuration. A star network topology is required to achieve the level of clock

precision specified.

A  Ethernet switch or hub

B Ethernet connected meters

C PTP leader clock
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Configuring time information using ION Setup

You can set the time, date, and time synchronization settings using ION Setup.

NOTE: You must manually adjust the date and time information if the device is installed in a
different time zone location from the computer running ION Setup.

To configure time information using ION Setup:

1.

2
3.
4

Start ION Setup.

. Open the Setup Assistant for your device.

Click Clock > Timezone.

. Select any parameter, and then click TimeSync to synchronize your device’s date and time

with the computer that is running ION Setup.

NOTE: Time Sync Source must match the device connection type to ION Setup for
TimeSync to work.

Click DST Settings to modify your meter’'s daylight savings time (DST) start and end dates,
if required.

Select the parameter that you want to configure, and then click Edit. Enter the password if
prompted.

Parameter Value Description

Sets the time zone based on the time zones
available from the computer’s operating system.

TimeZone - TIP: You can synchronize the computer's DST
settings with the meter while editing this
parameter.

Specifies the time format of the time sync
message.

UTC (Coordinated Universal time) is equivalent to

Greenwich Mean Time (GMT).
Time Sync

s UTC or LOCAL LOCAL is the local time with DST and time zone

information applied.

— For SNTP/NTP and PTP time
synchronization, set the Time Sync Type to
UTC.
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Parameter Value Description

Sets which device port accepts time
synchronization messages.

Time synchronization messages on other ports
are ignored.

— For GPS time synchronization, set the Time
Sync Source to COM1 (or COM4).

COM1, COM4,
ETHERNET — For SNTP/NTP time synchronization, set the
Time Sync ETHERNET - ION Time Sync Source to ETHERNET.
Source ETHERNET - DNP, — For ION time synchronization, set the Time
ETHERNET - PTP, Sync Source to ETHERNET - ION.
IRIG-B — For DNP time synchronization, set the Time
Sync Source to ETHERNET - DNP.
— For PTP time synchronization, set the Time
Sync Source to ETHERNET - PTP.
— For IRIG-B time synchronization, set the Time
Sync Source to IRIG-B.
Sets the source for the clock:
— Internal: the meter’s internal clock.
Sl Internal, COMM, Line — COMM: the meter’'s communication port
Sl Freq (used by the IRIG-B, GPS or ETHERNET -

PTP time sync source).

— Line Freq: uses the measured line frequency
of the power system as the clock source.

Specifies the amount of time the displayed local
time is moved forward when entering Daylight
Savings. A value of zero disables this feature and

Numeric Bounded
DST Offset Format/Elapsed Interval

Format o .
local time is not adjusted for DST.
Specifies the start day of the week used for
Start of the Trending and Forecasting.
Monday—Sunday
Week NOTE: Changing the start day of the week clears

all trending and forecasting data.

7. (Optional) If using SNTP/NTP time synchronization, enter the following information under
Communications > Advanced Ethernet > NTP:
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8.

Parameter Value Description
NTP: specifies NTP time synchronization.
Enable NTP SNTP: specifies SNTP time synchronization.
Time S NTP, SNTP, No
Ime syne No: neither NTP nor SNTP time synchronization are
used.
. Specifies how often the meter synchronizes over
i Numeric value
NTP Time Sync SNTP
or elapsed
Interval )
interval value NOTE: This parameter is not used for NTP.
Specifies the minimum time difference (in seconds)
Event Logging for a time synchronization to be logged as an event.
0.000001 to
Threshold (NTP 1.000000 This parameter can be configured to help prevent the
and PTP only) meter’s event log from being flooded with time
synchronization events.
Server IP . . :
Specifies the IP address (or fully qualified domain
NTP Server address or ) . i
. name if DNS is active) of the SNTP or NTP server.
domain name

(Optional) If using serial GPS time synchronization, enter the following information under
Communications > Serial settings:

Parameter Description

Protocol Select the GPS setting that matches your GPS receiver.

The recommended baud rate for GPS time synchronization is 19200
Baud rate

bps.
Serial port The recommended stop bits/parity for GPS time synchronization is 8N1.

Configuring time information using the display

Use the meter’s display to configure time parameters.

NOTE: If your device is installed in a region where DST is observed, it is recommended to use
ION Setup to configure the time zone for your locale.

1.
2.

Press Setup Menu > Date/Time/Clock Setup > Date & Time Setup.

Configure your time and date formats, time zone offset, and daylight savings time offset.
Press the down button to access the Clock Setup screen.

Configure the clock and time synchronization source, and the time synchronization time
format.
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Date and time setup

Parameter Values Description
Time Format 12H,24H Specifies how the time is displayed.
MM/DD/YYYY,
Date Format DD/MM/YYYY, Specifies how the date is displayed.
YYYY/MM/DD
Sets the time zone of the meter’s location,
TZ Offset -12:00:00 to 13:00:00 )
relative to UTC.
Sets the daylight savings time offset of the
DST Offset -3:00:00 to 3:00:00 )
meter’s location.
Clock setup
Parameter Values Description

Internal, Line Freq,

Clock S
ock Source COMM

Specifies the time synchronization source.
COM1, COM4,
: ETHERNET, ETHERNET . L
Time Sync Specifies the port to receive time
- ION, ETHERNET - o :
Source synchronization signals.
DNP, ETHERNET - PTP,

IRIG-B

Specifies whether time synchronization

Time Sync Type UTC, Local . , , .
signals are received in local time or UTC.
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Measurements

Energy

Your meter provides bi-directional, 4-quadrant, revenue accurate energy metering:

kWh, kVARh, kVAh delivered and received

kWh, kVARh, kVAh net (delivered minus received)
kWh, kVARh, kVAh total (delivered plus received)
Volt-squared-hours and amp-squared-hours

Integration of any instantaneous measurement

Energy parameters can be logged automatically on a programmed schedule.

All energy values represent the total for all three phases.

Demand

Your meter supports several demand calculation methods, including block, rolling block,
synchronized and predicted demand.

It can measure demand on any instantaneous value and record peak (maximum) demand with
time and date information.

kW, kVAR, kVA demand
kW, kVAR, kVA peak demand

Amps, Volts demand

Instantaneous measurements

Your meter provides one second and half-cycle true RMS readings.

Instantaneous readings include:

Harmonics

3-phase voltages (line-to-line, line-to-neutral): per phase and average
Line-to-earth voltages per phase and V4, neutral-to-earth voltage

3-phase currents: per phase and average

14 and |5 currents, measured

Residual current, calculated (I calc res)

Active (kW), reactive (kVAR) and apparent (kVA) power: per phase and total
Power factor per phase and total

System frequency

Voltage and current unbalance

Phase reversal

Your meter provides harmonic distortion metering, recording, and real-time values for all voltage
and current inputs.
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Your meter can measure and record:
* Individual harmonics, including magnitude and phase angle
* Interharmonics
* Total even harmonic distortion (TEHD)
* Total odd harmonic distortion (TOHD)
* Total harmonic distortion (THD)
* Total demand distortion (TDD)
* K-factor

* Crest factor

Min/max recording

Your meter records new minimum and maximum data every recording interval for a variety of
values.

* Voltage and current
* kW, kVAR and kVA
* Power factor

* Frequency

* Voltage unbalance

Power quality measurements

Your meter monitors the voltage channels to detect and record power quality events.

Disturbance event recording
The meter measures and records:
* Sag/swells: ITIC/CBEMA and SEMI curves

* Transients: 20 ys or longer on any voltage channel

Power quality standards logging

The meter logs power quality standards data according to:
* EN 50160, including Flicker
* IEC 61000-4-30 Class A
* IEEE 519

Advanced power quality features
The meter supports advanced power quality features:

* Disturbance Direction Detection: The meter can capture sag/swell and transient
disturbances, analyze the information, and determine the direction of the disturbance relative
to the meter. Determining the source of a disturbance more quickly and accurately helps
prevent repeat occurrences and also helps to minimize facility downtime.
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* COMTRADE: The meter can save waveform data in COMmon format for TRAnsient Data
Exchange (COMTRADE) format. COMTRADE data is available for download using an SFTP
client application.

* Setpoint learning: You can configure your meter to learn certain disturbance-related values.
For example, what constitutes a sag, swell, transient, or high or low setpoint.

Power and power factor

The sampled measurements taken at the meter’s voltage and current inputs provide data for
calculating power and power factor.

In a balanced 3-phase alternating current (AC) power system source, the AC voltage waveforms
on the current-carrying conductors are equal but offset by one-third of a period (a phase angle
shift of 120 degrees between the three voltage waveforms).

Power factor (PF)

Power factor (PF) is the ratio of real power (P) to apparent power (S).

FI
PF=—
5

PF is provided as a number between -1 and 1 or as a percentage from -100% to 100%, where the
sign is determined by the convention.

A purely resistive load has no reactive components, so its power factor is 1 (PF =1, or unity power
factor). Inductive or capacitive loads introduce a reactive power (Q) component to the circuit
which causes the PF to become closer to zero.

True PF and displacement PF
The meter supports true power factor and displacement power factor values:
* True power factor includes harmonic content.

* Displacement power factor only considers the fundamental frequency.

NOTE: Unless specified, the power factor displayed by the meter is true power factor.

Apparent, active, and reactive power (PQS)

Apparent power (S) is the capacity of your measured power system to provide active (real power,
P) and reactive power (Q).

A typical AC electrical system load has both resistive and reactive (inductive or capacitive)
components. Resistive loads consume real power (P). Reactive power (Q) is either consumed
(inductive loads) or generated (capacitive loads).
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The units for power are watts (W or kW) for real power P, vars (VAR or kVAR) for reactive power
Q, and volt-amps (VA or kVA) for apparent power S.

Positive real power P(+) flows from source to load, and negative real power P(-) flows from the
load to the power source.

Current phase shift from voltage

Electrical current can lag, lead, or be in phase with the AC voltage waveform, and is typically
associated with the type of load — inductive, capacitive or resistive.

For purely resistive loads, the current waveform is in phase with the voltage waveform. For
capacitive loads, current leads voltage. For inductive loads, current lags voltage.

The following diagrams show how voltage and current waveforms shift based on load type under
ideal (laboratory) conditions.
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Power demand

Power demand is a measure of average power consumption over a fixed time interval

NOTE: If not specified, references to demand are assumed to mean power demand.
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The meter measures instantaneous consumption and can calculate demand using various
methods.

Peak demand
Peak (or maximum) demand is the highest demand level recorded over the billing period.

Power utilities generally bill commercial customers based on their peak usage levels, called peak
demand (in kW) and energy consumption (in kWh). Peak (or maximum) demand is the highest
demand level recorded over the billing period. You can view peak demand values on your meter’s
display.

Your meter calculates the average current demand and kW, kVAR and kVA demand using sliding
window demand methods. It supports coincident demand values when a peak demand is
detected.

Your meter’s default configuration is suitable for most applications, or you can customize it for
your specific application. You can configure the minimum time between consecutive demand
resets.

NOTE: If not specified, references to demand are assumed to mean power demand.

Peak demand reset lockout

The demand reset lockout time sets the minimum time allowed between consecutive demand
resets; the meter ignores any attempts to reset demand that occur within the lockout period.

The peak demand reset lockout period is user-configurable (typical default value is 25 days).

See the ION Setup online help for instructions on how to configure demand peak and the demand
reset lockout period on your meter.

For more information on how Sliding Window Demand modules measure and calculate demand

values, see ION Reference, available on www.se.com.

Sliding window demand

To calculate demand values, your meter uses the sliding window averaging (or rolling interval)
method which divides the demand interval into a set number of subintervals of specified duration.

The demand is measured based on the average load level over the most recent set of

subintervals. Sliding window demand also provides predicted demand values.

Examples of sliding window demand
This example shows two different ways of configuring a 15-minute demand interval:

* Single interval (also called block or timed block): the 15-minute demand interval is defined as
a single subinterval with a duration of 15 minutes.

* Sliding window (also called rolling block): the 15-minute demand interval is defined as three
subintervals with a duration of 5 minutes each. This method offers better response time than a
single interval.

Single interval (block)
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Incremental energy

Incremental energy allows you to define a start time, end time, and the time interval (increments)
for incremental energy accumulation.

At the end of each interval, the energy accumulated during that period is stored. By default, the
meter only records the previous interval’s incremental energy and the instantaneous energy
accumulations in the active interval.

The first interval of incremental energy accumulation begins at the specified start time.
Incremental energy ends at the specified end time, which may result in a truncated interval if the
interval duration does not divide evenly into the overall incremental energy duration. For example,
an interval duration of three hours with an overall duration of five hours truncates the last interval
duration to two hours. The latest value for the specified end time is midnight (24:00).

Your start time must be before the end time and after midnight, and the period over which
incremental energy is accumulated cannot include midnight. This is because your meter’s start
and end times are defined relative to midnight.

Start: 6AM, End: Incremental energy accumulates from 6AM to midnight in intervals of
12AM, interval: 3hrs 3 hours.

Start: 6AM, End: Incremental energy will not function. End time must be after start
2AM, interval: 3 hrs time and before or equal to midnight.
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Incremental energy helps provide information for analyzing energy and power usage against
present or future utility rates, and is useful for measuring energy consumption by shift or for a
specific process.

When configuring incremental energy, shorter incremental energy periods provide more granular
data which can make the data easier to use for comparison purposes.

Example: Incremental energy
* Start time: 8AM or 08:00
* Endtime: 12AM or 24:00

* Interval: 420 minutes (7 hours)

A Firstinterval (08:00 to 15:00)
B  Secondinterval (15:00 to 22:00)
C Third interval (22:00 to 24:00)

The firstincremental energy interval is from 8AM (start time) to 3PM, and is 7 hours long. The
second incremental energy interval is from 3PM to 10PM, and is also 7 hours long. The third
interval is from 10PM to 12AM, and is only 2 hours long because 12AM is the specified end time.
These intervals repeat every 24 hours until the configuration is changed or incremental energy
feature is disabled.

Configuring incremental energy using ION Setup
You can configure incremental energy using ION Setup.
1. Start ION Setup.
2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Incremental Energy.
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4. Select Status and click Edit. The Incremental Energy Setup screen is displayed.
5. Select Enable to display parameters for configuration.

6. Select the parameter to configure.

NOTE: Configuring any parameter resets the incremental energy values recorded by your

meter.
Parameter Range Description
The incremental energy first interval’s start time. The
. 12:00 am to . . .
Start time 11:59 pm start time must be prior to the end time for energy
P accumulation.
The end time for incremental energy.
. 12:01 am to
End time 12:00 am The end time must be after the start time and be less
than or equal to 12AM (midnight).
Interval ) The increment period for the incremental energy
) Configurable )
duration duration.

7. Click OK to save your changes.

Conditional energy

Conditional energy allows you to define an accumulation period for real and reactive energy using
one of your meter’s digital inputs.

You can use conditional energy to track four-quadrant accumulated energy during a specific
period. For example, you can track accumulated energy values during a particular process that is
controlled by a programmabile logic controller (PLC).

Conditional energy is accumulated until it is reset. The conditional energy reset date and time
information is stored in the meter’s event log.

Configuring conditional energy using ION Setup

You can enable and configure conditional energy settings using ION Setup.

When configuring your meter, the configuration interface may show all of the possible ports,
regardless of what is physically available on your meter.

One of your device’s digital inputs must be connected and configured to define when conditional
energy is accumulated.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Digital Input Based. Review the digital inputs assigned to
applications to help ensure there are no conflicting usages.

4. Select Conditional Energy and click Edit. The Conditional Energy Setup screen is
displayed.

5. Click Enabled to enable the conditional energy feature.
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6. Click Select to define the digital input. The input’s state determines whether conditional
energy is accumulated. When this digital input is on, conditional energy is accumulated.

NOTE: It is recommended to set Assigned Input to No Connection to disable the
conditional energy feature by removing any port associations.

7. Click OK to save your configuration.

Trending and forecasting overview

Trending and forecasting is a feature on your device that predicts the next set of measured or
calculated data by plotting and analyzing trends in historical data.

Trending and forecasting data is a useful tool to help analyze changes in load and power quality
and forecasting values such as demand. For your meter’s trending and forecasting feature to
work, you only need to give the meter time to accumulate data.

For more information on the Trending and Forecasting module, see /ION Reference, available on
www.se.com.

Trending and forecasting implementation
Data used for trending and forecasting is logged for specific intervals:
* Every hour for the last 24 hours
* Every day for the last month
* Every week for the last 8 weeks

* Every month for the last 12 months

The following parameters are configured for trending and forecasting using ION Setup:

kW sd del-rec (demand) Freq (frequency)
Vil ab lamean

Vil bc I b mean

Vil ca | c mean

Vil avg | avg mean

You can configure the start day of the week for trending and forecasting using the Clock setup
assistantin ION Setup.

Viewing trending and forecasting data on your meter’s webpages

You can select data for forecasting and trending and view the resulting information using your
meter's webpages.

For trending and forecasting to operate, your meter must have accumulated data for at least two
of the specified intervals. For example, if you want to view a daily graph, your meter must have
accumulated data for at least two previous days before the present day.
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To view trending and forecasting data on your meter's webpages:
1. Log in to your meter’s webpages.
2. Click Monitoring > Trending & Forecasting.

3. Select the Target and Interval. The graph for the selected data is displayed.
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Resets

Resets overview

Resets allow you to clear accumulated parameters stored on your meter, reinitialize the meter or
reinitialize meter accessories.

Meter resets clear your meter’s onboard data logs and other related information. Resets are
typically performed after you make changes to the meter’s basic setup parameters to clear invalid
or obsolete data to prepare the meter for active service.

NOTE: Revenue-locked meters must be unlocked to perform resets that impact revenue data. For
more information, see "Revenue locking your meter" on page 295.

Option modules reset

Perform an option module reset if your option modules are not communicating with your meter.

During an option module reset, the option module may not operate normally, and digital and
analog outputs may change state.

A& WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

You can reset your meter’s option module bus using ION Setup or the display. This power cycles
all the modules attached to your meter. If you have queued firmware updates for option modules
on your meter’s internal SFTP site, the firmware updates are performed.

By default, your meter is configured to automatically perform an option module bus reset to help
keep the option modules operating normally. Contact Technical Support for instructions on
changing this default configuration.

Available resets

You can perform meter resets using ION Setup, the meter webpages or the display.
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Reset Description

* Clears all cumulative and derived quantities from the meter,
including: demand, peak demand, energy, revenue, and test
mode parameters.

Master Reset * Clears meter event and waveform logs.

* Clears COMTRADE waveform records stored in the meter’s
internal SFTP site.

* Clears meter data logs.

Clears meter peak demand values.
Peak Demand Reset NOTE: The peak demand reset has a lockout period that sets the
minimum time allowed between consecutive resets.

Min/Max Reset Clears maximum and minimum values stored in the meter.
Digital Input Count Reset  Clears the digital input status change counters.

Clears maximum and minimum harmonics values stored in the
meter.

Harmonics Min/Max Reset

Clears the sag/swell event counter. The sag/swell event counter
Disturbance Count Reset  counts the number of sag/swells that have occurred since the last
reset or meter power-up.

Clears all EN 50160 parameters and statistics accumulated in the
meter.

EN50160 Reset

Resets communications to expansion modules connected to the

Option Modules Reset
meter.

Conditional (Cnd) Energy

Clears the conditional energy values stored in the meter.
Reset

Input Metering Reset Clears the input metering values stored in the meter.

Performing resets using ION Setup

You can reset the meter using ION Setup.
Revenue-locked meters must be unlocked to perform resets that impact revenue data.

Meter resets clear the meter’s onboard data logs and other related information.

NOTICE

DATA LOSS

Ensure all important data from the device is saved before performing a reset.

Failure to follow these instructions can result in data loss.
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To reset the meter using ION Setup:

1.

2
3
4.
5

Start ION Setup.

. Open the Setup Assistant for your meter.

. Click Verification.

Select Normal Mode and click Display.

. Select the desired tab in the Normal Mode dialog box. Depending on the tab selected,

different resets are available.

Tab Reset available
Energy Master Reset
Peak Reset

Rolling Demand
Master Reset

Volts, Amps and Power  Master Reset

Cnd Reset
Conditional Energy
Master Reset

IM(n) Reset

Input Meteri
nput Metering NOTE: n is the input metering number, for example IM1.

Click the appropriate button to perform the reset. For some resets, the meter indicates that
the reset is in progress.

NOTE: Do not configure or power down your meter until it indicates that the reset is
complete or some parameters may not be completely reset.

Performing resets using the meter webpages

You can reset the meter using the meter webpages.

Meter resets clear the meter’s onboard data logs and related information.

NOTICE

DATA LOSS

Ensure all important data from the device has been retrieved before performing a reset.

Failure to follow these instructions can result in data loss.

To reset the meter using the meter webpages:

1.

Connect to your meter's webpages.

2. Browse to Control > Resets.
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Resets

3. Click Reset for the values you want to clear.

Parameter Description

Master Reset

Peak Demand Reset

Min/Max Reset

Digital Input Count Reset

Harmonics Min/Max
Reset

Disturbance Count Reset

EN50160 Reset

— Clears all cumulative and derived quantities from the
meter, including: demand, peak demand, energy,
revenue, and test mode parameters.

— Clears meter event and waveform logs.

— Clears COMTRADE waveform records stored in the
meter’s internal SFTP site.

— Clears meter data logs.

Clears meter peak demand values.
NOTE: The peak demand reset has a lockout period that sets
the minimum time allowed between consecutive resets.

Clears all accumulated maximum and minimum values stored
in the meter.

Clears the digital input status change counters.

Clears all accumulated maximum and minimum harmonics
values stored in the meter.

Clears the sag/swell event counter. The sag/swell event
counter counts the number of sag/swells that have occurred
since power-up or the last reset to provide power quality
information to energy management systems.

Clears all EN50160 parameters and statistics accumulated in
the meter.

Performing resets using the display

You can reset the meter using the display.

Revenue-locked meters must be unlocked to perform resets that impact revenue data.

Your meter’s digital and analog outputs may change state or may not function during resets.

A WARNING

UNINTENDED OPERATION

equipment.

damage.

Do not use this device for critical control or protection of persons, animals, property, or

Failure to follow these instructions can result in death, serious injury, or equipment

Meter resets clear the meter’s onboard data logs and related information.
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NOTICE

DATA LOSS

Ensure all important data from the device has been retrieved before performing a reset.

Failure to follow these instructions can result in data loss.

To reset the meter using the display:

1.

2
3.
4

Press the Home button on the display.

Press Setup Menu > Resets.

Press the Edit button. Enter your meter’s username and password.

Press the up or down icons to navigate available resets. A gray bar appears behind the

active selection.

Reset Description

Master Reset

Peak Demand
Reset

Min/Max Reset

Digital Input Count
Reset

Harmonics
Min/Max Reset

Disturbance Count

Reset

EN50160 Reset

Option Modules
Reset

— Clears all cumulative and derived quantities from the meter,
including: demand, peak demand, energy, revenue, and test
mode parameters.

— Clears meter event and waveform logs.

— Clears COMTRADE waveform records stored in the meter’s
internal SFTP site.

— Clears meter data logs.
Clears meter peak demand values.

NOTE: The peak demand reset has a lockout period that sets the
minimum time allowed between consecutive resets.

Clears all accumulated maximum and minimum values stored in the
meter.

Clears the digital input status change counters.

Clears all accumulated maximum and minimum harmonics values
stored in the meter.

Clears the sag/swell event counter. The sag/swell event counter
counts the number of sag/swells that have occurred since power-up
or the last reset to provide power quality information to energy
management systems.

Clears all EN 50160 parameters and statistics accumulated in the
meter.

Resets communications to expansion modules connected to the
meter.
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5. Pressthe Check Box icon.
6. Pressthe Selecticon to accept the change.

When you select Master Reset, the message all recorded data will be lost.
Reset selected parameters? is displayed.

7. Press Selecticon to confirm.
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Firmware upgrades

Firmware upgrades overview

It is recommended to upgrade PowerLogic™ ION9000 advanced power quality meters to the
latest firmware version.

Firmware version pre-v2.1.0

Before upgrading to the latest firmware version, firmware version 2.1.0 must have been
previously installed. Go to www.se.com, and then search for Upgrading Meter Firmware to v2.1.0
for information on that upgrade.

TIP: Firmware version can be identified using ION Setup, meter webpages, or the display.

Meter firmware includes a digital signature which helps ensure authenticity.

Obtaining meter upgrades

To find a recent firmware package, search for your meter type and Firmware and Associated
Files.

Download the firmware upgrade package (ZIP) from www.se.com.
Upgrade information

Meter firmware

A meter upgraded to firmware version 4.5.0 or later cannot be downgraded to an earlier firmware

version.

NOTICE

LOSS OF DOWNGRADE CAPABILITY

Do not upgrade to firmware version 4.5.0 or later if you need to downgrade the meter in the
future.

Failure to follow these instructions can result in loss of firmware downgrade
functionality.

Upgrade agent

When upgrading to firmware to version 2.1.0 or later, use upgrade agent version 2.1.0 or later.
Restart requirement
Meter restart is required.

Legacy security support

Legacy security support is an interim solution for users that use Standard security mode and is the
default setting for new meters. It provides backwards compatibility with older software
communicating with the meter using ION protocol.
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If Standard security was used before upgrading meter firmware to v3.0.0, Legacy security support
is enabled.

If Advanced security was used before upgrading meter firmware to v3.0.0, Advanced security is
enabled.

RECOMMENDATION: Use Advanced security mode.
Legacy security Legacy security

support password support password
range limit

Legacy security Legacy security

support username support password

* Same password
used before
upgrade to

User1 firmware version  0_99999999 8 characters
3.0.0.,0r

* 0 (zero) for new
meters.

Switch ION Setup into Advanced mode to setup multiple user accounts for meters using Legacy
security support: Open ION Setup > Ctrl + click on the meter to select it.

Meter firmware upgrade prerequisites

Perform back ups of all meter data, download latest ION Setup, and check the connection
requirements before upgrading.

Ensure that the firmware version you are upgrading to is compatible with your meter and the
version number is greater than your existing firmware.

Back up custom meter webpages

Back up webpage files if they were customized.

The upgrade process overwrites all existing meter webpages.

NOTICE

LOSS OF CUSTOM WEBPAGES

Back up custom webpages before upgrading the meter firmware.

Failure to follow these instructions can result in loss of custom webpage functionality.

To back up meter webpages, copy the web folder to a local folder on the computer using an SFTP
client application.

Back up custom meter frameworks

Back up the meter template if the meter uses a customized meter template or frameworks.
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The upgrade process overwrites all existing meter frameworks.

NOTICE

LOSS OF CUSTOM FRAMEWORKS

Back up custom frameworks before upgrading the meter firmware. The upgrade process
overwrites existing meter frameworks.

Failure to follow these instructions can result in loss of custom framework
functionality.

Back up accumulated energy values

Record the accumulated energy values on the meter before upgrading. Re-enter these values
after the upgrade. See "Editing accumulated energy values using ION Setup" on page 288.

Download latest ION Setup
To upgrade meter firmware, the most recent version of ION Setup is required.
1. Start ION Setup.
2. Click Help > Check for Updates.

3. Open a web browser and go to https://www.se.com/en/download/document/ION _Setup
Latest Release/ to download the latest version of ION Setup.

4. If you do not have the most recently released version, download the installation file, then run
it to upgrade ION Setup.
Connection requirements

* Use a direct Ethernet TCP connection to prevent delays and upgrade failure risks associated
with slower communications connection methods. You cannot perform certain firmware
updates over serial or Ethernet gateway.

* The display, webpages and option module firmware updates require an SFTP over Ethernet
connection.

* Use a computer connected to the same Ethernet network as the meter (physically or through
a remote desktop connection).

* To upgrade option module firmware, the option modules must be connected to the meter.

Meter firmware upgrades

Use individual files such as UPX, BIN and S19 file formats to upgrade or use the firmware
upgrade ZIP file with ION Setup (recommended).

Do not interrupt the upgrade process until all updates are complete.
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NOTICE

UPGRADE FAILURE

Do not interrupt the upgrade process or disconnect the meter or any connected components
while ION Setup is performing the firmware upgrades.

Failure to follow these instructions can result in loss of meter functionality.

Option 1 (recommended) — Upgrading using ZIP file

This is the recommended method of upgrading your meter. This method can also be used for
sequential device upgrades.

Any digital and analog outputs associated with your device may change state during a firmware
upgrade.

A WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Loading firmware or template onto your meter clears the meter’s recorded data.

NOTICE

DATA LOSS

Ensure that all important data has been recorded before uploading firmware or a template to
your device.

Failure to follow these instructions can result in data loss.

1. Start ION Setup.

Open the Setup Assistant for your meter.

Click Template > Upgrade.

Click Upgrade and navigate to the saved upgrade ZIP file.

o M DN

Select the upgrade ZIP file and click Open. The Compressed Device Upgrade Package
window displays the updates to be installed in the order listed.

NOTE: Click the View What’s New PDF link to read about new and updated features
related to the firm upgrade.
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6. Select the components you want to upgrade. For example:

Cempinund Creee Upgrade Fackage

'ﬁ Bt o sl Cpndsnd & ihasd o wasnd inal e om B Bevacs,

[ g g Flardkdt of gl ey
L] MW ) ) Lsgrade dgand bivwsme puckoe Ao malabad
5 0K S0 OO e pach ige | wpdale

{1 Frectone S00T 220 DUJ Sarpie ]

T Facime SO0 V3 7000 O bavpisie 1 pdats

T A2 st ol U0 D0 V1 D e | sl

[ Firss meebe dhplep WIDS, ODDUT 15 fpmeaces | mpdddn

e e VT B0 B8 metagan 1 wpdain

Cwsd | s

— ION9000 firmware V3.0.0 package to be applied in the order listed:
— UpgradeAgent V002.001.000.upx (notrequired if already applied)
— V003.000.000.upx

— Factory V2.2.0.0.0 template is the meter template that is programmed to the meter
after the firmware upgrade is complete.

— Factory V3.0.0 web pages are the files to be uploaded to the meter's web SFTP folder,
to update the meter webpages with firmware-related changes.

7. Select the desired settings and readings to be retained, if you selected a template
component:

Templste Paste Options >

Hester pverats
Lamm Hetling

| Secuky Sedtmg

| Log Mail Module

Modbus b.asies Sallr g

dlsa, relam the follovang

| [#] Basic Metering Settings
| ] Clock Settng:

| I Hamepiste Seltng:

| ] Erergy Readings

{ FFITC Setiings

| (] Dizplay Opticer Setrgs

[ oK Cacs | | He

8. Click OK.

9. Click Proceed to start the upgrade process.
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10. Confirm upgrade status is complete and upload webpages to the meter. See "Status" on
page 285 for details.
Option 2 — Upgrading using individual upgrade files
Refer to the “Firmware and templates” section in the meter’s user manual for detailed instructions
on how to upgrade the meter, display and option module firmware.

1. Follow tasks in the order listed:

a. UpgradeAgent V002.001.000.upx
b. v003.000.000.upx

To retain your meter settings, select a meter template file (DCF) to paste into the meter
when performing a and b firmware upgrades. Use the Template Paste Options box to
specify the settings to retain after the upgrade.

NOTICE

LOST SETTINGS

Always select a template file when upgrading the meter firmware.

Failure to follow these instructions can result in loss of meter settings.

2. Confirm upgrade status is complete and upload webpages to the meter. See "Status" on
page 285 for details.

Status

After all required meter firmware updates are complete, ION Setup continues to perform the
remaining updates.

* If you selected to upgrade the template, ION Setup will paste the template into the meter.

* If you selected to upgrade PM89RD96 remote display firmware, ION Setup will perform the
display upgrade through the connected DIN rail-mounted meter.

Upgrading display firmware

For more information, see the Upgrade PM89RD96 display firmware to v4.0.15 technical note,
available on www.se.com.

Upgrading option module firmware

You can upgrade option module using ION Setup or directly through the meter's internal SFTP
site.

1. Go to www.se.com and search for the METSEPM89M0024 or METSEPM89M2600
firmware file.

2. Download the firmware file.
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Loading option module firmware using ION Setup

Upload firmware to option modules using ION Setup over an Ethernet connection. Each option
module must be upgraded individually.

Prerequisites:
* Option module firmware upgrade (.S19) file(s). Go to www.se.com to download upgrade files.
* Option module is connected to the meter.
* Access to meter’s internal SFTP site.

Digital and analog outputs may change state during a firmware upgrade. Option modules are
offline during an option module firmware upgrade; they will not communicate to the meter and the
outputs may change state during the upgrade process.

A WARNING

UNINTENDED OPERATION
Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

If your meter’s option module loses power during firmware upload, the option module will revert to
its original firmware and you will have to reload the firmware file.

To load firmware option module firmware using ION Setup:

1. Obtain the Option Module firmware files (.S19) that you want to load onto your option
module(s). Save the files where they can be accessed by the computer running ION Setup.

Start ION Setup.
Open the Setup Assistant for your meter.

Select the Template screen.

o > @D

Click the Upgrade tab, then click Upgrade. Enter your meter’s password if prompted and
click OK.

6. Navigate to where you have stored the option module firmware. Select the Option Module
firmware file (*.S19) as the file type.

7. Select the option module firmware file and click Open.
An ION Setup window will open. Click Yes to confirm the firmware upgrade.

8. The Option Card Upgrade window opens. Select the Slot that corresponds to the Option
Module type. You can select multiple slots for the same option module type.

9. Click Start.

A dialog box describes the firmware upgrade progress, verifies the firmware, and finishes
with an overview stating whether the firmware was successfully uploaded.
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Loading option module firmware using SFTP

Upload firmware to your meter’s option modules by loading the firmware upgrade file onto your
meter’s internal SFTP site. Each option module must be upgraded individually.

Prerequisites:
* Option module firmware upgrade (.S19) file(s). Go to www.se.com to download upgrade files.
* Option module is connected to the meter.
* Access to meter’s internal SFTP site.

The meter’s digital and analog outputs may change state during a firmware upgrade. Option
modules are offline during an option module firmware upgrade. They will not communicate to the
meter and the outputs may change state during the upgrade process.

A WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

NOTE: If your meter’'s option module loses power during firmware upload, the option module will
revert to its original firmware and you will have to reload the firmware file.
To load firmware option module firmware using SFTP:

1. Connect to your meter’s internal SFTP site.

2. Open the (optionModuleUpg) folder.

3. Open the option module folder that applies to the module to be upgraded.

4. Drag the option module firmware file into the option module upgrade folder.

The file is immediately transferred to the option module, and is not stored on the meter.

5. Review the option module firmware upgrade details stored in the meter’s event log to
confirm that the upload was successful. The upgrade folder must match the position of the
option module (A through D).
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Maintenance

Maintenance overview

The meter does not contain any user-serviceable parts. If the meter requires service, contact your
local Schneider Electric Technical Support representative.

NOTICE

METER DAMAGE
* Do not open the meter case.
* Do not attempt to repair any components of the meter.

Failure to follow these instructions can result in equipment damage.

Do not open the meter. Opening the meter voids the warranty.

Editing accumulated energy values using ION Setup

Test mode

You can edit energy values such kWh and kVARh using ION Setup.

NOTE: Ensure you have recorded accumulated energy values before upgrading your meter’s
firmware. You can then re-enter these values after the upgrade.

NOTE: Revenue-locked meters must be unlocked before accumulated energy values can be
edited. See "Revenue locking your meter" on page 295 for more information

1.

Start ION Setup.

. Open the Setup Assistant for your meter.

2
3.
4

Click Template.

. Click the Register Edit tab, click Energy then click Display. Enter your meter’'s password (if

prompted) and click OK.

The Register Editor screen displays.

Click Edit to enable editing.

Enter values for kWh, kVAh and kVARh as required. Click Send to finish.

NOTE: Only values that have the check box selected will be sent to the meter.

Click Close to close the Register Editor screen.

Test mode is typically used for verifying meter functions.
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The meter is usually reading data from a test power supply while function verification is
performed.

The values shown in the test mode display screens represent different accumulators than those
shown in norm or alt mode (although they perform some of the same basic measurements). The
test mode display values are for accuracy checking purposes; they only accumulate while the
meter is in test mode.

You can create custom test mode screens and modify the existing test mode screens.
NOTE: You cannot place revenue-locked meters into test mode.

Several things to note about test mode:

* All of the billing quantities that are recorded when the meter is in Normal mode stop
accumulating when the meter is switched to test mode — the data is sent to special test mode
registers instead.

* The values accumulated in these test registers are displayed on the test mode displays and in
ION Setup.

* The regular normal mode billing registers are unaffected while the meter is in test mode;
accumulation of this data continues as soon as you exit test mode.

* All test registers are reset to zero when you exit test mode.

Test mode default screens

Your meter has default test mode display screens.

NOTE: You can modify the test mode display screens or add custom screens using ION Setup.

Screen Description

This screen shows test mode kW delivered and received values.
Demand test Both quantities are produced from a sliding window (rolling block)
demand calculation.

This screen shows test mode kVARh delivered and received

Reactive energy test
values.

Active energy test This screen shows test mode kWh delivered and received values.

Putting your meter in test mode using ION Setup

NOTE: You cannot place a revenue-locked meter into test mode.
To put your meter into test mode using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Navigate to Verification and select the Verification tab.
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Select Test Mode and click Display.
Your meter is now in test mode, and the Test Mode screen is displayed.

Select the different tabs to view your meter’s test mode values and modify test mode
parameters.

Click Close to take your meter out of test mode.

Putting your meter in test mode using the display

You can put your meter into test mode using the display.

NOTE: You cannot place a revenue-locked meter into test mode.

1.

2
3
4.
5

Press the Home button.

Press Up or Down to navigate to Normal Display Mode.
Press Select.

Press Down to navigate to Test Mode.

Press Select to enter the Test Mode Screens. Enter the meter password if prompted and
press Select.

The Test Mode menu displays briefly before switching to the first Test Mode screen.
View the test mode screens by pressing Up or Down.

Press the Home button to return to Test Mode Screens. Press Down to highlight Exit Test
Mode, then press Select.

Cleaning instructions

Your meter is rated for Pollution Degree 2: Normally, only non-conductive pollution occurs.
Occasionally, however, a temporary conductivity caused by condensation may be expected.

You should periodically inspect and clean your meter. Non-conductive pollution could negatively
impact the meter by impeding air flow and cooling. Abrasive contaminants can reduce the meter
lifespan.

NOTE: The meter is rated as IP30 (not protected from liquids.) The front of the meter display is
rated as IP54 (dust and water resistant) or IP65 (dust and water proof.) To review your meter's
display specifications, see "Display" on page 314.

Prerequisites:

* Turn off all power supplying the device before cleaning it.
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A DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

* Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

* Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

* Always use a properly rated voltage sensing device to confirm that all power is off.
* Do not use the data from the meter to confirm power is off.

* Do not short secondary terminals of Voltage Transformer (VT).

* Do not open secondary terminals of Current Transformer (CT).

* Secure CT or Low Power Current Transformers (LPCT) secondary conductors to ensure they
do not contact live circuits.

* Assume communications and I/O wiring are hazardous live until determined otherwise.

* Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

To clean the meter and accessories:

* Use compressed air (up to 30 PSI or ~200 kPa) to remove non-conductive pollution from
inside and around the meter or any of its accessories.

* Clean meter surfaces using a cloth dampened with water. *
NOTE: Do not allow liquids to enter the device through ventilation slots, connectors, or other
openings.

* If you are not certain about how to remove abrasive contaminants from the meter or its
accessories, contact Support or your Schneider Electric representative. Improperly removing
contaminants and pollution may void the warranty.

To clean the display:

* Wipe the display using a cloth dampened with water. *

*You can use 70% isopropyl alcohol instead of water if absolutely necessary. Cleaning the device
too frequently with isopropyl alcohol could damage the printing on labels and buttons. If you are
concerned about the risk of infection from touching surfaces, wear gloves or use hand sanitizer
afterward.

Device-specific information

Manufacturing-related information about the meter is available from the Factory module or
through Modbus commands.
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The meter’s Factory module stores meter details such as device type, serial number, and vendor
name. You can use ION Setup in advanced mode to view the contents of the Factory module’s
setup registers. Similarly, you can use Modbus commands to read the Modbus registers mapped
to the corresponding Factory module’s registers.

NOTE: Not all ION device setup registers are mapped to Modbus registers by default.

Other device-specific details, such as Product Code, are not stored in the Factory module.
Product Code (also known as Modbus Product ID) is a number that the manufacturer assigned to
a product to uniquely identify it, for use by systems that specifically require this information. You
can use the device’s Modbus map and Modbus commands to read the Modbus Product ID.

For more information on the Factory module, see ION Reference, available on www.se.com.
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Revenue

A revenue meter provides, over a defined range of operating conditions, measurements that are
within international and national defined standards and industry-accepted accuracy limits.

It also provides protection against unauthorized alteration of these measured quantities. National
and utility-based standards regulate protection against unauthorized alteration of measured
quantities.

Revenue metering components

To meet government regulations and utility security requirements, the meter incorporates three
types of security systems:

* Traditional anti-tamper mechanical seals on the meter. See your device installation guide.
* Passcode entry to reset meter values, for example, Master reset.

* Hardware locking mechanism that prevents modification of revenue quantities after they are
locked.

Revenue firmware security features

Your revenue meter has additional firmware security features:

* Your firmware upgrades are recorded in your meter’s upgrade log. Contact Technical Support
for information on upgrade log retrieval.

* When revenue-locked, you cannot perform resets, configure some revenue-specific
parameters, or upgrade your meter.

Protected features and settings

Your revenue meter has features and settings that cannot be changed while revenue-locked.

In order to prevent changes to revenue-related features, settings and meter data, you can apply
revenue-locking after all revenue-metering setup is complete. See the ION Device Template
Reference, available from www.se.com, for a complete listing of revenue-locked features and
settings.

Revenue locking

Revenue locking may be required to help meet government regulations and utility security
requirements.

Revenue locking your meter helps:
* Prevent changes to revenue-related features, settings and meter data.
* Prevent tampering with your meter’s voltage and current connections.
* Ensure the validity of revenue data.

See the ION Device Template Reference, available from www.se.com, for a complete listing of
revenue-locked features, settings and meter data.

See the meter’s catalog pages, available from www.se.com, or consult your local Schneider
Electric representative for information about your device, its options and accessories.
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Revenue-locking summary

You must configure and revenue lock your meter before installing it.

Unlock your revenue meter if it is locked.

Configure the required revenue settings specific for installation.

NOTE: If you are using ION Setup to configure your meter, allow for any communication
delays before removing power to your meter.

Verify the revenue settings have been implemented.

Clear all accumulated meter data.

Revenue lock your meter.

Verify the meter is revenue-locked.

Install the meter and install the terminal covers according to your meter’s installation guide.

Revenue lock switch

The revenue lock switch located on the meter base is used to revenue lock your meter.

This switch is accessed through a sealable cover.

A Revenue lock switch cover
B  Sealing point

C Toggle switch

D

Revenue lock LED

Revenue lock LED behavior

The revenue lock LED indicates the lock status of the meter.
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LED behavior Revenue lock status

Off The meter is not revenue locked.

On The meter is revenue locked.

Elashin New revenue lock state is pending; power cycle your meter to set the
9 revenue lock to on or off.

Revenue locking your meter

You can lock and unlock your meter using the revenue lock switch located on the meter base.

4 DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

* Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

* Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

Always use a properly rated voltage sensing device to confirm that all power is off.

Failure to follow these instructions will result in death or serious injury.

1. Open the revenue lock switch cover.
Locate the revenue lock switch.
Toggle revenue lock switch on or off.

Close the revenue lock switch cover and make sure it is firmly in place.

o M @D

Seal the revenue lock switch cover if required.

Anti-tamper sealing

The meter has several anti-tamper sealing points which can be sealed by a wire seal or lock.
In certain countries, the meter is no longer revenue certified if the anti-tamper seals are broken.

See your meter’s installation guide for sealing point locations.

NOTICE

LOSS OF COMPLIANCE

Re-certify your meter with the appropriate revenue metering authorities if you remove the anti-
tamper seals.

Failure to follow these instructions may render your device non-compliant for billing
purposes.

Revenue lock switch seal
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PT/CT correction

Potential transformer/current transformer correction (PT/CT correction), also called instrument
transformer correction, can help reduce the need to replace transformers in installations where
high accuracy is required.

The primary application for PT/CT correction is to apply correction factors for ratio errors and
phase angle errors to instrument transformers. PT/CT correction is done for each current and
voltage input to the meter and only affects 1-second power meter data and values derived from it,
such as energy or demand. No high-speed, harmonics or waveform values are affected by the
correction.

NOTE: For those familiar with ION architecture, the relevant 1-second Power Meter module
outputs are compensated using the Instr Xformer (ITC) Correction module. All other modules that
use the 1-second Power Meter module’s data are also compensated.

See the ION Setup online help, available from www.se.com, for instructions on how to configure
PT/CT correction on your device.

For more information about the Instr Xformer Correction (ITC) module and how it applies PT/CT
correction to your device, see ION Reference, available on www.se.com.

Transformer loss compensation

Transformer Loss Compensation (TLC) is the method for compensating for the measurable
losses that occur when there is a physical separation between the meter and the actual billing
point.

TLC is used when a meter’s actual location is different from the electrical location where change
of ownership occurs, for example, if meters are connected on the low-voltage side of power
transformers but the ownership change occurs on the high-side of the transformer. Meters are
usually installed on the low-voltage side of a transformer because it is more cost-effective

296 Public 7EN02-0390-08



PowerLogic™ ION9000 series - User manual Revenue

NOTE: Due to the variation in installations, advanced knowledge of power systems and
connection methods is required before transformer loss compensation can be properly
implemented. Data parameters should only be programmed by qualified personnel that have
appropriate training and experience with Transformer Loss Compensation calculations.

There are cases where the change of ownership occurs halfway along a transmission line, where
it is impractical to install a meter. In this case, power metering must be compensated using line
loss calculations.

For more information, see the PowerLogic Transformer Line Loss Calculations technical note,
available on www.se.com.

Time of use

Time of Use (TOU) is often used when a utility has set up schedules with different rates based on
time of day, type of day and date when energy is consumed.

You can view the TOU active rates and seasons using the display.

For more information on how to configure TOU on your meter, see the ION Setup online help,
available from www.se.com.

For more information on the Time of use module and its settings, see ION Reference, available on
www.se.com.

Energy pulsing LED behavior

The visible and infrared LEDs are configured by default to pulse based on energy measured by
the meter.

You can configure the pulse weight (pulses per kWh) and the energy source.

Energy pulsing is used to help verify the energy measurement accuracy of your meter for revenue
purposes.
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Verifying accuracy

Verifying accuracy overview

All meters are tested and verified at the factory in accordance with International Electrotechnical
Commission (IEC) and American National Standards Institute (ANSI) standards.

Your digital power meter typically does not require re-calibration. However, in some installations a
final accuracy verification of the meters is required, especially if the meters will be used for
revenue or billing applications.

For a list of accuracy standards that your meter complies to, contact your local Schneider Electric
representative or download the meter brochure from www.se.com.

Accuracy test requirements

The most common method for testing meter accuracy is to apply test voltages and currents from a
stable power source and compare the meter’s readings with readings from a reference device or
energy standard.

Signal and power source

The meter maintains its accuracy during voltage and current signal source variations but its
energy pulsing output needs a stable test signal to help produce accurate test pulses. The meter’s

energy pulsing mechanism needs approximately 10 seconds to stabilize after every source
adjustment.

The meter must be connected to control power in order to conduct accuracy verification testing.
Refer to your meter’s installation documentation for power supply specifications.

A DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Verify the device’s power source meets the specifications for your device’s power supply.

Failure to follow these instructions will result in death or serious injury.

Control equipment

Control equipment is required for counting and timing the energy pulse outputs from a visible
LED, infrared LED or onboard digital output.

* Most standard test benches have an arm equipped with optical sensors to detect LED pulses
(the photodiode circuitry converts detected light into a voltage signal).

* The reference device or energy standard typically has digital inputs that can detect and count
pulses coming from an external source (i.e., the meter’s onboard digital output).
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NOTE: The optical sensors on the test bench can be disrupted by strong sources of ambient light
(such as camera flashes, florescent tubes, sunlight reflections, floodlights, etc.). This can cause
test errors. Use a hood, if necessary, to block out ambient light.

Environment

The meter should be tested at the same temperature as the testing equipment. The ideal
temperature is about 23 °C (73 °F). Make sure the meter is warmed up sufficiently before testing.

A warm-up time of 30 minutes is recommended before beginning energy accuracy verification
testing. At the factory, the meters are warmed up to their typical operating temperature before
calibration to help ensure that the meters will reach their optimal accuracy at operating
temperature.

Most high precision electronic equipment requires a warm up time before it reaches its specified
performance levels. Energy meter standards allow the manufacturers to specify meter accuracy
derating due to ambient temperature changes and self-heating.

Your meter complies with and meets the requirements of these energy metering standards.

For a list of accuracy standards that your meter complies with, contact your local Schneider
Electric representative or download the meter brochure from www.se.com.

Reference device or energy standard

To help ensure the accuracy of the test, it is recommended that you use a reference device or
reference energy standard with a specified accuracy that is 6 to 10 times more accurate than the
meter under test. Before you start testing, the reference device or energy standard should be
warmed up as recommended by its manufacturer.

NOTE: Reference equipment with a traceable calibration certificate is recommended when
performing accuracy testing.

Energy pulsing

Energy pulsing LEDs and digital outputs can be used for energy pulsing.

Your meter is equipped with two types of energy pulsing LEDs: visible light and infrared. These
LEDs emit pulses that are then used to determine the accuracy of the meter’s energy
measurements. The pulses of light indicate accumulated energy; the meter’s accumulations are
compared with the reference/standard’s accumulated energy in order to help determine the
meter’s accuracy.

The meter’s digital output can also be used for energy pulsing. A closing (low impedance) and
then opening (high impedance) of the digital output represents a pulse. If the accuracy testing
equipment has a voltage requirement, a current-limited wetting supply voltage must be provided.

NOTE: Digital outputs on option modules should not be used for meter accuracy testing.
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Verifying accuracy test meter settings

Your meter's power system and other parameters must be configured for accuracy testing.

Meter parameter Value

Volts mode 4W-Wye (4 wire Wye)

PT/CT correction Disabled
Active

Test mode NOTE: In test mode, your meter’s billing quantities stop accumulating,
and the data is sent to special test mode registers. These registers are
cleared when you exit test mode.

Verifying accuracy test

The following tests are guidelines for accuracy testing your meter; your meter shop may have
specific testing methods.

A DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

* Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

Always use a properly rated voltage sensing device to confirm that all power is off.
* Do not exceed the maximum ratings of this device.

Verify the device’s power source meets the specifications for your device’s power supply.

Failure to follow these instructions will result in death or serious injury.

1. Connect the test voltage and current source to the reference device or energy standard.
Ensure all voltage inputs to the meter under test are connected in parallel and all current
inputs are connected in series.
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A Reference device or energy standard

B Testvoltage and current source

C Meter under test

. Connect the control equipment used for counting the standard output pulses using one of

these methods:

Option Description

Energy pulsing  Align the red light sensor on the standard test bench armature over the
LED energy pulsing LED.

Onboard Digital Connect the meter’s onboard digital output to the standard test bench
output pulse counting connections.

NOTE: When selecting which method to use, be aware that energy pulsing LEDs and digital
outputs have different pulse rate limits.

Before performing the verification test, let the test equipment power up the meter and apply
voltage for at least 30 seconds. This helps stabilize the internal circuitry of the meter.

. Configure your meter power settings (such as voltage, current and frequency) to align with

the reference device.

Depending on the method selected for counting the energy pulses, configure the meter’s
energy pulsing LED or one of the digital outputs to perform energy pulsing. Set the meter’'s
energy pulse constant so it is in sync with the reference test equipment.

Perform accuracy verification on the test points. Run each test point for at least 30 seconds
to allow the test bench equipment to read an adequate number of pulses. Allow 10 seconds
of dwell time between test points.
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Calculate the number of required pulses

The reference test equipment typically requires you to specify the number of pulses required for a
test duration of “t” seconds.

Normally, the number of pulses required is at least 25 pulses, and the test duration is greater than
30 seconds.

Use the following formula to calculate the required number of pulses:

Mumbear of pulses = i 0

3600 " Ki

Ne Number of metering elements used

v Test point voltage in line-to-neutral volts
(V) per phase

I Test point current in amps (A) per phase

i Test duration in seconds (s) which must
be longer than 30 seconds

PF Power factor

Kt Pulse constant programmed in the meter

under test in Wh/pulse

Round up the result of the calculation to the nearest integer number of pulses.

Calculation for number of required pulses

This example calculates the number of pulses required for an inductive load 3-phase test point
with a test duration of 60s; the source is configured to use V = 120V, | = 5A, PF =-0.5; the pulse
constant of the meter under test is Kt = 1.8 Wh/pulse.
g3=4"120V"5A" 5"80%
SE00 " 1.8

Round the number up to the nearest integer: Number of pulses = 9

Percentage error calculation for accuracy verification testing

Accuracy verification testing requires you to calculate the percentage error between the meter
being tested and the reference/standard.

Calculate the percentage error for every test point using the following formula:
Energy error = (EM - ES) / ES x 100%
Where:

* EM = energy measured by the meter under test

* ES =energy measured by the reference device or energy standard.
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NOTE: If accuracy verification reveals inaccuracies in your meter, they may be caused by typical
sources of test errors. If there are no sources of test errors present, please contact your local
Schneider Electric representative.

Typical sources of test errors

If you see excessive errors during accuracy testing, examine your test setup and test procedures
to eliminate typical sources of measurement errors.

Typical sources of accuracy verification testing errors include:

* Loose connections of voltage or current circuits, often caused by worn-out contacts or
terminals. Inspect terminals of test equipment, cables, test harness and the meter under test.

* Meter ambient temperature is significantly different than 23 °C (73 °F).

* Floating (ungrounded) neutral voltage terminal in any configuration with unbalanced phase
voltages.

* Inadequate meter control power, resulting in the meter resetting during the test procedure.
* Ambient light interference or sensitivity issues with the optical sensor.
* Unstable power source causing energy pulsing fluctuations.

* Incorrect test setup: not all phases connected to the reference device or the energy standard.
All phases connected to the meter under test should also be connected to the reference
meter/standard.

* Moisture (condensing humidity), debris or pollution present in the meter under test.

Accuracy verification test points

The meter should be tested at full and light loads and at lagging (inductive) power factors to help
ensure testing over the entire range of the meter.

The test amperage and voltage input rating are labeled on the meter. Refer to the installation
guide or data sheet for your meter’s nominal current, voltage and frequency specifications.

Watt-hour test point Sample accuracy verification test point

Eull load 100% to 200% of the nominal current, 100% of the nominal voltage and
nominal frequency at unity power factor or one (1).
Liaht load 10% of the nominal current, 100% of the nominal voltage and nominal
< frequency at unity power factor or one (1).
Inductive load 100% of the nominal current, 100% of the nominal voltage and nominal
(lagging power frequency at 0.50 lagging power factor (current lagging voltage by 60°
factor) phase angle).

VAR-hour test point Sample accuracy verification test point

100% to 200% of the nominal current, 100% of the nominal voltage and
Full load nominal frequency at zero power factor (current lagging voltage by 90°
phase angle).
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VAR-hour test point Sample accuracy verification test point

10% of the nominal current, 100% of the nominal voltage and nominal
Light load frequency at zero power factor (current lagging voltage by 90° phase
angle).
Inductive load 100% of the nominal current, 100% of the nominal voltage and nominal
(lagging power frequency at 0.87 lagging power factor (current lagging voltage by 30°
factor) phase angle).
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Troubleshooting

Review the topics in this section to get more information on how to troubleshoot your meter and
where to obtain technical assistance.

Setting up Advanced security troubleshooting

Some users could experience software access issues after enabling Advanced Security mode.
Resolve software access issues using these troubleshooting steps:

Solution — follow tasks in the
Meter state Example behavior

order listed

* Verify that you are using the
newest version of ION Setup.
New meter Login credentials are unknown.
* Enter Username: User1 and
Password: 0 [zero].
7EN02-0390-08 Public
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Solution — follow tasks in the
order listed

Meter state Example behavior

* Verify that you are using the
newest version of ION Setup.

* Verify you are using meter

Using EcoStruxure™ Power firmware v3.0.0.
Monitoring Expert software and after  « Configure software meter
password is entered, access is not security settings.
granted.

* Enter meter username: User1
and Password: [password used
before upgrade to firmware

v3.0.0].
Using Vista software and after Go to www.se.com and search for
password is entered, access is not support to get assistance with
granted. troubleshooting.

Meter recently
upgraded to Using EcoStruxure™ Power

firmware v3.0.0 Operation software.

Go to www.se.com and search for
support to get assistance with
troubleshooting.

Wait until lockout duration is over
and account is not locked out. If a
user account is locked out, that user
can still access the device by
entering the correct credentials over
a different protocol and
communications method.

Incorrect credentials are entered
multiple times and a lockout occurs.

* Verify that you are using the
newest version of ION Setup.

* Enter meter username: User1
and Password: [password used
before upgrade to firmware
v3.0.0].

Login credentials are unknown.

Option module troubleshooting

Events related to option module initialization and operation are stored in your meter’s onboard
event log. Perform an option bus reset to restart the option bus and re-initialize the option
modules attached to your meter. Reviewing the events in the event log within the first minute of
option bus reset will provide the most specific details of the detected problem with your option
module.

When troubleshooting option modules, attach each option module directly to the meter and verify
its operation. If each option module operates when directly connected, use combinations of
modules or known good modules to help identify the issue.
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Information about your option module’s type, serial number, firmware version and present status
is available in the Factory and Diagnostics modules.

See ION Reference, available from www.se.com, for more information about the Factory and

Diagnostics modules.

Technical assistance

Go to www.se.com and search for support to get assistance with troubleshooting.

Have the meter model, serial number and firmware version information ready. See "Device-
specific information" on page 291 for details about obtaining this information.

You may be asked by a customer care agent to enable factory access to the device for
troubleshooting. Factory access is gained after a unique diagnostic access code is used to login
to the device over a secure protocol.

Factory access:
* Is disabled by default.
* Istemporarily enabled for a duration defined in the Factory Access minutes register.
* Requires adequate user privileges to enable.

* Provides read and write permissions.
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ION9000 specifications

This section provides additional specifications for your meter and accessories.

NOTE: The information contained in this section is subject to change without notice. You can
download updated documentation from www.se.com or contact your local Schneider Electric
representative for the latest updates.

Mechanical characteristics

ION9000 series meter

Mounting options

DIN rail: IEC 60715 (DIN EN 60715), TH 35-7.5 or TH 35-15
Panel mount: with 9B2BMA

Orientation

Vertical, retaining clips located on bottom of meter

IP degree of protection

IP30 (except connectors)

Maximum number of option
modules

4 (based on maximum operating temperature)

Mechanical compliance

IEC 60068-2-6
Vibration

IEC 60068-2-57

IEC 60068-2-27
Shock

IEC 60068-2-31, Test Ec Free fall procedure 1

Electrical characteristics

Measurement accuracy

Active energy (Wh)

IEC 62053-22 Class 0.1 S

Reactive energy (VARh)

IEC 62053-24 Class 0.5 S

Power monitoring device (PMD)

IEC 61557-12 PMD/SD/K70/0.2 and PMD/SS/K70/0.2

Active power (P)

IEC 61557-12 Class 0.1

Reactive power (Qy)

IEC 61557-12 Class 1

Apparent power (Sy) IEC 61557-12 Class 0.2
Apparent energy (E,pv) IEC 61557-12 Class 0.2
Current (/) IEC 61557-12 Class 0.1
Voltage (V) IEC 61557-12 Class 0.1
Frequency (f) IEC 61557-12 Class 0.02
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NOTE: Reactive energy and demand values, by default, are based only on the fundamental
frequency, and do not include higher harmonics. Active and apparent energy and demand values
are measured using the entire signal, including harmonics.

Power quality

Power quality instrument (PQlI)

IEC 62586-1/2 PQI-A
IEC 61000-4-30 Class A (U, =230 V)
IEC 61000-4-15 Class F1 (U,=230V, 120 V)

Voltage unbalance (U,,)

IEC 61557-12 Class 0.2

Voltage harmonics (U,)

IEC 61557-12 Class 1

Voltage THD (THD,)

IEC 61557-12 Class 1

Current harmonics (1)

IEC 61557-12 Class 1

Current THD (THD))

IEC 61557-12 Class 1

Waveform capture

16—1024 samples per cycle

Voltage inputs

Specified accuracy range

57-400V L-N/100-690 V L-L (Wye) or 100-600 V L-L (Delta
or Wye with unearthed neutral)

Specified accuracy frequency

50/60 Hz + 15%
400 Hz £ 10%

Overload 600V L-Nor1035V L-L
Impedance >5MQ
Measurement category 1

Current inputs

Nominal

IEC: 1A/5A (Class 0.1 S)
ANSI: Current Class 2, 10, 20 (Accuracy Class 0.1)

Specified accuracy current
range

10 mA-20 A

Starting current

1mA

Withstand 30 A continuous, 50 A @ 10 sec/hr, 500 A @ 1 sec/hr
Impedance 0.3 mQ (typical)
Burden 0.01 VA maximum at5 A

LVCS current inputs

Input voltage range 5.5V pk
Minimum signal 1mV
Withstand 30V pk continuous
Input impedance 200 kQ
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Control power

AC control power

Operating range

50/60 Hz + 10%: 90480 V + 10%
400 Hz: 90120V + 10%

Burden (meter only)

Maximum: 16.5 W/38 VA @ 480 V (45-65 Hz)
Maximum: 13 W/24 VA @ 120V (400 Hz)

Burden (fully optioned meter)

Maximum: 40 W/80 VA @ 480 V (45-65 Hz)
Maximum: 36 W/58 VA @ 120 V (400 Hz)

Ride-through time (no optional
accessories)

100 ms (6 cycles at 60 Hz) typical, 120 V AC
400 ms (24 cycles at 60 Hz) typical, 240 V AC
1200 ms (72 cycles at 60 Hz) typical, 480 V AC

DC control power

Operating range

110-480V DC £ 10%

Burden (meter only)

Maximum: 13.5W at480V DC

Burden (fully optioned meter)

37 Wat480V DC

Overvoltage category

Low-voltage DC control power

DC control power

Operating range

2060V DC +10%

Burden (meter only)

Maximum: 15 W at 20-60V DC

Burden (fully optioned meter)

Maximum: 38 W at 20-60 V DC

Overvoltage category

Digital output (Form A)

Number 4
Type Form A solid-state
Reference voltage 40V
Maximum load voltage 30VAC/60VDC
Maximum load current 75 mA
ON resistance 13—-40Q at25°C (77 °F)
Signal type Continuous or pulse
Pulse frequency <25Hz

Relay output (Form C)
Number 2
Type Form C mechanical relay

Public
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Maximum load voltage 250V AC/30VDC
8A@250VAC
Maximum load current 5A@24VDC
20k cycles (resistive)
Operate time Maximum: 10 ms
Release time Maximum: 5 ms
No Load: 10,000,000 operations
Lifetime
Rated Voltage and Load: 50,000 operations
Digital inputs
Number 8
Tvpe Externally excited, 24 V DC whetting voltage available from
yp the meter
Reference voltage 40V
Event timestamp accuracy +1ms
30VAC
Maximum voltage
60V DC
Pulse frequency <25Hz
Response time 1 cycle
Minimum pulse width 20 ms
ON:<2.5mA
Current draw
OFF:<0.5mA
4-30V AC
Voltage ON state
4-60V DC
0-1.4VAC
Voltage OFF state
0-2.0vDC
IRIG-B00x format (unmodulated IRIG-B time code)
IRIG-B Coded expressions 0—7 are supported but the year data is
not used.
Whetting source (Digital inputs)
Output voltage 24V DC
Output current 20 mA
Maximum load 8 digital inputs (meter base)
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Environmental characteristics

Operating temperature

—25 °C to Max temp (—13 °F to Max temp)

NOTE: Maximum operating temperature could change based
on the quantity and type of attached option modules. See
Maximum operating temperature with option modules below.

Storage temperature —40°C to 85 °C (—40 °F to 185 °F)
5%—95% RH non-condensing
Humidity rating
Maximum dewpoint: 37 °C (99 °F)
Pollution degree 2
Altitude <3000 m (9843 ft) above sea level
Not suitable for wet locations
Location/mounting For indoor use only

Must be permanently connected and fixed

Maximum operating temperature with option modules

Maximum operating PM89M2600 PM89M0024
e Digital (2 out, 6 in) Analog (2 out, 4 in)
70 °C (158 °F) 0-4 0,1
70°C (158 °F) 0 2
60 °C (140 °F) 1,2 2-4
LEDs
Energy pulsing LEDs (visible and infrared)
Type Visible orange, infrared
Wavelength 600-609 nm (orange), 825-925 nm (infrared)
Maximum pulse rate 10 Hz (100 ms)
Status LEDs (visible)
Type Bi-color, red/green
EMC (electromagnetic compatibility)
EMC standards IEC 62052-11, IEC 61326-1, IEC 61000-6-5
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Immunity to electrostatic

discharge IEC 61000-4-2
Immunity to radiated fields IEC 61000-4-3
Immunity to fast transients IEC 61000-4-4
Immunity to surges IEC 61000-4-5

Immunity to conducted
disturbances

IEC 61000-4-6, IEC 61000-4-16

Immunity to power frequency
magnetic fields

IEC 61000-4-8

Immunity to conducted
disturbances, 2 - 150 kHz

CLC/TR 50579

Immunity to voltage dips and
interruptions

IEC 61000-4-11

Immunity to ring waves

IEC 61000-4-12

Conducted and radiated
emissions

EN 55011 and EN 55032 Class B, FCC part 15 Class B,
ICES-003 Class B

Surge withstand capability
(SWC)

IEEE/ANSI C37.90.1

Safety

Safety construction

IEC/EN 61010-1, CAT 11, 400 VLN / 690 VLL

UL 61010-1 and CSA-C22.2 No. 61010-1, CATIII, 347 VLN /
600 VLL

IEC/EN 62052-31, Protective Class I

Ethernet communications

Number of ports

2 (switched mode)

Maximum cable length

100 m (328 ft), per TIA/EIA 568-5-A

Cable type CATS5 (or higher)

Connector type Unshielded RJ45 modular connector (2)
Mode 10Base-T, 100Base-TX, Auto-MDIX
Data rate up to 100 Mbps
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RS-485 communications

Number of ports

2

Cable type

Shielded twisted pair

Maximum cable length

1200 m (4000 ft)

Maximum number of devices
(unit loads)

Up to 32 devices on the same bus

Parity

None, even, odd

Baud rate

2400-115200, 19200 recommended

Real-time clock

Display

Clock drift (time error)

Meter Powered ON: 5 ppm maximum

Meter Powered OFF: 20 ppm maximum at 25 °C (77 °F)

Battery backup time

Minimum 7 years under specified storage conditions

METSERD192 display

Display

Capacitive touchscreen, WVGA color graphic TFT LCD 800 x

Display type 480 resolution

Display backlight White LED

Viewable area 152.5x91.5mm (6.00 x 3.60 in)
Weight 0.9kg (2.0 1b)

Communications ports

Optical communications ports

ANSI C12.18 optical port
IEC 1107 optical port adapter

USB communications ports

USB host port: Type A USB
USB device port: Mini-B USB

Control power

Power over Ethernet (PoE)

power

PD Type 1 Class 3 per IEEE 802.3af, 10W maximum
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Auxiliary control power

(Not required for PoE
applications)

24V DC + 20%
DC burden 10 W maximum

Use UL listed or UL recognized NEC class 2 (or equivalent
SELV or PELV) power source

Communication connection

Cable type

CATS5 (or higher). Use with unshielded RJ45 modular
connector

Cable length

100 m (330 ft) maximum

Connection type

Direct, point-to-point

Environment

Operating temperature

~20°C to 60 °C (=4 °F to 140 °F)

Storage temperature

—40 °C to 85 °C (—40 °F to 185 °F)

Humidity rating

5%—-95% RH non-condensing
Maximum dewpoint: 37 °C (99 °F)

Pollution degree

2

Altitude

<3000 m (9843 ft) above sea level

IP degree of protection

Front: IP65
Rear: IP30

Location/mounting

For UL Type 12 applications, install display on a flat surface
of a Type 12 enclosure

Not suitable for wet locations

For indoor use only

Option modules

See your option module’s installation guide for additional option module specifications.

METSEPM89M0024 Analog (2 out, 4 in)

Maximum number of modules

4

Input resistance

<300 Q (current mode)

> 500 kQ (voltage mode)

Input voltage mode

0-30VvDC

Input current mode

4-20 mA, 020 mA

Operating temperature

—25t0 70 °C (—13 to 158 °F)

Maximum operation temperature is based on the quantity and
type of attached option modules.

METSEPM89M2600 Digital (2 out, 6 in)

Maximum number of modules

4

7EN02-0390-08

Public 315




ION9000 specifications

PowerLogic™ ION9000 series - User manual

Operating temperature

—251t070°C (—13 to 158 °F)

Maximum operation temperature is based on the quantity and

type of attached option modules.

METSEPMRS4854W 4-Wire RS-485

Maximum number of modules

1

Operating temperature

—2510 70 °C (=13 to 158 °F)

Maximum operation temperature is based on the quantity and

type of attached option modules.

METSEPMFIBER Fiber Ethernet

Maximum number of modules

1

Operating temperature

Other

—251t0 70 °C (13 to 158 °F)

Maximum operation temperature is based on the quantity and

type of attached option modules.

Parameter

Description

Weight (meter base only)

Weight (Measurement Canada)

1.5kg (3.31b)
3.23kg (7.12 Ib)

Meter start time'

25 seconds: Measurements
35 seconds: Communications

45 seconds: Display initialization

Meter storage

2000 MB

Data update rate

Regular data: 1 second

High-speed: 50/60 Hz half-cycle

Advanced security user
accounts

Up to 50 users

1 — Meter start up time is expressed as the typical elapsed time from the application of control

power to the result indicated in the

description field.
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